


n editorial

We are at an interesting time in consumer software again, after a long
hiatus. The next version of Windows promises much, but is two
years away. The two year old Windows XP is left holding the fort.

In the meanwhile, Linux is rapidly evolving a friendly face. For the first time,
it seems to really be a viable option for computer-literate users. It is not quite
there yet, but two years is a long time in computer years.

Internet Explorer 6 is the end of the line for the world's most popular browser.
The next level of the IE experience, will only be available integrated into the
upcoming Windows, two years from now. Web technology is among the most
rapidly evolving, so using IE going forward means being tied to obsolete tech-
nology.

In the meanwhile, Netscape is no more, but its offspring do it proud. Mozilla
Firebird is already far and beyond a better browser product than Internet
Explorer—Web standards compliant, privacy aware, and with a great pop-up
killer integrated.

The next MS Office is expected by year end, but the pretty new icons in the lat-
est beta test versions don't really present an interesting upgrade story. Sure, the
new XML capabilities will find takers in special applications, but that doesn't
help you write a better letter. If it sticks to schedule, MS Office will make anoth-
er attempt at tempting us in a couple of years.

In the meanwhile, solutions such as OpenOffice.org come nowhere near MS
Office in feature count or polish, but they get the job done for free.

Open source applications have been following an erratic path to usability and
effectiveness. In recent times, a lot has changed. And with all of the major
Microsoft products holding off for two years, this may be the right time to dip
your toes in strange waters, and feel the currents of change. 

Even our President would approve.

sumod_hajela@jasubhai.com

“For the first
time, it (Linux)
seems to really be
a viable option... It
is not quite there
yet, but two years
is a long time in
computer years ”

A Time for Alternatives

Sumod Hajela
Assistant Editor
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Alcohol 120%
Type: Trial Size: 3.41 MB
Mindware\Software\System

Cool Edit Pro 2.1
Type: Trial Size: 16.17 MB
Mindware\Software\Multimedia

CursorXP
Type: Free Size: 2.3 MB
Mindware\Software\Home

Forte Free Agent 1.93
Type: Trial Size: 2.29 MB
Mindware\Software\Internet

Goldwave 4.26
Type: Trial Size: 0.83 MB
Mindware\Software\Multimedia

IncrediMail Xe
Type: Free Size: 5.55 MB
Mindware\Software\Internet

mySQL 3.23.57
Type: Free Size: 12.67 MB
Mindware\Software\Dev Tools

Partition Resizer
Type: Free Size: 0.09 MB
Mindware\Software\System

PHP for Windows 4.3.2 
with installer and manual
Type: Free Size: 5.96 MB
Mindware\Software\Dev Tools

phpMyAdmin 2.5.1
Type: Free Size: 1.6 MB
Mindware\Software\Dev Tools

Sonic Foundry ACID XPress 3.0g
Type: Free Size: 30 MB
Mindware\Software\Multimedia

Trillian .74
Type: Free Size: 2.41 MB
Mindware\Software\Internet

TweakXP
Type: Trial Size: 2.77 MB
Mindware\Software\System

WinDVD Platinum 5
Type: Trial Size: 13.3 MB
Mindware\Software\Multimedia

HIGHLIGHTS

Rise Of Nations
Wheel and deal across time with histo-
ry’s eminent cultures with Rise of
Nations. Create new cities, improve city
infrastructures, and expand national

borders. Conquer foes through military
might using everything—from sling-
shots to cannons to stealth bombers to
nuclear weapons. Corner the market on
key commodities, and consolidate power
under your rule. 
Type: Trial Size: 194 MB
Playware\Arena\Games

Sonic Foundry Vegas 4
Vegas is a digital audio and video pro-
duction suite, allowing non destructive
composing, titling, audio/video record-
ing, editing, mixing, surround sound
production, unlimited tracks, and
DirectX filters and more. Easy yet power-
ful controls allow for complex high qual-
ity keyframe track motion, complex
composites, track envelopes, and loads
of useful features.

Type: Trial Size: 41 MB
Mindware\Software\Multimedia

Microsoft Money 2003
Deluxe
Microsoft Money 2003 Deluxe is a com-
plete personal finance solution that helps
you manage your day-to-day finances,
track and manage investments, prepare
for taxes, and build
a plan for your
future! Balance your
checkbook, pay
bills, bank online,
create a budget,
reduce your debt,
and organise your
finances all in one place while receiving
personalised financial guidance. Syn-
chronise with MSN Money, to access your
Money data on the Web, while you’re
away from home. You could also use
Money for Pocket PC, and your Money
data travels with you.
Type: Trial Size: 0.5 MB
Mindware\Software\Office

6

This section helps you stay
one step ahead of the oth-
ers by carrying a hand
picked collection of vari-
ous useful ‘Tips & Tricks’,
frequently asked questions
(FAQs), some whitepapers,
and assorted e-books. This
month, we bring you Tips & Tricks on get-
ting the best out of your favourite media

players, and FAQs on
hard disks. The Whitepa-
pers that are included,
aim at bringing you an
insight on various stor-
age technologies, such as
RAID, and Storage Area
Networks. Also, do catch

up with some classic literature, in the E-
Books section.

KNOW YOUR CD

MUST TRY SOFTWARE

MINDWARE \ RESOLVE

ON THE CD
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Peanut packs in a colourful Linux desktop and a
fine collection of applications, all packed into a
tiny footprint.

Mandrake 9.1

Knoppix 3.2

Red Hat 9

Peanut 9.5

With Knoppix you can try out Linux without risking
your hard disk—create a live boot CD from the ISO
file and start working within a full-fledged Linux
desktop.

Mandrake is one of the most
user friendly and easy-to-con-
figure Linux distributions
around that comes with
eye candy galore. 
WWoorrtthh  RRss..  11,,990000

One of the most well
known distributions, 
the stable Red Hat 9
comes with an interface
that draws the best from
the KDE and GNOME 
desktops. 
Worth Rs. 2,100

If you have been pondering over which 
Linux distribution to try out, the Digit 
Special Linux DVD comes to your rescue. 
This DVD comes with not just one or two, 
but four superb Linux distributions in their 
latest incarnations. So, go ahead and savour
whatever suits your taste buds the best!

America’s Army: Operations, 
Unreal Tournament 2003,
Sin, Quake 3 Arena
…and many more interesting games

Mozilla Firebird 0.6, GAIM .64,
Opera 7.11, Ethereal 0.9.13
…apart from other Internet utilities

Multimedia
XPde 0.3.5, GLAME 1.0.1, 
DivX 5.0.5 codec pack, 
Mplayer 0.90
…plus lots of other stuff to keep you busy

J2SE  1.4.2, PHP 5.0.0 Beta 1,
mySQL 4.0.12, Apache 2.0.46,
phpMyAdmin 2.5.1
…and many more of the latest development tools

GnuCash 1.8.4, QCAD 1.5.4, 
Tiki CMS/Groupware, Evolution 1.2
…and other handpicked applications
for your office

VNC 3.3.7, gCombust 0.1.54,
GnoRPM 0.96, Acrobat Reader
5.0.7, AWStats 5.5.1
…and other tools to make better
use of your PC

System

Office

Internet

Games

Dev Tools

SoftwareFlavours of Linux
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Note: If your DVD does not autorun, click on Index.html to enter the interface.
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Size: 2.75 MB 
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Size: 166 MB
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Want to subscribe to Digit? 
Or is it time to renew your subscription? 
You can now subscribe online! 
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taste technology at www.thinkdigit.com

BY DEMAND
One world,
One language   
¿Usted habla español?
Well, neither do we, but
you no longer need to
speak, read or write a
language to be able to
communicate using it…

Taking the weight off
your lap 
Wireless technology is seeing a 
new era, thanks to the latest mobile
processors. We take a peek into 
what makes them tick.
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Linux developer SuSE secured
a 2.4 million euro deal with

the German Aerospace Center
(DLR). SuSE Linux will provide
the software infrastructure for
the Colum-
bus module
that will be
launched to
the Interna-
tional Space
Station in October 2004. The
Columbus control centre pro-
vided by DLR will include mon-
itoring and control of Colum-
bus’ on-board systems, the co-
ordination of the European pay-
load operation and the provi-
sion of the communication net-
work for operations and data
distribution. SuSE provides the
software infrastructure for the
module’s data needs. Columbus
will continue to send data back
to earth for the next 15 years.
To handle all this data there are
46 IBM Dual-Xeon servers, two
Sun Solaris systems, almost 25
Terabytes of EMC CLARiiON
CX600 storage, ADIC StorNext
HSM, Legato Networker Backup
as well as an ADIC Scalar10k
tape library with more than 70
Terabytes of storage for backup
and archiving. All this will be
running on SuSE’s Linux Enter-
prise Server 8.
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UUllttrraa  WWiiddeebbaanndd  ((UUWWBB))
■■  WWhhaatt  iiss  iitt??
It is a wireless technology
that transmits data using an
extremely short duration
burst of radio frequency (RF)
energy. Unlike other wireless
standards UWB does not use
a carrier wave to transmit
data. It is faster than Blue-
tooth and consumes less
power. It is being extensive-
ly used for military applica-
tions.

■■  WWhhyy  UUWWBB??
It can be used to set up Per-
sonal Area Networks (PANs).
UWB pulses can be used in
multi-user network applica-
tions, as the UWB pulses
have a short time duration.
It has a very high bandwidth
of 100 Mbps. Also UWB
chipsets would be cheaper
than other wireless chipsets.

■■  HHooww  ddoo  II  uussee  iitt??
Currently there aren’t many
UWB-based products in the
market. But many compa-
nies have started releasing
UWB chipsets. UWB-based
entertainment devices will
allows seamless transfer of
media files between them at
very high speeds.

hypethesis

■ White House mail services were struck by a distributed denial of service attack (DDOS) ■ Slackware—a volunteer distribution of Linux, turns 10  

Intel sees chip
industry plateau

People have heard of and
participated in all sorts of

competitions. But this one
combines the
tradit ional
test of
s t r e n g t h
with a taste
of technol-
ogy. Eastern
Europeans conduct
annual competi-
tions for throwing
mobile phones, yes you read
it right. The current record is
66 metres, with a Nokia
5110. A company called Fen-
nolingua, provides the

mobile phones, and sponsors
the competition. The fourth
such competition will be

held on 23rd
of August,
2003 in
Savonlinna,
Finland. In
case you
want to

show off your
skills you
can register

yourself at the site www.fen-
nolingua.fi/mobile.htm. Prizes
are awarded based on style,
aesthetics and the length of
the throw.

Chip giant Intel says
industry growth will
slow down but remain

in double-digits. 
Chief Executive Craig Bar-

rett said, “I do believe that
growth rates will perhaps
declind b bit. Maybe
they will come down
a few percentage
points, but they will
probably remain double-digit”.

Intel saw its net income
more than double in the sec-
ond quarter of 2003. The com-
pany announced profits of
$896 million compared to
$446 million in 2002. Much of
the increased profit compared
to the 2002 figures were due to
last year’s write downs of areas
such as online services, totaling
$218 million. Intel says rev-
enues for its key product areas

in microprocessors and
chipsets were essentially flat for
the quarter as average prices
and volumes remained stable
from the previous quarter. 

Intel is now to spend more
on R&D in 2003 than it origi-

nally planned. The
move to 65-nm
processes from 90-nm
is now expected to be

around $4.2 billion compared
to $4.0 billion. However, over-
all the company is remaining
cautious over the global econ-
omy and says third quarter
revenues will be between $6.9
billion and $7.5 billion. The
company is pointing to the
new generation of Pentium
processors, Centrino systems
and the emerging 65-nm
processes to drive revenues for-
ward in the future.

Mobile throwing competition 

SuSE in space

16 million 
camera phones will
be sold worldwide 
in 2002, growing
strongly to 147
million in 2007

snapshot

Source: Strategy Analytics

ILLUSTRATIONS: Mahesh Benkar
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When www.defacers-chal-
lenge.com announced

a contest for hackers on
the sixth of July, everyone
in the online business
was worried. According to
the Web site, the first hacker
to deface 6,000 sites; or the
highest number of sites;
would win a prize of 500 MB
of Web space. 

Concerns about the crip-

pling of countless Web sites
were unfounded, as the event
was drawing to a close there
was no sign of damage among
the Web’s most popular sites
such as Amazon.com and
Yahoo.com.

This contest caused vari-
ous reactions across the
industry. Security officials
said that this contest received
so much press attention, that

it would only encourage
more elaborate events in the
future. But, only 500 to 600
smaller Web sites recorded
defacements, which is less
than the 3,000 or so sites that
are defaced on a heavy hack-
ing day.

Others were of the opin-
ion that it was good thing, as
it made people more aware
about their security.

Hacking contest 
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Virus through Spam
A new tool to spread spam
is slowly emerging. Junk e-
mailers are sending viruses
which spread spam anony-
mously. The research done
by Message Labs, an e-mail
security firm says that mass
distributions of junk e-mail
are increasingly coming
from the Internet addresses
of computers that have in
the past sent out viruses as
e-mail attachments. This
could very well become the
largest source of viruses.
Also, finding the source of
such a virus would be diffi-
cult. Such an infection
blends the evils of a com-
puter virus—spam and spy-
ware. Also, it would be very
easy to create variants of
such infections. The only
practical solution to this is to
ensure that e-mail and
attachments are checked
before downloading.

W32.HLLW.Indor.E@
mm
W32.HLLW.Indor.E@mm is a
mass-mailing worm that is
now a high threat level. It
spreads across computers
using Microsoft Outlook. It
sends a zipped copy of itself
to all the contacts in the
Microsoft Outlook Address
Book—with files such as
SaveNow.zip and Report.zip.
When the virus runs, it dis-
plays a fake message that
states “Error in file #1: bad
Zip file offset (Error local
header signature not found):
disk #1 offset: 68669733.
The virus may also spread
through network drives,
floppy disks, the KaZaA file-
sharing network, and mIRC.
Visit http://securityresponse.
symantec.com/avcenter/down
load/pages/US-N95.html for
a removal.

redalert

■ Sony recalled 18,000 laptops because of the risk of users receiving slight electrical shocks due to faulty modems ■ America’s Army has been released for MacOS

The music industry, which
has been perpetually frus-

trated by the continued popu-
larity of peer-to-peer file shar-
ing utilities, finally seems to
have hit upon a tactic that
works. At the end of June the
RIAA declared that it would
track individual users of these
file sharing tools and sue each
of them individually for shar-
ing their files. The compensa-

tion claimed would be
$1,50,000 per song
traded. At that rate
many users would
soon be picking up a
tab of a few million
dollars. In just a week
after the announcement, traf-
fic on these networks has
dipped noticeably. Nielsen-
NetRatings reports that usage
on Kazaa went down by 15 per

cent. Other popular net-
works have also experi-
enced similar declines,
with Morpheus and
iMesh losing 15 per

cent and 16 per cent
respectively. Another pos-

sible explanation is Apple’s
iTunes music store. The service
has already sold over 5 million
songs in the two months that
it has been operational. 
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Decline in file sharing after RIAA
threatens to sue individuals 

Source: OneStat.com

Source: TowerGroup

Sony recently released its
Handheld processor
dubbed ‘The Handheld

Engine’. The Sony CLI PEG-
UX50 will be the first hand-
held to use the chip. 

The hand-
held engine
is optimised
for handheld
devices, with
special emphasis
placed on battery
life and speed. It combines a
Sony manufactured ARM926-
based processor, a Digital
Singnal Processor and a
CXD2230GA graphics accelera-
tor. This is the first time an in
house processor is being used in
the Sony Handheld. 

Sony hand-
held engine  

statattack

➜
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Adobe has announced a
new version of its video

effects package After Effects 6,
and video editing software
Premiere Pro. In a significant
development, the company
said that Premiere will no
longer be developed
for Apple systems.
The new ver-
sion of Pre-
miere has been
redesigned and
developed from
the ground up for
Windows XP. Adobe’s core
audience of creative profes-
sionals are often Mac users.
But recently it is showing
increasing signs of supporting
only Windows, with Apple
developing a lot of tools
which overlap with their
products. Adobe’s strongest
competitor in the video edit-
ing market is Apple’s own
video editing tool Final Cut
Pro.

Adobe and Apple are not
at loggerheads though; they
continue to have good rela-
tions. After Effects continues
to enjoy good sales on the
Mac, and Photoshop remains
the de-facto for photo editing,
with Apple even using it as a
performance indicator at the
launch of the G5.

heroes

Camera phone
mischief
People are using camera
phones to take unsolicited
images. They are taking
photographs of books and
magazine pages that they
need. In South Korea, where
more than 3 million phones
have cameras built-in, the
problem is escalating.
Samsung has banned camera
phones in its offices to prevent
industrial espionage.

Winamp3
Development
stopped by AOL
AOL has stopped developing
Winamp3, and will revert to its
older version for now. The
slow and buggy media player
had shown promise in some
areas, such as the homegrown
language Wasabi. However,
the upcoming Winamp5
(version 2 plus 3) will continue
its development and should be
out late 2003.

The G5 processor powering
the latest Power Mac,

developed jointly by IBM and
Apple, runs at frequencies up
to 2 GHz. Benchmarks
provided by Apple
indicate that the sys-
tem, powered by dual
G5 processors, is con-
siderably faster than
the fastest Pentium 4
based system or even a
dual Xeon processor
configuration. 

But these bench-
marks are being questioned
around the world. The rival
machine that was used here
was a Dell Dimension 8300,
running a Linux operating sys-
tem. There is belief that the

Dell score would have been
much higher if the system was
running a Windows operating
system with an Intel optimised

compiler rather than the
used GCC compiler used. 

All of this is pure
speculation, for exam-
ple, the performance of
Quake III Arena on the
system is reported to be
much higher. However,
other computers around
the world easily match
and outperform the

score of the G5. But, then
again, the G5 uses a 64 MB
ATI Radeon 9600, in contrast
to the 9800 Pro card with 128
MB memory used by the Dell
Dimension 8300.

Indian gamers
The gaming scene in India is
beginning to heat up. Rumors of
console lsystems such as the PS2
and Xbox are filling the scene.
Along with this, new games are
now available quite easily and
legally. This is a great job done
by members of the Indian gam-
ing scene. Also, some credit goes
to the gaming industry for test-
ing out the waters of the Indian
market, despite the piracy.

C-DAC
C-DAC’s (Centre for Develop-
ment of Advanced Computing)
Param Padma Cluster is listed as
one of the worlds top 500
supercomputers. It is sitting at
171 on the list. The top 500
list, compiled by top500.org
lists out 500 of the world’s most
powerful supercomputers based
on raw computing power.

Apple loses
flavour with
Adobe

P2P utility
Morpheus had
231,000 unique
users for the week
ending July 6;
iMesh had
214,000 during
the same period.

snapshot

Source: Nielsen/NetRatings,
InternetNews.com

The 64-bit monster
...playing spoilsport?

Under the Telecom Regula-
tory Authority of India’s

(TRAI) new Interconnect
Usage Charge (IUC), or access
charge regime, all incoming
calls in India have been made
free. This came
into effect on the
first of May, and
since then talk
times on cell
phones have
shown a 20 per
cent jump. The
introduction of
WLL services has
also given a big boost to the
total number of mobile users
in the country, not only those
adopting WLL, but also new
users on the standard cellular
(GSM) networks. Increased
competition has pushed down
prices and increased the total
number of users on the net-
works. The new pricing struc-
ture also makes it more expen-
sive in some cases to call

mobile phones on GSM net-
works from a standard fixed
line. STD calls between
mobiles are also cheaper than
between fixed lines. So, for
many users calling mobile to

mobile is now the best
option. This sudden

explosion of users,
coupled with the

longer talk
times seems
to have
placed too
much stress
on the net-

works, with some users having
to try a couple of times, before
they can make a call or suc-
cessfully send an SMS. Orange
Vice President Harit Nagpal
said, “Earlier, we used to han-
dle traffic of about eight lakh
SMS messages a day. Now the
traffic has shot up five times
with about four million SMS
messages sent across our net-
work alone.”

Increased cell phone usage
due to free incoming calls zeroes

■ PC maker, Dell Computer, to change name to Dell ■ Hackers target a known Cisco router flaw, however no substantial damage is done
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In a move to reorganise its
Open Source Mozilla brows-

er team, America Online
(AOL), laid off 50 employees
involved in the Netscape
Communications develop-
ment subsidiary. Continuing
support of current versions of
Netscape and the Netscape
Web portal is planned by the
Company. 

In an increasingly tough
battle with Microsoft for
browser market share, the lay-

offs mark the latest set-
back for Netscape. More
than 90 per cent of Web
surfers currently use
Internet Explorer, accord-
ing to site visitor statistics
published by Google.

“Netscape remains a
key part of our multi-brand
strategy. “We’ll continue to
support the browser and the
portal,” AOL spokesman
Andrew Weinstein said. 

The layoffs come as the

loose Mozilla.org
group transforms
itself into a non-
profit foundation.
Some of the new
recruits are expect-
ed to come from
Netscape’s ranks.

However, a broad group of
independent volunteers and
staffers at other companies are
expected to continue working
on the open-source browser
effort. 

AOL lays off Netscape developers 

Ever been caught in a situa-
tion when the battery of

your laptop is running low
and you have to find a WiFi
access point? Or when you are
carrying your laptop in a bag?
Every time you have to take
out your laptop, wait for it to
boot and check whether there
is Wi-Fi coverage at that par-
ticular point. In all these
cases, there has been the need
for a device that could check
availability of Wi-Fi coverage
quickly and easily. 

Kensington Technology
Group (www.kensington.com), a
manufacturer of a broad
assortment of devices, has
come up with a product
called ‘WiFi Finder’. The 2.95
x 0.39 x 2.17-inch, three

lights and only one button. 
The button, of course,

starts the search for the
wireless LAN signal and if
one is found, the lights will
show its strength.

Kensington claims that
its device is able to find
802.11b and 802.11g signals,
if the hot-spot is up to 200
feet away. It also filters out
other wireless signals such as
Bluetooth. It is priced at
about $25, and comes with a
1-year warranty.

Motorola is working on a new display tech-
nology, using carbon nanotubes (CNT).

Called the ‘nano emissive display’, the technol-
ogy enables the manufacturers to produce large
flat-panel displays at a lower cost. Motorola
claims that the display quality will be better
than that of plasma and LCD
screens. If everything goes well, we
could be seeing 50 to 80-inch CNT
screens, costing the same as a 32-
inch Cathode Ray screen.

It could also be used for produc-
ing much larger displays such as bill-
boards. Carbon nanotubes can con-
duct electricity, withstand high temperatures,
and are strong and light. These nanotubes, fire
electrons at materials that emit light to produce
colour displays. And scientists at Motorola Labs
in Temple, Arizona have found a new way to
grow nanotubes at low temperatures, which was

the only hurdle to its implementation. This is
important because the substrate with which
they must bond are heat sensitive. Research on
carbon nanotubes has been going on for 10
years, and on this new process for about four
years. The technology can be easily adapted to

be used by plants that manufacture
plasma screens. Carbon nano tubes
can be used to produce a variety of
other devices such as transistors,
memory chips, batteries and sensors.
The company is holding talks with
European and Asian manufacturers
to bring the product to the market.

Motorola had set up a factory in mid 90s in Tem-
ple to manufacture flat panel displays using
microchip technology but the plant was closed
in 2000 owing to certain technological prob-
lems. This time Motorola has promised there
won’t be a repeat act.

Nanotubes in screens

Spot the hot spots sans the power 

■ A US company launches Mexican sales of microchips that can be implanted under a person’s skin, and used to confirm health history, and identity

Tulip Computers, owners of
the Commodore brand,

plan to re-launch due to an
upsurge of interest in the obso-
lete Commodore 64 (C64)
computer and its 1980s-era
games. Tulip estimates that
there are still 6 million Com-
modore users, who can choose
from a range of 6,000 games
which were developed for the
system.

Hardware enthusiasts have
written emulators for Windows
PCs, Macintoshes, and now
PocketPC-based PDAs to enable
original Commodore games to
run on those systems.

Tulip is working with Iron-
stone Partners, which will han-
dle all sales of Commodore 64-
related products worldwide and
take over the main C64 Web
portal. Tulip said that unautho-
rised use of the Commodore
name by other organisations
will soon be stopped.

Commodore 
makes a 
comeback
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“For folks who want
the ultimate experi-
ence, they’ll want the
latest ATI card, and
the fastest processor
available from AMD
or Intel.”
Marketing Director for Valve,
Doug Lombardi, talking
about Half-Life 2’s release

“Google’s a very nice
system, but compared
to my vision, it’s
pathetic.”
Microsoft Executive, Jim
Allchin, talking about their
new search program called
MSNBot that trawls the Net,
and builds an index of HTML
links, and documents

“Like almost every-
one, I receive a lot of
spam every day,
much of it offering to
help me get out of
debt or get rich
quick”
Microsoft Chairman, Bill
Gates, pointing out that
spam is draining business
productivity and that
Microsoft alone cannot fix
the problem

quoteworthy

SoundVu is a technology
under development by

NXT. The technology aims at
producing audio and visual
output from a single surface.
By doing this, NXT aims to
provide a speaker with virtu-
ally no footprint. 

Due to its technology and
size, SoundVu panels can bet-

ter standard phone receiver
systems. The sound quality
provided by such a panel is
much higher than a regular
receiver. But the best advan-
tage of this would be a dra-
matic change in the shape and
design of the phone. This is
mainly due to the integration
of the audio and video units. 

Such technology would
also be very useful in high end
multimedia phones. The
SoundVu technology meets
the needs of 3G handsets. NEC
is one of the first electronic
giants to have shown interest
in this system. It has devel-
oped a laptop with a screen
that works as a speaker. 

Spam filters
on Microsoft’s
MSN and

Hotmail e-mail

services now block

2.4 billion
messages a day

snapshot

Source: MSN

■ Mozilla 1.4 has been released for Windows, Linux and Mac OS  ■ A new bill pending in US Congress could make P2P file swapping a felony

SoundVu… audio/visual integration at its finest

Anew service allows cell
phone users to download

a sound that repels trouble-
some mosquitoes by South
Korea’s top mobile phone
operator. According to SK Tele-
com, the sound is capable of
clearing the insects within a
range of one

meter. The
prime reason
for such a
service is that

mosquitoes are a common irri-
tant during the hot, humid
summers in Korea.

Subscribers of the service
will be able to download the
sound, which will cost 3,000
won ($2.54), from the firm’s
wireless Internet service from
21st July. The sound plays
constantly, consuming pre-
cious mobile battery charge. It
is faintly audible to the
human ear. 

Repelling the bugs will use
up to 30 per cent more of the
phone’s battery power, said
SK, which controls more than
half of Asia’s third-largest
mobile market.

Ring out the
pests? 

tomorrow’stechnology

Two thousand Windows-
based PCs with high-speed

Internet connections in San
Francisco have been hijacked
by a stealth program and are
being used to send ads for
pornography, say computer
security experts. The Trojan,
dubbed ‘Migmaf’ or ‘migrant
Mafia’, turns the victim com-
puter into a proxy server that
serves as a sort of middleman
between people clicking on
porn e-mail spam or Web site

links. It allows the victim
computer to fetch porn Web
ads from an undisclosed serv-
er and pass the ads on to other
computers, either through an
e-mail spam or a Web browser. 

The Trojan is also said to be
responsible for a PayPal scam
discovered last week. Designed
to collect credit card informa-
tion from people who filled in
a form they received via e-mail
claiming to be from Web pay-
ment provider PayPal.

Microsoft announced three
new security breaches in

its software, including one
‘critical’ Windows flaw that
allows a hacker to run any
unauthorised code on victims’
PCs. The flaw known as a
buffer overrun vulnerability
allows an attacker to use an
unchecked buffer to run their
own executable code. The flaw
located in the HTML converter
in Windows, is used by hack-
ers to spread the code either by
sending an HTML e-mail or by
creating a special Web page
that triggers a the code.

The vulnerability exists in
most recent versions of Win-

dows, including Windows XP,
2000, 98, 98 SE, Me, and NT
4.0 Server. The flaw is less
effective in Windows Server
2003, because it ships with a
setting known as Enhanced
Security Configuration
designed to minimise the risk
of unauthorised code being
launched. Microsoft has post-
ed a patch for the vulnerabili-
ty on its Web site.

Hijacked PCs spread
porn 

Critical flaw found in
Windows
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Dear Sumod,
With reference to theJuly 2003 editorial, I feelthat India is the onlycountry in the worldwhere the customer for acomputer peripheral hasto go through ordeals thathave no parallels. Theimporter, distributor, and thereseller mafia here, is unheardof in the other parts of the world.There are ‘n’ number of online stores abroad, from where

you can buy PC components. ‘If they’re made, they’re avail-
able’ is their motto.

However, try buying any component in India, and you
are almost sure to be taken for a ride. Replacement and
repair problems are better left unsaid. Thank you for acknowledging our plight and highlight-
ing our woes. 
Sartaj Sharma 
Via e-mail

Dear Sumod,
Apropos the editorial dated July 2003, the smoke screen is
not yet completely off. Kudos for acknowledging the
ground realities, and the deplorable state the customer is in
today—an act long overdue. Prices for a SATA hard disk are not available with the reseller
because the distributor feels that there is no market for
these drives. CRT monitors are withdrawn from the market
overnight since the TFTs do not sell if their cheap cousins
are around! Indeed, call centres know  nothing about prices,
or anything for that matter. Big bullies, importing  motherboards and processors, see
which way the wind is blowing before answering your
queries about an 875 chipset! Lamington road ‘gurus’ still
wake up at 10 am, have lunch, and then tell you that the PC
components have yet to come, which, in their parlance,
means that the ‘rate for the day’ for all the parts is still being
worked out. Don’t be surprised if CPUs prices fall by 20 per
cent between the time of purchase, and the arrival of the
3.43 Virar fast at Dahisar.  The business carried out at Dalal
Street seems to be far safer.
Ravi Mahadevan
Via e-mail

Dear Raja and Ravi,
Your experiences resonate loud and clear with all of us who have
had the opportunity to buy PC components in the ‘grey’ market.
The stories are always the same, the excuses are quite pre-
dictable. The problem is compounded by the fact that it is the
rare reseller who has both knowledge, and the right attitude.

Q. Do you think publishing bad after-sales experiences
that our readers endure will help improve vendor’s
service levels?

Your vote counts

75.4%

Yes

24.6%

This month’s question:
Question: Your reason for not trying Linux yet?
Don’t know why I should try
To hard to install/use
My favourite application missing
Linux rules my desk! 

Log on to www.thinkdigit.com and vote

Crack who?
Dear Sir,
Please do include software such as 3D Studio Max, Partition

Magic, etc., in your forthcoming Digit interactive CDs. Also,

increase the number of games, and reduce the useless funzone

games. The bitter truth is that the popularity of your magazine

is due to the crackdigit site. The more cracks available, the more

popular will your magazine be. As the crackdigit site is down, I

cannot find cracks to some of the games. I suggest that you

entrust someone with the task of developing cracks.
Thanks,
Sartaj Sharma 
Via e-mail

The death of a PC

Dear Digit,

Congratulations! You have blown up

our PC by suggesting that we use soft-

ware such as SoftFSB. In no time, it

multiplied our Celeron 900 MHz 4

times! Now, could we just ask you to

be kind, and send us a a cheque of

Rs 10,000 for the repairs that you

have literally thrust upon us? 

Thanking you,

Anant and Shantanu 

Via e-mail

AUGUST 2003

Dear Anant and Shantanu,
You have our sympathies for your loss. Over-clocking your PC is always
a hazardous task, as we point out in every article that shows you how to
go about doing it.Where a 10 per cent increase is considered significant,
pushing your system to 4 times it’s rated speed is certain to melt every
chip. We publish your letter here as a cautionary note to all our read-
ers—the speed gain by over-clocking brings with it a corresponding risk
of burn out. Please be careful.

Dear Sartaj,
Over the last couple of issues, we have been dis-
cussing the ills of piracy in this space. Just to make
it absolutely clear, we are not in any way associat-
ed with any crackdigit site, and are most certainly
not getting into the business of “developing cracks”
for  software.

No

ILLUSTRATIONS: Mahesh Benkar
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Trailer trouble

Dear Sumod,

First, let me congratulate you on Digit’s second anniversary. The anniversary issue made

for interesting reading. I have also  noticed that the content that goes into Digit has

improved substantially. 

However, for the past two or three months, you have stopped publishing gaming

articles. Please don’t expect every gamer to buy Skoar, since it’s not available as widely

as Digit. 

Secondly, a different player is needed to play each game, and movie trailers that

are included on the playware CD. This is very irritating. Could you recommend a sin-

gle media player for all these trailers? If not, then please change the trailers’ format. I

strongly believe it will help me, and others facing such problems. 

maxpowersin@....com

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 

Short Bytes
Pleasantries
Hi Digit,
I could hardly believe my eyes when I
read that the August issue would be
carrying  a DVD. It was music to my
ears!. And, I alreadyhave a premoni-
tion that it’s gonna be packed with a
lot of surplus surprises. 

I recently got the 10-CD pack that
was promised with my subscription.
It had all the utilies needed for my
system. Indeed, the CDs have proven
themselves to be useful.

Good job guys! Cheers!

S.Raghavendra
Via e-mail

Hi, 
Read the SOS of Arvind Singh in the
July 2003 issue. The same problem
has been affecting my friend for the
past one year. I have been removing
it using IBM’s DFT (Drive fitness Test)
which I downloaded from the Net.

Arvind  could use the ‘Corrupted
Sector Repair’ option, available in the
DFT to eliminate the problem.
However, the repair may sometimes
make the present installation unusable
(missing explorer.exe, or registry dam-
ages). He should backup data from
Windows to another drive before for-
matting the drive. Here’s wishing the
Digit Team a happy Anniversary.
Love,

Deepu
Via e-mail

Hi! 
I am a regular news stand buyer of Digit.
I noticed that you were conducting a massive
subscription campaign that entailed offering
a 10-CD pack to the subsrciber. You made use
of almost all the languages, except Kannada—
the language of the state where India’s IT capi-
tal is situated. Was this done deliberately?
It seems to me that a state that contributes so
much to the IT sector does not mean much to
you. Is this the message that you wish to spread ?
Please do clarify your stand in this matter.
Thank you,
Ganesh.
Via e-mail

I am appalled to see how partial you guys have
been while advertising for your latest 10-CD

pack offer. The June issue carried the advertise-
ment in all languages—except in Telugu.

I thought that you would carry the advertisement
in Telugu in thefollowing month, but that did not

happen. Don’t be under the impression that no one
with Telugu as their mother tongue reads Digit. In fact,

in my opinion, more than 1000 Digit subscribers are
from Andhra Pradesh. I hope you will not repeat such a

mistake in the near future.
Yours,
Y.Niranjan Prasad
Via e-mail

AUGUST 2003

Dear maxpowersin,
We cannot continue carrying gaming articles every month, simply
because only a small number of our readers, such as yourself, are avid
gamers. However, we will certainly carry the occasional gaming article
to satisfy your needs. As for the multiple format movies, that is how the
movies are made by the original creators. We do not limit our choices
by format, and try to include all the software—players, as well as
codecs, required to view them. You should find this software on the
Playware CD, under the Players folder.

Language babble

Dear Niranjan and Ganesh,It is indeed unbelievable that we missed out on Telegu, and Kannada

in our subscription campaign.We chose the languages quite at random,

and from your response, you seem to have got the message. We had

no intention to cause offence to the Telegu and Kannada speaking com-

munities, or those that speak any of the couple of dozen other Indian

languages we didn’t use, out of the 40 odd recognised.
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In the last 12 weeks, every tech or non-tech
publication contained at least one news
item or article about spam, saying how bad

it is, how the George Bush government will
stop it by passing laws against it, and so on.

Let’s face it! Spam is not going away no
matter how many laws you pass against it.
Stopping spam is far more difficult than carpet
bombing a few countries. It costs almost noth-
ing to send a million e-mails, and is enor-
mously profitable—even if only 10 people
respond, and buy a University Diploma, a
weight loss product, or accept money from the
wife of an ex-president of some African coun-
try. Until people on the Internet become more
alert and savvy, spam is going to be major busi-
ness, and also a major nuisance.

Most spam e-mails originate from China
and some Eastern bloc countries. So, even if
spam is outlawed in one country, your mail-
box will still overflow with spam originating
from other countries. The rate at which spam
is increasing, one or two sender countries
dropping out won’t change the scene much.

Now, since we can’t stop spam, we can at
least try to duck it. There are few ways to do
this. One very popular, but not very effective
way, is to use anti-spam software such as Mail-
washer. This software is free, and very good at
detecting spam in your mailbox. It deletes
spam before you download any e-mails and
bounces all spam back to the sender in order
to appear as an invalid address, and hope that
the spammers will remove your address from
their list. If your e-mail ID is not critical, you
can just create new e-mail accounts every few
months, abandon the old accounts and
inform every one of the change.

I have started a strategy where if I can’t
completely stop spam, I can at least reduce it
to manageable level. The older your e-mail
address, the more important it is to you, and
the more spam it attracts. So if you are some-
one who needs e-mail for your work, then you
should allocate some money every year for e-
mail—just as you do for mobile phones, faxes
or ISP charges. You should sign up for a
domain name, which now costs as low as $7
to $13 a year and buy e-mail hosting—20 MB
or more—as it’s not expensive. Usually the
hosting company will create a master account

for you, and you can create multiple POP3
accounts or aliases for as little as Rs 300 to Rs
1,300 a year. If you don’t want to create mul-
tiple POP3 accounts, create just one main
account. It can be called ab@yourdomain.com.
Don’t give this address to anyone. Now create
few aliases; How many depends solely on how
many different categories you can sort your
incoming mail into—for example, create a
yourfirstname@yourdomain.com for all your per-
sonal contacts. Ask your friends to never sub-
mit this e-mail address to any Web sites which
may offer them goodies in exchange for a
friend’s e-mail address. 

Then create an alias—bank@yourdo-
main.com or abcbank@yourdomain.com—and
use it for banking. Create a separate alias for
every e-mail newsletter you subscribe to and
so on. In my case, I write for various publi-
cations, so I have different aliases such as
digit@vipulshah.com or toi@vipulshah.com for
Times of India.

You can even create a spam@yourdo-
main.com, just for those Web sites which
insist on your registering with them before
you can use their services. Then you won’t
have to bother checking this e-mail, as it
will be full of mailers and offers. Once done,
create different folders in your e-mail soft-
ware and use message rules to route all your
incoming mails to the respective folders,
depending on the address in the To/Cc field
of incoming mails. 

Now, you are not at the mercy of spam-
mers. If one of the above aliases receives any
spam, you can just disable it by adding it to
the ‘nobody’ list, and all mails to this alias will
start bouncing. Also, if you receive spam at
bank@yourdomain.com you know your bank is
leaking, selling or renting your e-mail address
to spammers. You may add this address to the
‘Nobody’ list, and inform the bank that you
don’t wish to receive communication by e-
mail anymore, or even consider taking your
business elsewhere. 

This strategy keeps your options open and
lets you minimise spam, which you can’t do
with free e-mail addresses. We also know that
dot com portals can crash, and thus, so can
your free e-mail address. But your own domain
name protects you from such uncertainties. 

DDuucckk  tthhaatt  SSppaamm

Stopping
spam is far more
difficult than car-
pet bombing
a few countries...

”
“
VIPUL SHAH 

Vipul Shah is a chartered accountant, and writes and consults on Internet, e-commerce, banking and finance 
technologies. He can be reached at digit@vipulshah.com
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For many decades now, the way we
listen to music hasn’t really
changed. If you claim to be an

audiophile, or a connoisseur of fine
music, then you probably have your own
personal acoustical preferences in instru-
ments that reproduce music. However, it’s
interesting to know that the basic tech-
nology powering the speaker has
remained just about the same. 

At the moment, two companies that
have been at the forefront of research in
acoustics have decided to change that.
The secret weapon in their arsenal is an
often touted, but never quite realised
technology that creates focused beams of
sound, similar to the light beams coming
out of a flashlight. The technology that
powers this is known as audio spotlight-
ing. It uses a combination of non-linear
acoustics and some very fancy and com-

plex mathematics. But it’s real, and works
fine enough to knock the socks of any
other conventional loudspeaker. 

Researchers have worked for many
years to focus sound into a coherent and
highly directional beam. It’s never quite
worked beyond the laboratory; at least,
not until recently, when former MIT
Media Labs researcher, Joseph Pompei,
managed to crack the problem by study-
ing current techniques and re-engineer-
ing them. Now, Holosonic Research Labs
and the American Technology Corpora-
tion have come up with audio solutions
that make use of audio spotlighting tech-
nology to create fine audio solutions for
a wide variety of applications. 

Lighting up sound
Audio spotlighting makes for an interest-
ing theory, but you just can’t focus, or

direct a beam of sound the way you focus
light using a flashlight. Perhaps just a lit-
tle, by holding an open-mouthed funnel-
shaped pipe close to your mouth and
shouting. However, this still doesn’t
direct the sound as required. 

The audible portions of sound tend to
spread out in all directions from the point
of origin. They do not travel as narrow
beams—which is why you don’t need to
be right in front of a radio to hear music.
In fact, the beam angle of audible sound
is very wide, just about 360 degrees. This
effectively means the sound that you hear
will be propagated through air equally, in
all directions. 

In order to focus sound into a nar-
row beam, you need to maintain a low
beam angle that is dictated by wave-
length. The smaller the wavelength, the
less the beam angle, and hence, the more

Sound, like light can now be directed, so that only those within its path can hear it.
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focused the sound. Unfortunately, most
of the human-audible sound is a mixture
of signals with varying wavelengths—
between 2 cms to 17 metres (the human
hearing ranges from a frequency of 20
Hz to 20,000 Hz). Hence, except for very
low wavelengths, just about the entire
audible spectrum tends to spread out at
360 degrees. 

To create a narrow sound beam, the
aperture size of the source also matters—
a large loudspeaker will focus sound over
a smaller area. If the source loudspeaker
can be made several times bigger than
the wavelength of the sound transmitted,
then a finely focused beam can be creat-
ed. The problem here is that this is not a
very practical solution. To ensure that the
shortest audible wavelengths are focused
into a beam, a loudspeaker about 10
metres across is required, and to guaran-
tee that all the audible wavelengths 
are focused, even bigger loudspeakers 
are needed. 

Ultrasound to the rescue 
Bigger loudspeakers and source apertures
seemed like an insurmountable obstacle,
until scientists started work on ultra-
sound. Pioneering research in the usage
and propagation of ultrasound can be
traced back to the 1960s, when Orhan
Berktay and other acousticians were
studying underwater sound propagation.
Researchers discovered that if short puls-
es of ultrasound were fired into water, the
pulses were spontaneously converted
into low frequency sound. Ultrasound is
sound that has very small wavelength—
in the millimetre range. You can’t hear
ultrasound since it lies beyond the
threshold of human hearing. Orhan
Berktay studied this and wrote his semi-

nal paper, which established that water
distorts ultrasound signals in a non-lin-
ear, but predictable, mathematical way.
The researchers finally went on to use
this and create directional sonar, but
there was a bigger use of Berktay’s equa-
tion outside of sound propagation under
water. Research in the early 1970s
focused on sound propagation in air. This
is when researchers started firing the
inaudible ultrasound pulses into the air
and discovered that air spontaneously
converted the inaudible ultrasound into
audible sound tones, hence proving that
as with water, sound propagation in air is
just as non-linear, but can be calculated
mathematically. Joseph Pompei’s
acoustic device, the Audio Spotlight
works just like that—it comprises a
speaker that fires ultrasound pulses,
which act in a manner similar to that of
a long, narrow column extending from
the front of the disc. The ultrasound col-
umn acts as an airborne speaker, and as
the beam moves through the air, gradual
distortion takes place in a predictable
way. This gives rise to audible compo-
nents that can be accurately predicted
and precisely controlled. 

However, the problem with firing off
ultrasound pulses, and having them inter-
fere to produce audible tones is that the
audible components created are nowhere
similar to the complex signals in speech
and music. Human speech, as well as
music, contains multiple varying fre-
quency signals, which interfere to pro-
duce sound and distortion. To generate
such sound out of pure ultrasound tones
is not easy. This is when teams of

researchers from Ricoh and other Japan-
ese companies got together to come up
with the idea of using pure ultrasound
signals as a carrier wave, and superim-
posing audible speech and music signals
on it to create a hybrid wave. This is sim-
ilar to the idea of amplitude modulation
(AM), a technique used to broadcast com-
mercial radio stations signals over a wide
area. The speech and music signals are
mixed with the pure ultrasound carrier
wave, and the resultant hybrid wave is
then broadcast. As this wave moves
through the air, it creates complex dis-
tortions that give rise to two new fre-
quency sets, one slightly higher and one
slightly lower than the hybrid wave. Berk-
tay’s equation holds strong here, and
these two sidebands interfere with the
hybrid wave and produce two signal com-
ponents, as the equation says. One is
identical to the original sound wave, and
the other is a badly distorted component.
This is where the problem lies—the vol-
ume of the original sound wave is pro-
portional to that of the ultrasounds, while
the volume of the signal’s distorted com-
ponent is exponential. So, a slight
increase in the volume drowns out the
original sound wave as the distorted sig-
nal becomes predominant. It was at this
point that all research on ultrasound as a
carrier wave for an audio spotlight got
bogged down in the 1980s. 

Berktay’s equation works 
Then, Joseph Pompei realised that the
focus should have been on the signal’s
distorted component. Now since the sig-
nal component’s behavior is mathemati-

Apart from discreet communication sys-
tems and acoustic assault rifles that the
US Army is interested in, there is one
really wild application—Ventriloquist sys-
tems. By using tiny sound focusing
devices to beam out voices and having
them scatter against rocks and natural
obstacles to the path, they can give the
impression of the presence of people in
uninhabited places. 

Tricks of this sort are known as Psy-
Ops—a short form for Psychological
Operations that are used to fight a war
of wits against enemy troops.

Mysterious Sounds

Using ultrasound to generate audible sound
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cally predictable, the technique to create
the audio beam is simple; modulate the
amplitude to get the hybrid wave, then
calculate what the Becktay’s Equation
does to this signal, and do the exact oppo-
site. In other words, distort it, before
Mother Nature does it. Finally, pass this
wave through air, and what you get is the
original sound wave component whose
volume, this time, is exponentially relat-
ed to the volume of the ultrasound beam,
and a distorted component, whose vol-
ume now varies directly as the ultrasound
wave. Once you crank up the volume of
the ultrasound, you can get as high as 80
decibels with just 5 per cent distortion—
not the best in the world yet, but a far cry
from the 50 per cent or so that the Japan-
ese teams faced. The best speakers in the
world can currently get distortion down
to below 1 per cent and research is get-

ting the targeted audio beam very close
to this point. 

Since you can control and focus the
ultrasound beam just like a flashlight, you
can direct it such that you would hear the
sound only if you were in the path of the
beam. This is called directed sound. You
could also bounce the beam off a reflect-
ing surface, so that people in the path of
the audio reflection can hear the sound.
This is known as projected audio. In
short, unlike ordinary speakers, you will
hear the sound only if you disrupt the
sound beam, whether you stand in its
path or in the path of a reflection from
an acoustic mirroring surface. If you step
away from the path of the sound, you will
hear nothing. In either case, the sound’s
source is not the physical device you see,
but the invisible ultrasound beam that
generates it. 

The sound ray is
coming 
The targeted or directed
audio technology is
going to tap a huge com-
mercial market in enter-
tainment and in
consumer electronics,
and the technology
developers are scram-
bling to tap into that
market.  Joseph Pompei’s
Holosonic Research Labs
developed the Audio
Spotlight that is made of
a sound processor, an
amplifier and the trans-
ducer. Aim the transduc-
er anywhere, and direct
and project a three-
degree wide sound beam
that is audible even at
100 metres. The Ameri-
can Technology Corpora-
tion developed the
HyperSonic Sound-based
Directed Audio Sound
System. Both use ultra-
sound based solutions to
beam sound into a
focused beam.

With something as
radical as this coming
into mainstream sound
reproduction, analysts
claim that this is possi-
bly the most dramatic
change in the way we
perceive sound since the

invention of the coil loudspeaker. Sound
as we know it, is a very three-dimen-
sional sensation. But if you strip out the
perception of depth and direction, for
example whilst watching a movie on TV,
we tend to associate the sound source as
being very fixed, and hence unreal. This
is where three-dimensional sound beam-
ing comes in. The technology that the
Holosonic Research Labs and the Amer-
ican Technology Corporation are lining
up may seem to be a novelty of sorts, but
a wide range of applications are being
targeted at it. 

The first lab rats are going to be those
attending exhibitions and trade shows.
With targeted announcements at crowded
shows, audio spotlighting technology may
possibly be the best way for exhibitors to
draw people to their stalls and demon-
strate their product to potential customers.
Supermarkets and retail stores may not be
very far behind either—stand in this aisle
that features detergents and hear the sales
pitch for a new washing detergent, stand
in the other and find out about the latest
meat bargains. Retail displays and kiosks
are possibly going to be the first to get
wired up. Soon after this, spotlighting
technology can also be built into vending
machines, which might entice you to stop
by for a refreshing cold drink as you pass
by. There is an even bigger market for per-
sonalised sound systems in entertainment
and consumer electronics. You could be
wired up for spotlighting in the future with
your home theatre audio system, and
could experience sound as it was original-
ly heard, possessing direction and move-
ment, and this will be tuned to your
favourite couch-potato position. If you just
have to watch that show that everybody
detests, then you could use a personalised
spotlight that turns off the audio for every-
body, except you, since you will be sitting
right in the middle of it. Movie theatres
could also jump onto the bandwagon,
with live moving voices coming in from
all over the screen, movies would be truer

U2 front man Bono, is reportedly inter-
ested in systems such as the Audio Spot-
light—and U2 is now working with the
Holosonic Labs to create Audio Spot-
lights for rock concerts, where they are
looking at giving users the kind of wild
sound shows that are currently possible
with light.

U2 and us…
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This is where you are going to 
experience audio spotlighting

Personalised messaging:
Using targeted sound, 
you could message people
in high activity areas 
such as construction sites,
and factory floors.

Acoustic assault rifles: 
You could employ sound to
fire focussed, high-energy
acoustic bullets that could
be used as non-lethal
weapons to deter crowds

Realistic movies:
With targeted sound,
movies could become 
more realistic, with the
sound moving, along with
its source on the screen. 

Discreet announcements:
In museums and exhibitions,
using audio spotlighting
techniques to discreetly
inform people, without 
raising ambient sound levels

Consumer electronics:
You could use focussed
sound in televisions, and
home theatre systems, to
give realistic sound effects. 
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to life and enormously entertaining. 
Holosonic Labs is working on another

interesting application at the Boston Muse-
um of Science that allows the intended lis-
teners to understand and hear explana-
tions, without raising the ambient sound
levels. The idea is that museum exhibits
can be discreetly wired up with tiny speak-
er domes that can unobtrusively, provide
explanations. There are also other inter-
esting applications that they are looking

at, such as private messaging using this sys-
tem without headphones, special effects at
presentations as well as special sound
theme parks that could put up animated
sound displays similar to today’s light
shows. Holosonic has installed their Audio
Spotlight system at Tokyo’s Sega Joyopolis
theme park. One of the most interesting
applications though, is the one fitted 
in the DaimlerChrysler MAXXcab proto-
type truck. Holosonic put in four individ-

ual Audio Spot-
lights into the truck
to let all the passen-
gers enjoy their
own choice of
music. This has
been successful
enough for them to
start looking at
marketing this
commercially. 

American Tech-
nology Corporation
has also been look-
ing at emerging
consumer and non-
consumer markets,
targeting consumer
electronics and
home entertain-
ment as well as a
decidedly niche
usage in the mili-
tary. The US Navy
has installed sound
beaming technolo-
gy on the deck of an
Aegis-class Navy
destroyer, and is
looking at this as a
substitute to the
radio operator’s
headphones. To
keep track of what’s
going on around

them, as well as the radio chatter, users
generally keep one ear off the radio
headset. With this system, all the infor-
mation can be piped into the operator’s
ears, without them having to wear bulky
headsets. 

There are even bigger applications as
far as the military goes. One of them is a
very loud hailing device to catch the
attention of ships further away, though it
does not use ultrasound as the underly-
ing technology. Still more interesting is
the idea of non-lethal acoustic assault
rifles that fire sound pulses. Pump up the
normal sound being transmitted to about
150 decibels or greater, and you could fire
out pulses that could disorient human
targets, even causing them severe physical
pain. The weapon could also be fine-
tuned to bring on further discomfort.
American Technology Corp is looking at
Jeep mounted units that could be
deployed as a mob deterrent. 

Sounding right
There are even more interesting applica-
tions in the pipeline—car-based safety
audio systems, discreet speaker phones
and many more such interesting applica-
tions. Over the next few years, the way
we experience sound may change
dramatically. We will reproduce sound
just the way we experience it in the real
world. Is it time to trash your boom box?
Well, not yet, but pretty soon, the next
big bang in sound is going to come
straight out of the air, riding on inaudible
ultrasound.

SRINIVASAN RAMAKRISHNAN

(srinivasan_ramakrishnan@thinkdigit.com)

Take a ride in the MAXXcab and headbang to metal, while your parents listen to oldies

1/4 AD

There are other alternative approaches to
creating targeted audio, other than the
ultrasound modulation technique. One is
the parabolic dish approach that essen-
tially uses antennae to focus and direct
sound. Here, a relatively omni-directional
loudspeaker is placed at the focal point of
a parabolic dish pointing towards it.
When the loudspeaker generates the
sound signal, it acts as a point source,
emitting waves that reflect off the
parabolic dish which is pointed towards a
particular direction. This is very much in
use, but the problem here is that the
size of the parabolic dish required to
accommodate the longer wavelengths of
lower frequencies is too large.

Beaming alternatively
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Casio WQV3 Wrist 
Camera Watch 
Smile at my wrist please

The Casio WQV3 is a wrist camera
that allows you to take pictures in
a digital format, which can then be
sent to your PC. It uses a 25,344-
pixel colour CMOS sensor to capture
images, which are displayed on a 16-
grayscale monochrome LCD panel.
The watch has memory capacity that
allows you to store up to 80 images.
Infrared data communication is used to
export the images.

Sony CLIÉ PEG-NZ90
Will you CLIÉ?

The Sony CLIÉ PEG-NZ90 uses a 2-
megapixel digital camera, featuring a
built-in flash, and auto-focus
capabilities. Along with this, 
it also features a Wi-Fi (802.11b)
communications slot and integrated
Bluetooth connectivity options.

▲▲

▲
▲

▲ ▲
Siemens SX1 Smartphone

Get Siemens Smart

In this first smart phone by Siemens, the
buttons are placed around the screen for a

sleek look. It has a 64 K colour display, and
weighs 110 grams. It has a video player, FM

radio player, and a camcorder. 
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An ensemble of elements that embody another vista
of time…
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Fossil PDA
Watch my PDA

Fossil has incorporated the popular Palm OS
into its watch to provide a product with
unique functionality and style. Inputs are
made using the touch screen and a 2 MB
memory is provided to easily store files.

CASIO DBCW150D-7 
Wave-Ceptor Wrist Watch 
The exact time

The Waveceptor watch from Casio provides you
with the most accurate time standard. It is
synchronized with the Atomic Clock that
regulates accuracy using calibrated radio signals.

Along with this, it has the regular databank
functions that keep you organised.

Handspring Treo 600 
Treo’s a company
The Treo 600 is a fully

functional PDA 
which comes shaped in a

phone for easier
portability. It features a

fully functional QWERTY
keyboard layout and

runs PALM OS 5.2.1 It
will support 32 MB

RAM 
and has a 160*160

pixel screen.

▲▲

▲ ▲

�����

▲ ▲

�����



38

features ■
■ firsthand

Linux! Say the word amidst a crowd
of computer novices, and you will
witness a vanishing act. Linux has

developed an image of being extremely
complicated, and for most general users,
a major headache. This is the primary rea-
son why Linux is not even considered an
operating system for the home user,
despite its crucial advantage—cost-effec-
tiveness. The same is the case for corpo-
rations and employees. Why lose out on
productivity for no apparent reason?

But will this always be the scenario?
Linux has been around for some time
now. Hence the excuse that it is a rela-
tively new entrant, and will take time to
develop, now holds no weight.    

OS on Steroids?
The major task of almost every PC is office
productivity and games. On an average,
the life expectancy of a PC in India is about
4 years. Now, consider upgrading your
Windows every 2 to 3 years. This alone

would set you back by as much as Rs 6,500.
And when you look at licensed application
software, few go further than another flag-
ship Microsoft offering: Office could cost
you as much as Rs 15,000. What this effec-
tively means is that in a year, you could
easily spend up to Rs 5,000 on your PC.
And if you work in a corporate environ-
ment, multiply that figure by the number
of employees in your firm. 

Linux cost savings are also helping
create a cheaper computing environment

Break on
���������������������	
���

AUGUST 2003

ILLUSTRATION: Mahesh Benkar

Why hasn’t Linux invaded our lives? We take a look at the Linux penetration in Indian offices,
and the different projects and programmes that look to introduce Open Source Solutions
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around the world. A few noteworthy
projects are making progress. One of
them is the Simputer. It aims at providing
access to computing at the grass root lev-
els in India, and its ultimate goal is to
enable illiterate people to use the device.
Thus it aims at being inexpensive and
Indianised. The Simputer trust has been
developed to ensure that such a noble
project does not fade away due to lack of
interest or funding.

The problem with Linux lies in the
availability of application software.
Unlike Windows-based application soft-
ware, Linux-based software isn’t freely
available, even in software stores. The
major reason for this, in turn, is the lack
of popularity of Linux. Then again, if it
were popular and available in stores, the
cost factor of buying Linux application
software would come into play.

Trevor Warren, consultant for Red
Hat, encompasses the problem of Distri-
bution very simply, “Whatever your
required application, there is a good
chance you get it off the Net. Popular dis-
tributions provide a large number of
applications off the box. The specific
application that you may need is just a
download away.”

Linux is a lot more than a cheap buy.

On its own, it is a stable solution and a
great choice for many computing needs.
This could be a very important reason for
people to switch to Linux. When you run
applications on a Windows environ-
ment, invariably you encounter a system
crash or a lock-up at some point or the
other. A very important fact that most
experienced Windows users overlook is
the underlying anxiety while working on
the system. This anxiety is due to the
worry that a system crash or lock-up can
potentially disrupt an entire days work.
But this is not so in the case of Linux.
Since it is a derivative of Unix, its stabil-

ity cannot be ques-
tioned. Uptime is usu-
ally measured in terms
of weeks and months
for a Unix-based OS. 

The common per-
ception of users is that
Linux does not have
technical support. But
this is not true. The rea-
son behind this is that
people do not search
for support in the right
places. Similar to its dis-
tribution model, sup-
port for Linux is also

based primarily on the Internet. For tech-
nical support, the open source communi-
ty is the best solution.

But According to Trevor Warren, “The
system of support is the same for Win-
dows or Red Hat. Support and updates are
available off the Web.” Adding to this,
you can also expect support from the
large online Linux community. 

To save on costs, State Institutions
are ideally suited to switch to Linux. The
West Bengal Pollution Control (WBPC)
board has undertaken a project to devel-
op an information system for their entire
network, titled the ‘Environment Man-

The IITs have always been at the forefront
of research into new horizons. With the
Affordable Solutions Lab (ASL) at the
Kanwal Rekhi School of Information Tech-
nology (KReSIT), practical deployment of
Linux is now possible. The ASL is walking
the thin line of making computational
facilities cheaper without having to com-
promise on performance. 

ASL can be called a simulation envi-
ronment in the simplest of terms. Corpo-
rations interested in switching to low cost
systems can bring their needs to the lab.
Based on these needs, a test bed is set
up, and the corporations can see their
system function exactly as it will, when
implemented. Also, the hesitation to
make the switch is removed with the
presence of such an institution as an IIT
offering support. 

Though the lab is in its initial stages,
a lot of progress has already been made.
During the set up, a set of tests are
performed which make assessments

regarding the performance, stability and
security of a system. The basic set up is a
server with connected diskless nodes
(also called ‘thin clients’), which receive
information via a browser environment.
This reduces the thin client system
requirements, and ultimately the cost of
the entire network. A typical thin client
costs only about Rs 15,000, as opposed
to Rs 20,000 for normal entry level desk-
top PCs. 

Dr. Deepak B. Phatak is a professor
who is closely involved with the opera-
tions of the lab. He is extremely opti-
mistic about the results. According to
him, the acceptance of a cheaper solu-
tion will be possible only if the end user
is convinced that the solution is a safe
and workable one. According to him the
lack of interest for an Open Source OS is
due to lack of applications. The only way
that users can try out the OS is if applica-
tions do exist. But this results in a vicious
cycle as major software developers will

only make applications if a market exists
for them. He believes that projects such
as the ASL can help break this cycle. By
providing a solution and backing it with
the ASL name, an end user will feel reas-
sured about trying out the system.

When asked about computing in gen-
eral in India, he feels that a mutual par-
ticipation is required. According to him,
for Computer penetration to increase at a
faster pace, his plan must be adopted. 

Dr. Phatak says, “Governments,
schools, colleges must increase their
investment in IT by a factor of 4. At the
same time, the industry should give solu-
tions at a quarter of the current cost.
20 Million desktop PCs must be sold in
order to make India an IT powerhouse.
A 16X growth factor is required to attain
this. This is only possible when the cost
of a desktop drops to Rs 15,000. Only
then will people will believe it. The ulti-
mate aim is to make a PC cost less than
a TV”.

IIT: Affordable solutions for everyone!

Business takes 
a conservative

approach. Trying to
implement something
that will take time 
and effort to under-
stand defeats the 
principle of savings 
in free software.

Frederick Noronha
A freelance writer
and an active
member of the
Linux community 

““
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agement Information System’. It is one
of the first forays into building a system
on open source software. The WBPC
board uses Linux servers to run their
state-wide operation. But the move to
the desktop has not been ignored. The
WBPC has 110 computers in operation.
As of now 12 computers are running on
Linux. Once the simputer project is
implemented, the operation and pro-
cessing will be done by the servers, and
most client tasks will be restricted to
browsers—thus providing an impetus
towards cheaper operating systems. Such
a project explains just why a large body
should make the switch.

Such a change is even more obvious
for cash strapped educational institu-
tions. Such programmes are under devel-
opment in places across India. As of now,
three sizeable projects are underway in
Chennai, Goa and Kerala. Demo@Schools
is a project that has now come under the
hood of the Free Software Foundation. It
aims at popularising free software to the
masses. The project is trying to convince
educational institutions to replace their
proprietary software formats and provide
free software replacements. In a similar
manner, Goa and Kerala are seriously
considering the adoption of GNU or

Linux based solutions to educational
institutions.

Linux: All Talk and no substance?
So far so good, but then, why is Windows
the desktop of choice? A simple analysis
of our computer market will provide the
answer. When a PC is purchased, it is like-
ly to come with Windows preloaded. Sys-
tem Assemblers do this simply because
they do not wish to be confused, or con-
fuse customers with multiple choices.
Linux is not considered, simply because
of user fear. This is one of the main prob-
lems of Linux. Since its inception, a lot
has been done to make Linux user-friend-
ly. But the problem here is that the end

user is not aware of this fact. Also, the
usability of Linux still does not match a
Windows OS. With such an aura, would
anybody use Linux? 

If some heroic soul does make the
decision to use Linux, he has to choose
between many Linux distributions—Red-
Hat, Mandrake, Caldera, etc. It is difficult
to make an informed choice of which dis-
tribution is best for what scenario. This
again makes an organisation think twice
about making a switch. Though all the
flavours of Linux are quite interoperable,
many are concerned about support and
compatibility with other systems. 

Another problem that comes up is
application selection. An organisation
may probably have a set of applications,
used by employees to perform various
tasks. When the switch to Linux is made,
applications that do the job just as well as
their Windows counterparts need to be
procured and deployed. After all of this,
you still have to learn the differences in
operation commands with Linux, and
will have a long way to go before you
become a power user. 

Since Linux is open source, there are
many companies that develop the differ-
ent variants of Linux available today. In

contrast to this all the versions of Win-
dows have a similar interface. But, there
is more to this than meets the eye.
According to Trevor, the problem lies in
clearing the image of Linux. “Defining a
proper Business Model for an Open
Source development is a major hurdle.
Linux is equally user friendly and appli-
cation support is available. But the costs
required to push this notion around the
world are enormous.”

The Transition Process…
It is not possible to simply switch from
one OS to another. The transition period
is one of the most important stages of the
entire process. The final decision as to

switch or not to switch is dependant on
the success of the transition. During the
transition period, one must critically test
out the areas in which the system will be
used most. 

The first thing that must be done is a
thorough analysis of the system. The two
major roles of Linux as an OS are at the
server level and at the desktop level.
Linux has already been accepted as a
good solution for a server. This is also due
to the interoperability between a Linux
server and Windows workstations.

But the real challenge is getting
Linux to the desktop. While it may not
be very difficult to convince a system
administrator to switch to Linux, try
convincing an accountant, using Tally
on his Windows-based machine. The
ultimate goal here is to provide the same
operating environment at a lesser cost.
A non-technical user should easily
understand the applications and the
desktop interface used.

Nowadays, this can be done easily
thanks to the availability of different
kinds of software for the Linux system.
But the biggest problem is changing the
mental outlook of the employee. “The
most important task for both the system

Well we all know that Linux is a sizeable
power in the OS market. But, does
Linux have a bearing in India? Yes! India
is definitely an important global
resource in terms of computing. The
amount of technical brainpower cou-
pled with the sizeable English speaking
populace has made the Indian employ-
ee a much sought after worker. Thus it
makes sense that the Open Source
movement should catch up to India.
The movement also gives programmers
a chance to demonstrate their own skills
independently rather than be forced to
follow an organisation.  

In India, most software currently
being used is pirated. Software sales
have suffered due to this. The gaming
industry has almost given up on India,
due to piracy. Here, Linux has an advan-
tage. It is either free or available for such
low prices that the question of piracy
doesn't arise. The Indian users’ need for
cheaper introductory PCs can also be
realised by offering a Linux OS pre-
loaded. 

Why focus on India?

It’s a chicken and egg story. A
mature product such as Tally is

available for Windows. There is no rea-
son to switch over because it is doing
quite well. The other available pack-
ages do not have the functionality that
Tally can boast of.Deepak Phatak

KReSIT, IIT Bombay

““
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administrator or the home user is mapping his uses of the sys-
tem. There are advantages and disadvantages to both. If you need
Office productivity software and Internet access, Linux can pro-
vide a cheaper solution without skimping on the features. But if
you are a gamer, Windows becomes the preferred choice”,  says
Trevor Warren.

To master Linux, you need to have sound knowledge of the
Command Line. But for a regular employee, is this needed? Nowa-
days, most Linux distributions have a decent GUI environment.
Thus, if you can provide basic training to a user to operate in the
Linux environment, he or she will be able to achieve the same pro-
ductivity as on a Windows machine, at a much lesser cost.

An employee perspective…
While corporate planning and a complete analysis of using Linux
is pleasing to the ear, an employee or home user has a radically
different approach to computing. The PC is just a tool after all,
and getting the job done as quickly and efficiently as possible is
all that matters. Employees still have to maintain their deadlines,
and the ‘if it isn’t broken, don’t try to fix it’ attitude still prevails. 

The situation is even worse for the home user. Unless you
have a resident geek in your family, you will never consider run-
ning a different OS. To become the ideal choice for the home user,
Linux needs to have simple installations, ease of use, availability
of common applications and good support for games. Home users
don’t want to use the command line. Does Linux fulfil all of these
demands? Not quite. Linux does not have a difficult installation,
but it could be made a lot simpler. The ease of use is not quite up
to Windows standards, and Linux game support is still in its infan-
cy. Then why would a person switch to Linux? In such a case, low
costs do not matter. What is the point in having a free OS that
does not allow you to run Quake III Arena with ease? This also
results in piracy. 

Making a decision to move to an Open Source system or
remaining with a proprietary solution is no laughing matter. It
takes a great deal of time and research. But the move definitely
pays off if you do your analysis well. Large corporations such as
LIC and IDBI have definitely shown an interest in moving towards
a more affordable computing system. This has resulted in confer-
ences and talks between experts, corporations, academia and gov-
ernments. But a proper and concrete platform for people to dis-
cuss the future of Linux in India is still missing. Only when this
platform is built will the final piece in the puzzle fit in.

AAYUSH IYER (aayush_iyer@thinkdigit.com )

SRINIVASAN RAMAKRISHNAN(srinivasan_ramakrishnan@thinkdigit.com)

Linux is being touted as the key to proper e-governance. The
obvious cost benefits in terms of OS licenses and the savings in
the hardware usage lifecycle are enormous. Slowly, institutions
and state run offices are realising that the open source world is
ideal for them. In fact, most of these offices are yet to be comput-
erised, thus the so-called transition period does not apply here.

Educational institutions are also trying to push Free Open
Source software into their labs. This is an extremely important
move, and will ensure that people are not restricted to proprietary
or open source solutions. This will also allow people to accept and
implement more affordable computing solutions for cash
strapped educational institutions. 

The Open Source Institution
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The Digital Media
Test & Research
Centre (DMTRC)
conducts a series

of elaborate tests to eval-
uate the merit of each
hardware and software
product. To ensure that
our readers have all the
information they need to
make an informed buy-
ing decision, engineers at
DMTRC evaluate and
review the latest hard-
ware, software and technology services in accor-
dance with the most up-to-date evaluation
processes and methodologies used around 
the world. 

Comparison Tests
We use a dual rating system, the first of which is

applied to the Comparison
Tests in which we compare
the performance of products
within a particular category.

Each product is evaluat-
ed under different parame-
ters such as performance,
value for money, features,
warranty and support, etc. 

Weightages are then
applied to the various test
parameters according to
their importance for 
that particular category of
products. 

These weightages are
then used to arrive at an
overall grade for each indi-
vidual product. An overall
grade of A+, therefore, indi-
cates that the product is
close to perfection.

The Awards
Digit awards out-
standing products
by selecting a Best
Performance and
Best Value winner in
each comparison
test. The winner of
the Best Perfor-
mance Award will be
the product that
scored the highest in
the performance seg-
ment of our tests.

This award represents the best performing prod-
uct in our tests and doesn’t factor in any other
parameter such as value for money, features, sup-
port, etc. The winner of the Best Value Award
will be the product that scores the highest in
our value for money parameter which is derived

taking into account the ratio of
a product’s performance and fea-
tures to its price. The product
winning this award offers good
performance at a great price.

In Bazaar
The second part of the rating system is used to
evaluate individual hardware and software prod-
ucts in the Bazaar section. The evaluation covers
parameters such as performance, ease of use,
value for money and the build quality and fea-
tures of the product in question and then arrives
at an overall rating. 

Here each of these parameters is given a
weightage of 25 per cent and is rated on a scale
of 5, which is represented by arrows ( ). 

The greater the number of arrows, the better
the product. This simple five-point rating system
is designed to give you an easy-to-interpret
assessment of a product. For example, a product
that receives an overall score of five arrows sig-
nifies an outstanding buy!

How we Test
On the mat this month are
the biggest and fastest hard
drives and Linux distribu-
tions fighting for the top
slot. In the software compar-
ison test, seven Linux distri-
butions were tested, based
on their home desktop abili-
ties that would let them act
as complete replacements to
Windows and let users
migrate with ease. To give
you the complete picture on
these Linux distributions,
they were also evaluated on
their ability to function as
full-fledged office desktops
that would let users perform
standard office related com-
puting work on them. If
you’ve been looking at
switching to Linux, this is
where you can
start. 

The hardware compari-
son test this month featured
13 SATA, Ultra-ATA and IDE
hard disks. The hard disks
were evaluated on several
parameters using standard
benchmarking tools and
were also subjected to real
world tests, which simulat-
ed daily usage patterns on
each disk to get realistic
performance values. Cost
was also factored in to give
you the final results. There
you have it—find out which
is the perfect storage solu-
tion for your needs.

Bazaar this month
brings to you the inside
information on a wide
range of hardware—from
the Intel Pentium 4 3.2
GHz processor to the Dell
Latitude laptop and HCL
Beanstalk 4458 PC. 

In Test this Month
It looks good and the technology is glitzy, but does it do the job?

Excellent: A brilliant combination of price, performance and features—far 
beyond expectations
Good: A good buy, better than most products in its category
Average: Reasonably competent but nothing spectacular about the product
Mediocre: Does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be 
used for its target application

The 5-point Rating System used in Bazaar
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With the Gigahertz wars underway, the need for faster and 
hard drives was expected. We test the best hard drives ava
the Indian market, to see which of them compliment your
configuration, as well as your pocket

E
very year, most computer
users spend money on one
particular component that is
most fragile, and at the
highest risk. It puts compa-
nies, and home-users alike,

on pins and needles when it starts acting
up, which just goes to show how impor-
tant it is. It’s the hard drive—a versatile
digital storage medium. 

Today, if you conduct a survey, you
will notice that the minimum capacity of
the hard drive that your vendor is likely
to put in your system is 40 GB, unless you
specify a different capacity. Does any one
require such a mammoth digital storage
space? Well, when you think about it, we
don’t even require the latest, and fastest
Pentium 4 processors. It may not be the
need of the hour, but it is always advis-
able to make your PC as future proof as
possible, considering that the default
installation of Windows XP needs about
1.2 GB—only for the operating system—
then there are applications that increase
in size with every new version. The latest
games require at least 1 GB of space, the
vast MP3 collection that you are going to
collect over time, and last but not least
movies—all these space mongering col-
lectibles are sure to fill up a 250 GB hard
disk in no time. Although, as of now, a
250 GB hard drive seems too large to be
even considered, it will soon become a
standard accepted level. Remember, what
people said about the 40 GB hard drives
when they were launched, while 4 GB
was still the norm?

So why are we doing a HDD test? A
gamer would like his hard drive to per-
form well enough to load 3D games
faster. A multimedia professional needs to
see the load time of his heavy graphic
software dwindling, while a normal user
just wants to get movies, documents, and
songs copied, and ripped faster than ever
before. With hyper-threading already on
desktop PCs, multi-tasking has acquired a
new dimension, and the hard drive sub-
system needs to complement, and keep
pace with latest components. Since SCSI
is not only complicated, but also costly
for desktop systems, one has to settle for
IDE, or the latest Serial ATA drives. 

However, in no way should these

drives be underestimated. An 
133 drive can load applications,
fer data at high speeds. The du
tage of higher capacities, and 
hard drives is that you get optim
for storage space. The per-rupee
every MB of the data that you st
hard drive, has come down d
Ironically, you can get a highe
hard drive for the same amoun
spent on your existing hard dr
calculate the capacity of the h
and make a note of the amount
spent on it, you can come up w
to MB ratio that will help you bu
hard drive that is within your b

This article will provide you
insight needed to arrive at a pr
sion when a new hard drive be
need of the hour. We tested
brands of hard drives, with capa
range from the current entry-lev
to the humongous ones. The 
that we have tested are the no
drives, and the newer Serial ATA 
also provide you with buying tip
an informed buying decision w
enable you to choose a drive tha
your needs for a long time to co

Test process 
The IDE and Serial ATA (SATA) d
tested on a test PC that comprise
tium 4 3.2 GHz, on an Intel i875
terwood) motherboard, with 5
Dual Channel 400 MHz DDR SD
video card used was a GeForce 4
with 128 MB of DDR memory.
SATA, 120 GB hard disk was in
the port 0 SATA channel. All the
drives were connected to the po
channel, while the IDE drives 
nected to the Primary IDE chann
ter drives. The necessary dri
benchmarking utilities were loa
the drive after installing Window
latest drivers for the main boar
IDE channel were installed. The
are the benchmarks used to  ev
performance of the hard disk

HDTach 2.6
In this test, sequential read a
read burst speed, average access
CPU utilisation are noted down
the first in the battery of tests 
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conducted on the hard drives. HDTach
2.6 is used to test the hard drives without
installing any other software on it. The
logic behind this is that the software tests
the raw unformatted hard drive and
provides us with results, without
making any modifications
to the hard drive. A
graph displays the
results, as the data is
read and written in
real time. After the
test is done, the suite cal-
culates the total CPU
power consumed by the
drive during the test. In
real world conditions, the drive is not
likely to excede this CPU utilisation per-

centage since the disk is continuously
accessed during this test.

SiSoft Sandra 2003 Pro (File 
System benchmark)
This is a synthetic benchmark, and gives
us vital information about the drive, such
as transfer rate, sequential and random
read as well as write
speed, along with
average access time.
The benchmarking
suite reads and writes
the data to the disk con-
tinuously, and in the end,
gives individual as well as
overall scores. These scores of
the tested hard drive are com-
pared to that of other hard
drives on a reference score
sheet.  

Real world tests (File transfer tests):
This is a new category that we have intro-
duced to test hard drives. This test mimics
a user’s daily usage pattern. A user gener-
ally moves, or copies data from one place
to another. It may just take a few seconds
for a single file, but when moving huge
amounts of data, it could take anything
from a few minutes, to an hour. This can
really get frustrating, and hence it becomes
important to test the hard drive in a real
world environment. The tests consisted of
transferring an assorted file set of 1 GB,
and a single file of 1 GB from one parti-
tion of the hard drive to another.

These test results are very important
as they directly reflect the true perform-
ance capability of the hard drive’s read
and write speeds in a real world environ-
ment. Poor scores in this test indicate
lower read and write speed capabilities of
the hard drive.
Adobe Photoshop load time (Applica-
tion load time): In this test, we made a

fresh installation of Adobe Photo-
shop on the hard

drive, and
noted down
the time

taken for
Photoshop 7 to

start. This test gives
the performance of the

hard disk when put under
load by heavy graphics software

such as Photoshop.  

Adobe Photoshop file load time: This is
a very stressful test in which we loaded,

and recorded the time taken for 
Adobe Photoshop to open a 200 MB TIFF
image file.

Test analysis
In all we tested 13 hard drives from three
major manufacturers—Seagate, Samsung,

and Maxtor. Of these 13 drives, Maxtor
seems to be gunning for the future,

and sent us three SATA drives,
and one ultra ATA drive.

On the other hand,
Seagate seems to be
playing safe, and

sent one SATA, and
two IDE drives. Sam-

sung’s bandwagon com-
prised of six IDE drives, with
not a single SATA drive. The
drive capacity ranged from a

minimum of 40 GB to a mammoth 250
GB. Let’s see how the drives fared on both
the performance, and the features front.   

Features, specifications, and bun-
dled accessories
On the features front, not a single drive
matches the specifications of the Maxtor
Maxline Plus II—it simply blows the com-
petitors away. The Maxtor Maxline Plus
II comes with a mammoth 250 GB of
storage space, and an impressive 8 MB
buffer, which makes for an unbeatable
performance combination. All these fea-
tures are further enhanced by the provi-
sion of the Ultra ATA 133 interface. In
fact, all the tested Maxtor drives came
with a 7,200 rpm spindle, and an 8 MB
buffer. Not only is a larger buffer good for
performance, it also comes in handy dur-
ing disk intensive tasks. 

The Seagate ST3160021A, sported the
second best feature list amongst the ATA
drives, followed by the twins from Sam-
sung. The Samsung SP0411N, and
SP0802N drives came in third, with a good
amount of storage space, an ATA 133 inter-
face, and a 7,200 rpm spindle speed, mak-
ing them an ideal choice for desktop data
storage, at an irresistible price. The other
ATA hard drives, especially those from
Samsung, were not feature rich but yet
made an excellent bang for the buck with
a decent performance, and price factors
taken into consideration.

In the SATA category, nothing came
close to the 200 GB Maxtor DiamondMax
Plus. It comes with an 8 MB buffer that
compliments the 7,200 rpm spindle speed
really well. All the SATA drives from Max-
tor come with both, the SATA and Molex

Tracks and sectors: A hard disk consists
of platters on which data is stored. These
platters consist of tens of thousands of
tracks that are tightly integrated in con-
centric circles. These tracks contain loads
of vital information, and thus are broken
down into sectors. Hence, a sector is the
smallest addressable unit that can hold
512 bytes of information. 
S.M.A.R.T: The Self-Monitoring Analysis
and Reporting Tool system uses internal
hard disk monitoring technology to
analyse your hard disk, and prevent hard
disk failure, or data loss. 
Bad sector: A sector that cannot be used
due to a physical flaw on the disk is
called a bad sector. 
Clusters: A cluster is a logical unit of
storage on a hard disk, or a floppy drive.
The size of a cluster varies from 512
bytes, to 256 kilobytes depending on the
size of the partition, and the file system.
FAT: The FAT (File Allocation Table) tells
the Disk Operating System which por-
tions of the disk belong to each file.  The
FAT links together all the clusters belong-
ing to each file, no matter where they
are on the disk.  
Partition: By default, whenever a hard
disk is formatted, it will have one parti-
tion. Hence, a partition is a formatted
section of a hard disk. Large hard disks
can be formatted into multiple parti-
tions, and each partition acts as an indi-
vidual, or a separate hard drive. 
Boot disk: A special floppy boot disk
allows your PC to boot, even if it cannot
boot from the hard disk. This disk is also
known as a System Rescue Disk.

Glossary

Maxtor DiamondMax
PlusII 6Y160M0

Seagate Barracuda
ST340015A
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type of power supply connector, so that you don’t get stuck if you
don’t have the SATA power connector cable. Feature wise, the 160
GB drives from both, Seagate, and Maxtor, were at par, employing
the same amount of buffer, and spindle speed, the only exception
being the power connector—Seagate only provided a SATA connec-
tor. 

Performance analysis
Before we delve deep into the performance of these hard drives, we
would like to clarify certain points. The first point is the difference
in the two interfacing standards—the older IDE interface, also called
PATA (Parallel ATA), and the newer SATA (Serial ATA). Though SATA
is a new standard that was supposed to offer better performance
than an IDE drive, this does not quite hold true. However, the lim-
itations seem to be in the first generation of SATA drives. As newer
versions of the same technology are released, the performance will

increase. As of now, SATA only offers advantages
such as smaller, and thinner cables

that lessen the cluster of cables
inside the PC cabinet, thus
improving its thermal dynam-
ics. Also, the cables are simpler

to install, and moreover, since there
is no jumper selection, or a master slave

concept, installation is a cakewalk. One
more thing that we would like to point out
is that the older 5,400 rpm drives are now
slowly vanishing. Hence, opt for a 7,200
rpm drive, since they offer a better per-

formance, and are priced sensibly.

HD-TACH
HD-Tach is an excellent benchmark to figure out the performance
of a drive. This benchsmark offers the average read write speed,
along with the burst speed, and the CPU utilisation of the drive.
The burst speed is the speed at which data can be accessed from
the drive’s on-board read-ahead memory. The higher the score, the
better the performance of the drive. At the same time, it is also
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✔ Speed or space? If you need to store MP3s and DivX films, 
or back up heavy image files, buy the largest hard disk you can afford.
On the other hand, if you use applications such as image editing, or
audio processing software extensively, look for the fastest hard disk
you can afford—at least a 7,200-rpm drive.
✔ Do a bit of market research. Ask your friends, dealers, or search the
Internet for information about the manufacturer, their reputation, and
their after sales service.
✔ Check the warranty type covered, apart from the time frame
offered. Some manufacturers provide a hard disk replacement only in
the first year, after which they only offer to repair it. This is rather
unreliable, and can lead to further problems.
✔ Confirm the time it takes to replace a faulty hard disk. This is impor-
tant, especially, if your business relies heavily on data storage. Gener-
ally, manufacturers running service centres are able to provide quick
replacements. Those who don’t could take weeks to replace a faulty
hard disk.
✔ Check for accessories such as IDE cables, disk management 
software, and operating manuals.

Disk shopping

Maxtor DiamondMax
PlusII 6Y20M0
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important to note down the CPU utilisa-
tion of the drive, since a high CPU utili-
sation, would slow down the entire sys-
tem. 

In the HD-Tach benchmark, nearly all
drives performed on par with each other,
with the read burst speed hitting the the-
oretical limit of 80 MBps, indicating that
all the drives have good on-board con-
trollers. The only drive that could not
make it to the 80
MBps mark was
the Samsung
SV0602H, which
registered a speed
of 78 MBps—not a
bad score, but compar-
atively slower than the
rest. An important point to
note was that all the drives were
able to hit the 80 MBps mark, but
at the cost of higher CPU utilisa-
tion. 

In the SATA category, the Max-
tor DiamondMax Plus9 160 GB drive
sported the highest CPU utilisation of
around 4.1 per cent. This was the only
drive in the entire comparison test that
exceeded 3 per cent CPU utilisation. With

such a high CPU utilisation, it is quite evi-
dent that the performance of this drive will
be hampered in the real world environ-
ment that often involves multi-tasking. For
example, if you are working on a docu-
ment, and copying some files in the back-
ground simultaneously, the higher CPU
utilisation will result in more CPU time
being diverted to the copying of files rather

than the document that you’re working
on. 

The Seagate 160 GB
ST3160023AS drive took

second last place by
utilising 2.1 per
cent of CPU time.
Both these drives
had an unusually
high CPU utilisa-

tion, as compared to the
other drives in the compar-
ison test. The 200 GB Max-
tor DiamondMax Plus9
drive took the crown with

the least amount of CPU utilisation, by tip-
ping the pointer at just 0.4 per cent. Its
lower capacity sibling—the 120 GB Dia-
mondMax Plus 9, followed it.

Among the IDE drives, the Samsung’s

SV0411N fared badly by utilising 2.5 per
cent of CPU time. This was followed by
Maxtor MaxLine Plus II, and Samsung’s
SP0802N that utilised 1 per cent of the
CPU time during the test. Seagate’s
ST340015A and Samsung’s SV1203N,
took the top honours, utilising just 0.6
per cent of the CPU time.

SiSoft Sandra tests
The SiSoft Sandra tests came up with

Need to recover your data from a crashed
hard disk? Well, don’t be disappointed.
Here’s how you go about doing it. (In this
example, we have taken Ontrack Easy
Recovery, and Lost & Found.)
■ As soon as you realise your hard disk has
crashed, shut down your PC, so as to pre-
vent any further damage. Then restart it, go
to the BIOS, and check if the hard disk is
being detected. If your hard disk is not
detected, you won’t be able to recover data
through any software. You will have to send
it to the data recovery centre. 
■ Next, connect another hard disk to
your PC to store the recovered data. How-
ever, ensure that the free disk space is
more than the size of the data you need
to restore; else the task won’t be success-
ful. Alternatively, you can plug in a zip
drive, but make sure that the recovery
software you’re using supports such
media. Note that you cannot recover data
onto another partition that is present on
the crashed hard disk. Hence, plugging in
an additional storage media on which the
data can be stored becomes mandatory. 
■ Next, make sure you have a bootable flop-
py disk. Insert the floppy disk, and boot your

machine in the MS-DOS mode. Go into the
BIOS, and change the boot sequence from
there so as to make the PC boot from the
floppy disk.
■ After you’ve booted in DOS mode, insert
the recovery software floppy diskette. Here
we’ve taken the example of Ontrack’s Easy
Recovery software, which is considered to
be one of the most widely used, and effec-
tive recovery software. You can also use
other software such as Stellar Phoenix Data
Recovery Software, Final Data, etc.
■ After inserting the recovery software, you
get an option to select the primary hard disk

(the one that crashed) as the recovery
source, and the second hard disk as the
restore destination. 
■ The software then analyses the data
that it has to recover from the crashed
hard disk. In order to recover the data,
the software tries to read the two copies of
the FAT tables, and then reads the raw
data on the hard drive, trying to match it
to the FAT Tables. The data that matches
the FAT table is the data that is visible to
you, even after the crash. The data that
does not match the FAT table is generally
the data that you are trying to recover.
Once it comes across raw data on the
disk that corresponds to a file, but finds
that there is no similar entry in the FAT
table, it marks the data as a recoverable
file, and adds it to the existing list of files it
has from the FAT table. All the files that
exist on the hard drive, whether in the FAT
table, or detected by the software, are
shown as recoverable files. Once this is
done, you can choose the data to be
recovered, which will be copied to the
destination drive. The whole process might
take hours to complete, depending purely
on how much data has to be recovered. 

On the road to recovery

Seagate Barracuda
ST3160023AS

Recover lost files using Ontrack Easy Recovery
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some surprising results. The Maxtor MaxLine Plus II 250 GB hard
drive, with an ATA-133 interface, gave the highest results, scoring
a drive index of 39,680 KBps. This drive has an 8 MB memory
buffer, which translates to better scores when you take into con-
sideration the sequential read and write speed. The MaxLine Plus
II gave excellent results in the sequential read and write speed test,
with scores of 58 and 56 MBps. These scores were even better than
that of any of the SATA drives. Similarly, the Barracuda ST3160021A
drive from Seagate also gave some astonishing results by beating all
the SATA drives in this particular test, and returned a drive index
of 37,727 KBps, which was second best to the Maxtor 250 GB drive.
Excellent drive electronics, and the 7,200 rpm spindle enabled this
drive to give such an impressive performance. The only drive that
could not make a good impact was the SV0602H drive from Sam-
sung, being a 5,400 rpm hard drive.

Sadly, none of the SATA drives could live up to the expecta-
tions. The results were monotonous, with the scores deviating a
little from each other. The drive index of all the SATA drives 
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The number of files and folders stored on the hard drive increases as
you keep installing programs. If the files are not properly organised,
the performance of the hard drive degrades, and you will end up
wasting valuable time, searching for files. The best way to keep a
check on this is to partition the hard drive, and allocate the partition
size, according to the number of applications that are going to be
installed on the system, and the amount of data that will be stored. As
far as storing files and folder goes, here are a few simple tips to follow:
■ Always store your doc-
uments, and other work-
ing data, on the second-
ary partition.
■ Name the folder based
on the data to be stored
in it. For example, store all
account files in a folder
named accounts.
■ The file name should
be such that it carries
enough information
regarding its content,
the date it was created,
etc. For example, Maxtor hard drive_august2003.doc 
■ Keep separate folders for different kind of files such as images, doc-
uments, and so on.
■ Try not to install games, applications, and other system utilities on
this partition, as it will clutter the disk with other kind of data, and
hence affect disk access. 

Over a period of time, as data gets stored and deleted, it
becomes imperative to defrag the data. This entails re-arranging the
data at one place for faster access. Windows itself provides you with
this utility, so you need not bother installing a third party program.
To access this program, go to Start > Program > Accessories > System
Tools > Disk Defragment. The time required to complete the defrag-
ment task will depend upon the hard drive capacity. The other use-
ful built-in option is Scandisk, which can also be found in the Sys-
tem tools. It checks the hard drive for errors such as lost clusters,
bad sectors, and so on. Defrag once a month to keep the hard drive
free from any errors.

Organising files and folders

Defragment your hard disk frequently
for faster access to data
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hovered about the 36,000 KBps mark,
with the read and write speeds being more
or less within the 52 - 54 MBps range. This
clearly indicates that SATA needs to make
a significant technology advance in order
to beat the prevailing ATA standard. As of
now, the ATA 133 standard still rocks.     

File transfer tests
This test was introduced in our hard drive
comparison tests to see how they fared in a
real world environment. Any user with
access to a PC uses it to transfer data in
some way or the other. The hard drive plays
an important role in this, since it is the data
storage component. The faster the rate of
data transfer, the better the hard drive. 

The test file comprised of two sets of
files. An assorted set of files, comprising of
mp3 files, software installation setups, doc-
uments, and zip files, all of which amount-
ed to 1 GB, were put in a single folder.
These were then transferred from the main
hard drive to the test hard drive, and then
from one partition to the other on the test
hard drive. A 1 GB movie file was also
taken for the tests. The assorted set of files,
and the movie file simulated the random,
and sequential read and write speeds for
the hard drive. The time taken to transfer
the files was noted down as the result.

The results for these tests were quite
similar all over. In the SATA category, the
Maxtor DiamondMax Plus 9 200 GB drive
showed the best results in this test by
completing the entire file transfer in just
57, and 52 seconds for random and
sequential read and write respectively.
This hard drive is really good for people
who need to transfer a lot of data, onto or
off the hard drive. The Seagate’s
ST3160023AS took the second spot, by
taking a slightly longer time than the

Maxtor’s 200 GB drive, but, nevertheless,
put up a respectable score. 

In the ATA category, nothing could
beat the Maxtor Maxline Plus II 250 GB
drive in the real world tests. This drive lost
out to its SATA sibling only because of its
slightly higher CPU utilisation, taking
some extra seconds to complete the copy-
ing of the file. This is a good point to show
how even a slight difference in the CPU
utilisation matters in the real world. The
other drives, such as the ones from Sam-
sung, and especially the SP0802N, dis-
played good real world
performance with neck-to-
neck scores with the Max-
tor MaxLine Plus II.
One good point to
note is that the
CPU utilisa-
tion of both
the drives
was on par.
The Seagate Bar-
racuda ST340015A
was the biggest
disappointment 
in the entire test. 
It was the only drive that came up with
worst results. 

Photoshop test
In this test, we note down the time
required to load Photoshop after its instal-
lation, and the time taken to open a 200
MB file. The drive with the higher buffer
memory, and good read burst speed will
definitely score better than other drives. A
lot depends on the read ahead memory,
and the drive controller, present on the
drive itself. The Maxtor MaxLine Plus II
250 GB—which took just 4 seconds to load
Photoshop, and needed just 29 seconds to

load the 200 MB test file—walked away
with the crown. This can be attributed to
the 8 MB buffer memory, and a good read
speed burst of 9 MBps. We recommend it
to anyone who wants a good drive for
video editing. The Samsung SV1203N ATA
drive was second in line, taking just 5 sec-
onds, and 28 seconds to open Photoshop
and the test file. Other drives such as the
Seagate Barracuda ST3160021A, and 
the Samsung SP0802N, took around the
same time. 

All these drives have excellent
onboard drive controller electronics

resulting in high performance.
The test results seem to be
very much alike, with
hardly any variation in

them. However, even a
second’s difference could be

of utmost importance.
Unfortunately, none of the

SATA drives gave results that jus-
tify them as the successors of the

PATA technology. Coming in first,
was the Maxtor 120 GB DiamondMax

plus 9 drive, sporting a score that was
neck-to-neck with the winner in this par-

ticular test. All other drives took longer
times to load the same image file.

To sum it up...
The test concluded with some great
insights, toppling some of the myths
about the ATA 133 standards capability,
and was an eye opener regarding facts
about the SATA technology. Although
many motherboard, and chipset manu-
facturers deny official support to the ATA
133 standard under the pretext of insta-
bility, the fact remains clear that even
today, it has the capability to beat newer
technologies such as SATA, which is in its

Decision Maker

You Need 

Look For

Our Pick 

Price

Entry Level Hard Disk

A steady going HDD that can
store all your Movies, MP3’s
and other data with decent
performance and a large
enough capacity

A 7,200 RPM drive with atleast
40 to 80 GB of capacity with
price per MB in the region of
5 to 7 paisa

The Samsung SV0802N,
SV0602H, SP0411N

Rs 4,500 to Rs 6,200

Good balance of performance and price

A HDD with good performance, with large 
storage capacity, taking less time to copy files on
and off the HDD. A Drive that is future proof and
won’t become obsolete in the wake of SATA
becoming a standard.

A 7,200 RPM drive with 120 GB to 160 GB of 
space and providing 8 MB of buffer and having
excellent read write speeds.

The Maxtor DiamondMax plus 9 120, 160 GB 
and Samsung’s SV1203N

Rs 7,500 to Rs 12,000

Super Fast and scalable Hard Disk

A super fast drive with excellent 
performance, low latency, takes less 
time to copy data on and off the HDD
and also supports  future satandards.

HDD with atleast 8 MB of buffer, spindle
speed over 7,200 rpm, having extremely
low CPU utilisation and having good over
all performance with loads of real estate
to store you data.

The Maxtor Maxline Plus II, Maxtor 
DiamondMax Plus 9 200 GB 

Rs 15,000 and above

Samsung SpinPoint V
Series SV1203N
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nascent stages of develop-
ment, and still needs to be
nurtured to be accepted as the
successor to the prevailing
PATA technology. 

We would definitely rec-
ommend a PATA hard disk for
your existing motherboard,
since it offers seamless com-
patibility, and performance,
which is either better, or on
par with the new technology.

Also, a SATA upgrade requires some
additional investments in a new motherboard that has native sup-
port for the new technology. 

But, in case you are one of those lucky souls who happen to be
on the verge of an upgrade, investing in an SATA hard disk, and a
SATA motherboard makes a good future proof solution, since apart
from the near equivalent performance of the SATA drives, it also
offers better thermal dynamics for the cabinet, and is simple to
install and maintain.

The products that shone in the comparison test were none
other than the trio from Maxtor, and one particular drive from
Samsung. In the SATA category, no other drive could beat the per-
formance of the 200 GB Maxtor DiamondMax Plus 9. This drive
has the best features, with specifications that can put the
ones from Seagate to shame. Not
only do the features look
great on paper
but also deliver
in the real world
env i ronment ,
which is clearly
reflected in the tests.
We recommend this hard
disk for any user who wants the
best of both worlds: a large
storage capacity, and excellent
performance. 

Similarly,  this drive also
wins hands down, when it come to value for money. It provides
200 GB of space at just Rs 15,000. The other drive that you 
can consider is the lower capacity Maxtor DiamondMax Plus 9
120 GB that came in second in the performance rig. We suggest
this drive, if you are on the lookout for a decent capacity 
SATA hard disk that performs well, is feature rich, and is light on
the pocket.  

In the PATA category, the 250 GB Maxtor MaxLine Plus II
wins hands down. Be it features, or performance—no other drive
can match it. This was also the best performing drive in the entire
spectrum of PATA and SATA hard disks taken together. At Rs
21,000, the drive offers a humongous 250 GB of space. We rec-
ommend this drive for professional audio and video editors, and
gamers, who are always on the hunt for bigger capacity drives
that are fast and provide top notch performance. The Samsung
SP1203N 120 GB drive provides excellent value for money, con-
sidering the fact that it costs Rs 7,200, which gives it an excel-
lent price per MB of 5.86 paise. At such a price, this hard disk is
a must buy piece of hardware.

SANKET NAIK (sanket_naik@thinkdigit.com) 

BHASKAR BANIK (bhaskar_banik@thinkdigit.com

AUGUST 2003
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Maxtor Maxline PlusII 7Y250P0

Maxtor DiamondMax
Plus9 6Y200M0
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Brand

Model

Model number.

Features (15%)

Drive specifications

Capacity (GB)

Spindle speed (RPM)

Interface type 

(ATA 100/133/Serial ATA)

Data buffer size (MB)

No. of platters

Rated access time (ms)

Power connector

Price per MB (paisa)

Performance (65%)

Synthetic tests

HD Tach

Read burst speed (MBps)

CPU utilisation (%) * 

SiSoft Sandra 2003 

Pro Drive benchmark

Sequential read (MBps)

Random  read (MBps)

Sequential write (MBps)

Random  write (MBps)

Access time (ms) *

Drive index (KBps)

Real world tests

Assorted file transfer (sec)

Single file transfer (sec)

Application load time

Startup time (sec) *

Photoshop 7 image load time

(200 MB file) (sec) *

Warranty & support 

Replacement warranty (Y/N)

No. of years

Overall score

Features (15%)

Performance  (65%)

Value for money (20%)***

Overall grade

Vendor name

Phone

E-mail

Price (In Rs)

Maxtor

DiamondMax Plus9

6Y120M0

120

7200

Serial ATA

8

NA

9.4

Molex and SATA 

6.92

80

0.5

48

8

46

16

7

32944

92

71

6

28

**

3

13.8

40.46

16.57

Cyberstar

011-26438216

yogi@maxtor.com

8500

Maxtor

DiamondMax Plus9

6Y160M0

160

7200

Serial ATA

8

NA

9.4

Molex and SATA 

7.02

80

4.1

53

8

52

14

6

36282

87

148

7

33

**

3

13.8

36.32

15.08

Cyberstar

011-26438216

yogi@maxtor.com

11500

Seagate

Barracuda

ST3160023AS 

160

7200

SATA

8

2

8.5

SATA

8.06

80

1.2

52

8

55

11

6

36027

89

84

6

39

Replacement

1

12.60

37.50

13.13

Seagate

Distrubution

Singapore Pvt Ltd

1600 33 11 04

response.india@

seagate.com

13200

CATEGORY

Samsung

PL40 Series

SP0411N

40

7200

ATA 133

2

1

11

Molex  

10.99

80

0.9

52

7

51

9

8

34592

83

71

5

31

**

3

11.80

40.48

10.05

Samsung Electronics

India Information &

Telecommunication Ltd

011-51511234

hddsupport@

samsungindia.com

4500

ATA DRIVES

Disclaimers: All prices are subject to variation, * Lower scores indicate better performance
** if possible repairs or else replacement  *** Calculated on the basis of price per MB

SERIAL ATA DRIVES

Maxtor

Diamond

Max Plus9

6Y200M0

200

7200

Serial ATA

8

NA

9.4

Molex and SATA 

7.32

80

0.4

53

8

53

19

6

36428

57

52

6

29

**

3

13.8

45.42

17.08

Cyberstar

011-26438216

yogi@maxtor.com

15000

Maxtor

Maxline

PlusII

7Y250P0

250

7200

ATA 133

8

3

9

Molex  

8.20

80

1

58

9

56

20

6

39680

80

61

4

29

**

3

13.80

45.94

15.38

Cyberstar

011-26438216

yogi@maxtor.com

21000
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Samsung

SpinPoint V Series

SV0411N

40

5400

ATA 133

2

1

11

Molex  

10.25

80

2.5

42

6

42

8

9

28444

101

85

6

32

**

3

9.80

36.38

9.51

Samsung Electronics

India Information &

Telecommunication Ltd

011-51511234

hddsupport@

samsungindia.com

4200

Samsung

SpinPoint V Series

SV0802N

80

5400

ATA 133

2

1

8.9

Molex  

6.84

80

0.9

44

6

44

8

9

29553

104

81

6

34

**

3

9.80

36.15

14.20

Samsung Electronics

India Information &

Telecommunication Ltd

011-51511234

hddsupport@

samsungindia.com

5600

Samsung

SpinPoint P Series

SP0802N

80

7200

ATA 133

2

1

8.9

Molex  

7.57

80

1

55

8

55

10

7

36860

85

63

5

30

**

3

11.80

41.96

15.00

Samsung Electronics

India Information &

Telecommunication Ltd

011-51511234

hddsupport@

samsungindia.com

6200

Seagate

Barracuda

ST340015A 

40

5400

ATA 100

2

1

12.5

Molex  

10.80

80

0.6

43

6

43

6

9

28914

767

1160

6

37

Replacement

1

6.60

28.09

6.78

Seagate Distrubution

Singapore Pvt Ltd

1600 33 11 04

response.india@

seagate.com

4425

Seagate

Barracuda

ST3160021A

160

7200

ATA 100

2

2

8.5

Molex  

6.55

80

1

56

8

56

10

6

37727

131

122

5

29

Replacement

1

8.60

38.26

15.12

Seagate

Distrubution

Singapore Pvt Ltd

1600 33 11 04

response.india@

seagate.com

10725

Samsung

SpinPoint V Series

SV0602H

60

5400

ATA 100

2

1

8.9

Molex  

7.49

78

0.4

38

6

24

6

9

23975

135

129

6

34

**

3

7.80

32.46

11.36

Samsung Electronics

India Information &

Telecommunication Ltd

011-51511234

hddsupport@

samsungindia.com

4600

ATA DRIVES

Samsung

SpinPoint V

Series

SV1203N

120

5400

ATA 133

2

1

8.9

Molex  

5.86

80

0.6

49

6

49

8

9

32571

84

75

5

28

**

3

9.80

40.44

18.11

Samsung Electronics

India information &

Telecommunication Ltd

011-51511234

hddsupport@

samsungindia.com

7200
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“Hello everybody… I’m doing a (free) operating
system (just a hobby, won’t be big and profes-
sional…).” Linus Torvalds’ first Linux
announcement on August 25, 1991.

Those simple words describe Linux’s humble beginning.
Linux comes in various distributions (distros to the geekdom)
that promise to be stable, and as user friendly as Windows. Well,
are these just empty assurances, or can their claims be justified?
The purpose of this comparison test was to evaluate the very best
of these Linux distros. We also answer crucial questions that
every office and home user wants answered—is Linux really ready
for the desktop? Can I install Linux on my PC, and get the same
productivity, and features that Windows offers? Can I transpar-
ently work with my existing data under Linux? This test answers
them all, and comes up with some astonishing results to boot.

The available flavours were divided into two categories: Win-
dows replacements, and Office Desktops.

The Windows replacement distributions are meant for a new-
bie scouting the market for an OS other than Windows. We chose
Xandros, Lycoris, Lindows 3.0 and ELX Linux, for this category.

The second category includes distributions that do not attempt
to give the same look-n-feel as the standard Windows desktop.
Instead, they provide a very intuitive interface that can be used
with little effort. They also bundle a whole lot of applications that
make life easier for the office user. Red Hat Linux 9.0, Mandrake 9.1,
and SuSE Linux Office Desktop were the distributions considered.

How we tested
The test process for the categories was almost identical. Howev-
er, the weightage awarded to each component of the test process
differed for the two categories. For Windows replacements,
importance was given to their resemblance to Windows so that
a novice user can make the right choice.

The 
Linux

Shootout

test drive ■
■ software

Everyone’s heard of Linux, most fear it, but the
few daring individuals that use it, now swear by
it. Is there a Linux distribution that can compare
with Windows’ functionality, leave alone replace
it as the OS of choice? Let’s find out…

AUGUST 2003
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Ease of installation
The installation utility was evaluated for
ease-of-use. Special points were given to
those flavours that took into account
existing Windows partitions, and sug-
gested mount points automatically. The
ability of the partitioning utility to han-
dle NTFS, and FAT32 partitions, was con-
sidered as a distinct advantage.

Suitability to Desktop
These tests gauged the ease with which a
novice can configure, and get around his
Linux desktop—for example, easily under-
standable desktop icons (My Computer,
My Presentations, My Documents, etc.),
which promote a familiar Windows envi-
ronment. We also noted the ease with
which a user could alter the desktop set-
tings. Simple tasks such as setting the back-
ground image, changing screensavers,
changing the default desktop resolution,
etc., were taken into consideration.

Adherence to the File Hierarchy Stan-
dard (FHS) was also given special atten-
tion—for interoperability of applications
between various Linux distributions. 

The number of file systems sup-
ported by a Linux box, is a good indi-
cation of its suitability in a
heterogeneous environment where
it needs to co-exist with other
operating systems. However, for
the typical home, and office

desktop user, the area of major concern 
is the compatibility level between Linux, 
and Windows. 

Office productivity tools
Office applications such as word proces-
sors, spreadsheets, presentation tools,
etc., were evaluated, and their compati-
bility with standard Windows office
applications was also determined.

For those who insist on using MS
Office tools in Linux, Windows emulators
are a viable option. They create an artifi-
cial Windows environment within Linux,
thereby enabling a user to install, and run
his favourite Windows application.

Hardware compatibility
To check the compatibility of the available
distros with common hardware, we
installed each flavour on 5 different test
PCs that represented a pool of popularly

available computer
components. The

details of each configuration can be found
in the hardware compatibility table.

The Windows killers

ELX Linux Power Desktop 2.0:
This one is for everyone

The ELX installation was fairly simple.
A neat listing of the steps involved on

the left hand pane went hand in hand
with an information box in the corner.
Three install options—Default, Laptop,
and Custom System—are offered. The
Default install loads a majority of the
applications, the Laptop loads only the
bare necessities and the Custom install,
as the name suggests, is just that. The par-
titioning utility is similar to that of Red
Hat—the user has to assign the root par-
tition. However, the assign-
ment process is
s i m p l i -

ILLUSTRATINS: Mahesh Benkar
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fied; instead of assigning partitions for
individual directories, you can check the
box labelled ‘I want to use this as the
main partition (/)’. Moreover, you can
either use the remaining free space, or
specify the the partition size in MB.

The install process is time consuming
due to the installation of a whole lot of
applications. Interestingly, this is the only
distro that comes with ‘Asia/Calcutta’ as
the default time zone.

After installation, the user is asked for
basic configuration information, using
KPersonaliser during the first login. ELX
Power Desktop 2.0 has a very friendly desk-
top with simple Windows style icons, such
as My Computer, My Network, etc.

Strangely, the minimum hard drive
space mentioned was 1 GB, but the default
install took up 3 GB of space.

ELX works well with KDE, but does
not work properly with Gnome. The panel
crashed during the first Gnome session,
and we had to use the shortcut keys to
start the X server; a novice user could not
have done that. Also, the My Computer
icon did not function under Gnome.

Accessing Windows shares is extreme-

ly easy. During installation, you are
prompted to specify a workgroup name.
Later, just click on the Network Neigh-
bourhood icon to get a listing of all the
machines on the network, and their net-
work shares.

All applications are neatly categorised
into six groups—Office, Internet, Multi-
media, Graphics, Development tools, and
Games. All these groups have icons (called
Launchpads) on the task bar. Clicking on
any one of these icons brings up a dialog
box containing separate icons for the indi-
vidual applications within that group.
Point the mouse to any of these icons to
get a brief description of its features. A but-
ton, to update all the applications in a par-
ticular group, is also provided. The
Launchpad also acts as a front end to the
apt-get package manager. Select ‘Update
all’ from the Launchpad, to update all the
packages, and their dependencies via ftp
sites. For the root user (administrator), a
couple of extra launchpads are provided.
The system configuration Launchpad has
a handy set of tools to make system con-
figuration an easy affair.

Apart from some of these customised
utilities, the rest of the tools are general-
ly KDE-based utilities. For example,
adding, or removing users can be done
using the KDE User Manager (Kuser). Sim-
ilarly, printer configuration uses the stan-
dard KDE Printer Manager. But what is
commendable here is that a very simple
way of accessing all the relevant tools is
provided. Clicking on the My Computer
icon on the desktop will bring up a win-
dow that has almost all the tools found

on a standard Windows computer includ-
ing a Dial-up Account icon.

As can be seen from the comparison
chart, ELX turned out to be a very sur-
prising distro in many respects. Apart from
using a very easy desktop, they have also
developed some very simple but ingenious
tools. The samba file sharing front end is
a classic example. While the majority of
distros used the Konqueror browser to
access Windows shares, the separate tool
provided by ELX is comfortable to use.
Moreover, this distro is free for personal
and educational use. The commercial
licensing is also very reasonable.

Lycoris Desktop/LX review:
The problematic Windows 
look-alike

Lycoris has one of the most simple, and
fastest installations of all the distros

tested. However,
even a small prob-
lem with hardware
compatibility, such
as an undetected
mouse, could bring
down the installa-
tion utility. 

In terms of look
and feel, Lycoris
was the closest to the Windows desktop. It
even has a default wallpaper that has a
striking resemblance to the one that comes
with Windows XP. A guided tour starts up
during first boot, which walks you through
all the features of the Lycoris desktop. This
is very helpful to the first-time Linux user
migrating from Windows to Linux.

Lycoris had the worst hardware sup-
port amongst all the distros. It did not
configure on many of the test beds. Even
on those that were configured, everything
did not go smoothly. For example, on the
HCL Beanstalk 4455 with Geforce2 MX
400, the desktop was configured, by
default, at an uncomfortable resolution of
1,600 x 1,200. All the desktop icons were
tiny and hardly legible. All attempts to
bring the desktop to a lower resolution
yielded strange results. On restarting the
X server after changing the resolution, the
desktop area went outside the monitor’s
viewable area. Although you could scroll
up, or down on the desktop, this is defi-
nitely not desirable.

Overall, Lycoris was impressive with its
near-perfect Windows desktop look and
feel, but lost out on hardware support. 
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Distribution name
Ease of use
File system
Laptop support
Similarity to Windows
Suitability to office use
Printing subsystem 
System administration
Internet readiness
Graphical configuration
Features

Special features
Glaring deficiencies

Resource utilisation
Desktop hardware support
Economy
Overall score

Xandros
22.5
2
2.5
15
10
4
2
1.2
4
0.8
4
2
1.8
5.71
2
67.8

Lycoris
18
2
0
15
10
4
2
1.2
4
0
3
3
2.4
1.43
2
60.6

Lindows 3.0
15
2
0
11.25
10
4
2
1
2.75
-0.4
2
3
2.4
6.67
2
52

ELX Linux
22.5
2
0
15
10
4
2
1.8
3.5
0.8
4
2
1.8
6.19
4
67.4

CATEGORY Windows killers
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Xandros 1.0:
The best of the lot

The Xandros installation
procedure is very simple. It

gives two modes of install: Express install,
and Custom Install. Express install does
not allow partitioning of the hard drive,
but preserves existing Windows parti-
tions. Custom install, on the other hand,
lets the user partition the hard drive.

After logging in for the first time, a First
Run Wizard allows the user to configure the
network, printers, etc., in a very intuitive
fashion. For example, to configure a print-
er using the First Run Wizard, just select the
type of printer (local or remote) and give
the relevant information in the steps that
follow. If you do not configure a peripher-

al device, using the wizard, you can do so
later using the Control Centre.

Sharing files on a Windows network
is also very easy. In the Control Centre
just go to Networking > Windows Networking,
enter the name of your workgroup, and
you’re done. You can now access the
other computers on the network using
the File Manager by going to Home > Win-
dows Network. Search for other computers
on the network, by going to Find > Com-
puters in the main menu.

The Xandros desktop is basically a
variant of the K Desktop Environment
(KDE). Many of the tools that are avail-
able via the Launch menu are standard
KDE tools. For example, the Process Man-
ager runs the kpm tool, and the Run Level
Editor is nothing but the ksysv applica-
tion with the -caption option.

Clicking on the Windows key on the
keyboard brings up the Launch menu—
just as it brings up the Start menu under
Windows. Such small improvements
make the user much more comfortable
with the GUI environment.

Xandros is considerably faster than
the other distributions and provides a
very intuitive and easy to use GUI. It even
supports active user switching, just as in
Windows XP. The users can switch even if
their applications are running on their

65

Distribution name
Graphics card

nVidia GeForce MX 440 with AGP8x
nVidia GeForce2 MX 400
nVidia GeForce2 MX 200
NVIDIA Riva TNT2
SiS 6326

Ethernet card
Broadcom NetXtreme 
Gigabit ethernet card
Intel Pro 100 VE
Dlink DFE-538TX 10/100
Intel EtherExpress PRO 100

Sound card
Onboard CMI 8378
Onboard 5.1 support
Onboad Realtek AC’97
Aureal2
Yamaha DS-XG

Optical drives
Samsung SW-240B CD-RW
Samsung SD-616Q DVD-ROM
Samsung SD-612 DVD-ROM
Samsung SM-348B Combo Drive

Modem
Best data 56 Kbps data fax modem

Overall score

Xandros

✔

✖

✖

✔

✔

✖

✖

✔

✔

✔

✖

✔

✔

✔

✔

✔

✖

✖

✖

0.57

Lycoris

✖

✔

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✔

✔

✖

✖

✖

0.14

Lindows 3.0

✔

✔

✔

✔

✔

✖

✔

✔

✔

✖

✖

✖

✔

✔

✔

✔

✔

✔

✖

0.67

ELX

✔

✖

✔

✔

✔

✔

✖

✔

✔

✔

✖

✔

✖

✔

✖

✖

✔

✔

✖

0.62

CATEGORY Hardware compatibility
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respective desktops.
The Launch menu is very user-friend-

ly, and very similar to the Windows Start
menu. All the applications are neatly clas-
sified and arranged under specific cate-
gories. Also, The quick start guide gives a
comprehensive list of all the topics that
might be of interest to the novice user. 

However, The per-seat license can get
a bit heavy on the pocket. Moreover, while
the Crossover office is a useful tool for
individuals keen on using MS Office tools
on Linux, it would have been cheaper if
Xandros had bundled a cheaper emulator.

Lindows 3.0:
Linux with Windows licensing

Lindows 3.0 has a very simple installa-
tion procedure and is also one of the

fastest installations; it barely took 5 min-
utes to install all the packages. This sounds

really impressive till you actually boot for
the first time and realise that hardly any
applications have been installed. This is
primarily because of the Click-n-Run inter-
face for installing and updating applica-
tions. The disk partitioning utility of Lin-
dows is very easy to use and takes a differ-
ent approach to all the other Linux distri-
butions. It does not display the partitions
using the standard Linux convention of
hda1, hda2, etc. Instead it uses a very sim-
ple listing of all the primary, extended and
logical partitions. This ensures that you are
able to get around with partitioning even
if you are not aware of Linux partition
naming conventions.

Lindows provides all the fancies that
are required to attract a Windows user.
However, what really gets on your nerves
is the limited number of applications that
come along with the installation CD.
Even basic office utilities such as spread-
sheet viewers and presentation tools are
not included in the basic installation. The
Click-n-Run Express install CD promises
to reduce the download time of all the
applications from the Click-n-Run ware-
house located at the Lindows Web site.
This express CD installs many of the

libraries that are needed for the applica-
tions to install properly.

The concept of downloading applica-
tions from a central repository might not
be feasible for a home user as the time
required is mind boggling. For example,
the average download time for StarOffice
6.0 listed at the Lindows site is seven and
a half hours on a 56 Kbps modem, about
an hour for a DSL modem, and 20 min-
utes for a T1 connection.

But before corporations with T1 lines
think that it is feasible, we caution you
about some licensing policies. The license
for the Click-and-Run Warehouse is sepa-
rate from that for the operating system
and needs to be renewed every year. More-
over, a full membership of the warehouse
(whatever that means), comes at an extra
price. This feature can be easily bypassed
by using the ‘apt-get’ installer that comes
along with Debian Linux as Lindows is
based on the Debian distribution.

What it all boils down to
Before starting this comparison there was a
lot of apprehension about the very concept
of comparing Linux distros that are touted
as Windows replacements. “Isn’t that a
cheap marketing gimmick?”, we were
asked; and we didn’t have an answer, then.
But now, after completing the comparison,
we have an answer—no it is not a market-
ing gimmick. The vendors responsible for
developing these distributions have gone
to great extents to make their offerings as
user-friendly as possible, while retaining

the basic power and uniqueness of Linux. 
In terms of Windows look-n-feel,

usability and user friendliness, Xandros
was slightly better than ELX Power Desk-
top 2.0. However, Xandros has complex
licensing issues, and has to be bought,
even for home use—it has a per seat or
per user licensing policy. ELX, however,
is free to download for home and educa-
tional use. Thus, from the economic
point of view ELX beats Xandros.

In spite of all these features there are
a few troublesome areas that have to be
addressed, such as hardware compatibili-
ty. Another area that looks worrying is the
pricing and the licensing policies. In par-
ticular installing applications on Xandros
and Lindows can be bypassed by using the
freely available tools from the Debian
Linux distribution, which effectively
means that they don’t have to pay for the
support provided by the respective ven-
dors. This is also true for ELX. Apart from
these annoyances all the Windows looka-
like distributions gave good overall results.

Desktop Linux comparison

Red Hat Linux 9.0:
Old wine in a new bottle

Red Hat is probably the most recog-
nised of all the Linux distributions. It

has been installed in almost every think-
able form, from servers to clusters. But
how suitable is it for the desktop? Of late,
Red Hat is attempting to become more
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Unfortunately, the term ‘Linux Gaming’ 
has come to symbolise the ultimate 
oxymoron. Linux has always been 
considered the preserve of geeks, and 
geeks don’t play games—they program 
like there’s no tomorrow.

There has always been somewhat of 
a vicious circle revolving around Linux. 
Game developers have consciously steered
away from porting Windows games to 
this platform since they don’t perceive 
a market here. 

However, few companies have tried to
break this barrier. id Software released Linux
versions for all of its recent games—The
Quake franchise, and Return To Castle Wolfen-
stein. Another major development is the
release of Unreal Tournament 2003, by Epic
Games. Apart from these, there are games
that come shipped with the Linux distros. 

The two most popular arcade games that 
are included with Red Hat are Chromium, 
and Tux Racer. Chromium is a souped up 
version of Space Invaders, and involves 
blasting anything you come across to
smithereens while flying your spaceship
around, advancing to the next level, and
repeating the procedure ad nauseum, ad
infinitum. Tux Racer is slightly different in 
its approach. You basically control the 
Linux Penguin, and help it skate across 
an ice floor, looking for fish to eat, while
avoiding obstacles. However, the game 
runs very slowly, even on a high-end 
system with a top-end graphics card, 
primarily because the drivers haven’t 
been installed properly. You can also try 
out the free multiplayer 3D games, found 
at www.sourceforge.net or www.rpmfind.net.
Good hunting!

Gaming in Linux 
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user-friendly for desktop users.
The set up is quite simple. The tricky

part is the disk partitioning utility that is
not easy for a new user. Though
it provides a graphical represen-
tation of all the partitions on
the hard drive, it does not shield
you from assigning a root parti-
tion or selecting a swap parti-
tion. Otherwise the install can
be easily navigated by a user
with a basic idea of Linux.

Starting off with Red Hat
8.0, Red Hat has embarked on
an ambitious project, called the
Blue Curve desktop initiative,
that provides a highly integrated desktop
environment. This inititive has drawn a lot
of flak from the open source community,
since it also restricts the ability of the user

to play around with the desktop. Thus, this
Blue Curve initiative has removed a lot of
the fun that was possible in the earlier ver-

sions of Red Hat. But it is a
boon to the new user who
does not care much about
switching desktops and
window managers. 

Configuring your
graphical hardware and
adjusting display settings
is also much easier now
using the new ‘redhat-con-
fig-xfree86’ tool, which
has replaced Xconfigurator
as the standard tool for

graphical configuration. But, there is a
downside to using this new utility, it runs
in graphical mode and the only way left
to bring the X server to life in case of
faulty hardware detection is by tweaking
the X server’s configuration file.

Red Hat does a good job of compiling
applications from source code, and there
are no issues as far as support for rpm
packages go. But the package manage-
ment system leaves a lot to be desired,

KDE
KDE is a network transparent contempo-
rary desktop environment for Unix work-
stations. KDE seeks to fill the need for an
easy-to-use desktop for Unix workstations,
similar to the desktop environments
found under Macintosh, or Windows. 
KDE has the following features:
� A beautiful contemporary desktop
� An integrated help system, allowing 
for convenient access to help pages of 
the KDE desktop, and related applications
� Standardised menu and toolbars, 
keybindings, colour schemes, etc.
� Internationalisation: KDE is available 
in more than 40 languages
� Centralised dialog driven desktop 
configuration
KDE applications
KDE has an office application suite, based
on KDE’s ‘Kparts’ technology consisting of
a spreadsheet, a presentation application,
an organiser, a news client, and more. It
also includes a Web browser—Konqueror,

which is a solid competitor to other exist-
ing Unix Web browsers.
GNOME
GNOME is a powerful graphics-driven desk-
top environment that enables users to easi-
ly use and configure their PCs. It’s main
objective is to provide a user-friendly suite
of applications, and an easy-to-use desktop.
It includes a start up panel, a desktop,
standard desktop tools and applications,
and a set of conventions that make it easy
for applications to be consistent with
each other. 
Window Managers
One of the main distinguishing features of
X is that it separates the window manager
from the windowing system. X allows you
to run any window manager that controls
the title bar, and other decorations. 
You can run a window manager that
looks and acts like the NeXT interface, the
Motif interface, or the Open Look inter-
face. Common window managers are
mentioned in the box below:

Desktop environments

Name
fvwm 

fvwm95 

WindowMaker 

AfterStep 

Enlightenment

Description
Looks like mwm; main window manager on Linux 

Looks like Windows 95. Comes with Slackware Linux 

Uses NeXT interface. 

Follow on to Bowman; uses NeXT interface. 

A color-intensive window manager.

The older Linux 
lpd-based printing

subsystem has now
been replaced by 
the CUPS subsystem
that has a very simple
Web-based configura-
tion utility, and sup-
ports many standard
lpd commands. 

Site to Visit
Visit these Web sites to get an insight
into open source, and free software.
http://www.opensource.org
http://www.fsf.org



more so in the area of checking and auto-
matically installing dependencies before
installing packages. These functionalities
are currently provided only by the
Debian-based apt-get, the ports-system
on BSD-style operating systems, and the
portage system on Gentoo Linux.

Red Hat has OpenOffice.org, which
provides compatibility with existing
Microsoft Office files. It is a very mature
Linux distribution but does not adapt well
in the office environment; rather the office
user has to adapt to Red Hat, and that will
take a lot of time.
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Distribution name
Ease of use
File system
Similarity to Windows
Suitability to office use
Printing subsystem 
System administration
Internet readiness
Graphical configuration
Features

Special features
Glaring deficiencies

Resource utilisation
Desktop hardware compatibility
Windows emulation tools
Economy
Overall score

SuSE Office Desktop
22.5
2
0
20
4
2
1.2
20
4
3
0.4
2.4
9.05
4
3
90.55

Red Hat 9.0
18
2
0
20
4
2
1
18.75
3
2
0.4
1.2
9.05
3
5
84.39

Mandrake 9.1
21
2
0
20
4
2
1.2
20
3
2
0.4
1.8
8.57
0
3
83.97

CATEGORY Office desktops

Distribution name

Graphics card
nVidia GeForce MX 440 with AGP8x
nVidia GeForce2 MX 400
nVidia GeForce2 MX 200
nVidia Riva TNT2
SiS 6326

Ethernet card
Broadcom NetXtreme 
Gigabit ethernet card
Intel Pro 100 VE
Dlink DFE-538TX 10/100
Intel EtherExpress PRO 100

Sound card
Onboard CMI 8378
Onboard 5.1 support
Onboard Realtek AC’97
Aureal2
Yamaha DS-XG

Optical drives
Samsung SW-240B CD-RW
Samsung SD-616Q DVD-ROM
Samsung SD-612 DVD-ROM
Samsung SM-348B Combo Drive

Modem
Best data 56 Kbps data fax modem

Overall score

SuSE Linux
Office Desktop

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

0.90

Red Hat 9.0

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

0.90

Mandrake 9.1
Standard Edition

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✖

0.86

CATEGORY Hardware compatibility

The purpose of Windows emulators is to
provide an environment in which Win-
dows-based programs can be executed on
a Linux platform. All you need to do is load
the emulator in Linux, which allows you to
run your Windows application. Here, we
look at the four commonly used emulators;
Wine, CodeWeavers CrossOver Office,
NeTraverse Win4Lin 4.0, and VMware.

Wine
Wine is an open source implementation
that can be downloaded for free from
www.winehq.com. It runs the Win 32 and
Win 16 API on Linux. Hence, you can exe-
cute almost any of your Win 32, Win 16 or
DOS applications. It provides X11-based
graphical support, DirectX support as well
as text based console. Support for sound
devices, input devices, printing devices,
scanners and CD writers, are also included.
Even bug detection occurs similar to that
on a Windows PC.

Code Weavers CrossOver Office
CrossOver Office has a small set of appli-
cations that can be emulated on Linux.
The list of applications supported includes
Microsoft Office, Lotus Notes, Microsoft
Visio, etc. Its latest version, CrossOver
Office 2.0.1, is available at http://www.
codeweavers.com/products/office/

NeTraverse Win4Lin 4.0
Developed by NeTraverse, Win4Lin 4.0
supports more Linux distributions than
any other. All you need to do is down-
load, and install it. It supports applications
from Microsoft Office, Macromedia appli-
cations, and Adobe. It also supports the
wheel mouse, larger memory allocation,
and a larger swap partition for Windows. 

VMware
VMware takes advantage of the Intel archi-
tecture, which allows virtual machines to
be created at the hardware level, enabling
you to use more than one operating sys-
tem on the same PC. It establishes a virtual
network connection between the operat-
ing systems, allowing them to communi-
cate with each other as if they were physi-
cal computers, connected via the LAN. So,
you can access the Linux virtual machine
through Network Neighbourhood in Win-
dows and vice versa. The biggest advan-
tage being that it can have either Linux, or
Windows as the host operating system.

Windows emulators



SuSE Linux Office Desktop:
The chameleon 
does it again

SuSE are tying to break up
their Linux distros into two

distinct categories; one targeted at
the general user and
the other targeted
at the office user.
This is much better
than trying to satis-
fy the needs of all
the users in a single
distribution.

The installer
interface is very

simple for those who have had some pre-
vious experience with SuSE, but for a new-
bie it can get confusing—SuSE does not
follow the step-by-step installation
process that is commonly used by all the
other distros. Instead it uses a Web page
format—all the detected settings are dis-
played on a single screen. To change any
of the settings, you have to click on the
specific item. The problem with this kind
of installation is that you might miss out
some important settings that should have
been changed. Otherwise the install is
perfect—the default option provided in
the installation, mounted all the existing
Windows partitions by itself.

The hardware support was quite amaz-
ing; it didn’t have problems installing on
any of the testbeds. Also, apart from the
bundled StarOffice 6.0, it comes with
Crossover, which lets you run many Win-
dows-based applications on Linux. 

Compatibility with rpm packages was
not a problem. But the most annoying part
was the absence of the ‘make’ utility need-
ed for compiling from source. While the
novice user might not consider this a
shortcoming, users are not novices forev-
er. Just as normal Windows users turn into
power users after a few months of usage,
Linux users generally demand much more
from their distributions after a few
months. This could be something as sim-
ple as compiling the open source alterna-
tive to MSN messenger (amsn).

Mandrake Linux 9.1
Standard review:
A magician without a wand

Installing Mandrake is quite simple. The
installer is very user-friendly, and even

a newbie won’t have a problem when
selecting options. The disk partitioning

utility is slightly different from other dis-
tros. It is much more graphical and gives
a multi-coloured view of the different par-
titions on your drive.

Mandrake 9.1 Standard comes with
both Koffice 1.2.1 and OpenOffice 1.0.2.
but StarOffice 6.0
comes only in the
PowerPack edition.
It comes with a
whole lot of applica-
tions neatly grouped
under various easy-
to-understand cate-
gories such as Office,
Networking, etc.

The Mandrake Control Centre is an
excellent tool that lets you control all the
hardware and software on your comput-
er. The Software Sources Manager uses
the CDs to manage the update process by
default. It also lets you add extra sites for
downloading the security updates. It lets
you choose from a list of mirror sites.
After configuring the proxy setting the
updates work perfectly, but the list of
sites is restricted. The updates take about
10 minutes to download on a T1 line.

The Windows partitions are mounted
by default, but the user has to have prior
knowledge of the mount points to access
the partitions. The samba server man-
agement using the Mandrake Control
Centre leaves much to be desired. It
searches for servers on the network and
lists all the available computers, but does
not group them by workgroups. More-
over it has problems accessing Windows
XP shares. Finally, you end up using the
command line samba utilities to get your
work done faster.

Overall Mandrake 9.1 is a good prod-
uct but a little more effort is required to
make it more user-friendly. While the
operating system comes with a whole lot
of goodies, it does not offer anything spe-
cial for the typical office desktop user.

What it all means
In the Office desktop category SuSE Office
Desktop outperformed all the others sim-
ply because it has been specifically devel-
oped for this particular segment. While the
other distros (Redhat and Mandrake) are
one-size-fits-all packages, SuSE has smartly
moved away from this mentality and start-
ed addressing the needs of different target
audiences. However, as far as pricing goes,
Red Hat is the best option as it is freely
downloadable, even for commercial use.

PRAVEEN KURUP (praveen_kurup@thinkdigit.com)
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Every Digit reader must surely be aware of the various com-
parison tests we do at our Digital Test and Research Cen-
tre. The comparison includes various products from all

categories. They  range from motherboards to keyboards, and
other cool gadgets such as digital cameras and MP3 players. We

grade these products based on their performance, features and
their merit as per the money you pay for them. The ‘A’ listed
products are those which are truly the best among the best—
products that you can safely bet on. Read on to find out more
about the product you have been hunting for all this time.

A listing of the best products in different hardware and software categories

A-List Reviews

CPU + 
Motherboard

Pentium 4 3.2 GHz 800
MHz FSB
+ Ultra Fast
- Very costly

Specifications: 533 MHz FSB, 512
KB L2 cache, HyperThreading
enabled
Contact: Nebula Technologies
Phone: 022-6730567
E-mail: pratik@nebulatech.com
Price: Rs 41,500

MSI 845PE Max2
+ Chock-full of features
- No serial ATA support
Specifications: Intel 845PE chipset,
HyperThreading enabled,
onboard 5.1 channel sound,
FireWire, Gigabit Ethernet, RAID
controller, USB 2.0, six PCI slots,
AGP 4X
Contact: Priya Ltd
Phone: 022-2663611
E-mail: salesbom@priyagroup.com
Price: Rs 7,200

Display

LCD
SONY SDM-N80 
18.1-inch LCD Monitor
+ Stylish looks combined with
great performance
- External power supply takes up
extra space.
Specifications: 18.1 inch a-Si
(Amorphous-Silicon) TFT Active
matrix panel, 1,600 x 1,200 max-

imum resolution, two USB ports,
external power supply with con-
nections for alternate display
source, sound connectors, Mac-
compatible display connection
Contact: Rashi Peripherals
Phone: 022-28260258
E-mail: ho@rptechindia.com
Price: Rs 1,49,000

Sharp LL-T153G
+ Outstanding Perfor-
mance
- No built-in speakers, minimal
feature set
Specifications: Max resolution
supported 1,024 x 768 @ 75Hz, 
15-inch LCD, pixel size 0.29
Contact: Sharp India Ltd
Phone: 011-26431313
E-mail: lcd@sharp-oa.com
Price: Rs 22,500

Samsung 
Syncmaster 171S
+ Good Performance, Wall
mountable
- No built-in speakers
Specifications: Max resolution
supported 1,280 x 1024 @ 76Hz,
17-inch LCD display, pixel size
.264, rotating angle 160 degree
/120 degree (H/V)
Contact: Samsung Electronics
India information & 
telecommunication ltd
Phone: 011-51511234
E-mail: marketing@
samsungindia.com
Price: Rs 42,000

CRT
BenQ V991 - 19-inch
+ High resolutions, great per-
formance
- No extra accessories
Specifications: 19-inch CRT 
(18-inch viewable size), 0.25 dot

pitch, Shadow-
mask CRT type,
115 MHz video
bandwidth,
flat picture
tube, MPR II,

TCO 99 emis-
sion standards compliant
Contact: Benq India Pvt Ltd
Phone: 022-25705231
E-mail: salesenquiryin@benq.com
Price: Rs 12,999

Printer

Laser
Samsung ML-1710
+ High-quality prints, low
cost
- Memory can’t be upgraded.

Specifications: USB interface, 600
dpi, 512 KB buffer memory, 250
sheet paper tray and 17 PPM
Contact: Samsung Electronics
India information and 
Telecommunication Ltd 
Phone: 011-51511234
E-mail: farrukh@
samsungindia.com 
Price: Rs 16,000

Inkjet
Canon S530D
+ Feature-rich
- High costs
Specifications: USB interface,
2,400 x 1,200 dpi (colour)
Contact: Canon India Ltd 
Phone: 011-26806572

Email: brijesh@canon.co.in 
Price: Rs 21,747

Scanners

HP Scanjet 4570C
+ Excellent scanning 
performance
- Heavier and bulkier

Specifications: 1,200 x 1,200 
optical resolution, USB interface, 
48-bit colour depth
Contact: Hewlett Packard 
India Ltd
Phone: 011-28260000
Email: ashwini-k_aggarwal@
hp.com
Price: Rs 17,999

Primary Stor-
age
Maxtor 250 GB
MaxLine Plus II 
+ Tons of space
- Heats up
Specifications: 7200 rpm, 8 MB
cache, ATA 133 interface
Contact: Cyberstar
Phone: 011-6438216
E-mail: yogi@maxtor.com
Price: Rs 21,000

Maxtor 200 GB
DiamondMax Plus 9  
+ SATA enabled
- Gets hot
Specifications: 7,200 rpm, 8 MB
cache, Serial ATA interface
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Contact: Cyberstar
Phone: 011-6438216
E-mail: yogi@maxtor.com
Price: Rs 15,000

Secondary Storage

MSI CD-RW CR52-A2
+ Can read and write 
90 minute CDs
- Small problems with CDs 
written at 52X
Specifications: 52X write, 24X
rewrite, 52X read speeds, IDE
interface, 2 MB buffer, Exact-
Rec and AWSS technology,
BURN-proof, supports up to 790
MB disc capacity, horizontal and
vertical mounting

Contact: Cyberstar Infocom Ltd
Phone: 080-2276986
E-Mail: narend@cyberstarin.net
Price: Rs 4,100

Input Devices

Microsoft Multimedia
Keyboard
+ Great feel
- Comes at a high price

Specifications: 16 hotkeys,
PS/2 interface, wrist support
Contact: Microsoft Corporation
Pvt Ltd
Phone: 011-26292640
Email: connect@microsoft.com
Price: Rs 1,600

Microsoft Wireless 
Intellimouse Explorer
+ High precision and sensitivity
- Batteries make it heavy
Specifications: Optical mouse,
USB interface, two extra buttons,
2 AAA batteries, infra-red, 
cordless
Contact: Microsoft Corporation
Phone: 011-26292640

Email: connect@microsoft.com
Price: Rs 3,380

Graphics Cards

Gainward FX 5800 
+ Future-proof

- Gets very hot
Specifications: 128 MB

DDR II memo-
ry, 0.13

micron,
maxi-

mum res-
olution

2,048 x 1,536 at
85 Hz, AGP 8X, 128 MHz, RAM-
DAC speed 500 MHz
Contact: Mediatech India Pvt Ltd
Phone: 022-56396696
Email: sales@mediatechindia.com 
Price: Rs 37,975

Sound Cards

Creative SoundBlaster
Audigy 2 Platinum 
+ 6.1 channel outputs
- Not even remotely affordable
Specifications: DVD-Audio (24-bit
with 192 KHz in stereo and 96
KHz in 5.1), 106 dB signal to noise
ratio, 6.1 surround sound capabili-
ty, EAX Advanced HD support,
WMA 9 support, FireWire port
Contact: Creative Technology Ltd
Phone: 9820357713
Email: rajshekhar_bhatt@ctl.cre-
ative.com 
Price: Rs 15,500

Speakers

Creative Megaworks
THX 5.1 550 
+ Mindblowing sound
- No digital inputs
Specifications: 5.1 speakers, 150
W RMS subwoofer, Five 70 W
RMS satellites, Frequency range
25 Hz to 20 KHz, 99dB SNR
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@ctl.cre-
ative.com 
Price: Rs 25,500

Mobile Phones

Sony Ericsson P800
+ Easy navigation

- Too many features for
the 
average user
Specifications:
Symbian 7.0 OS,
expandable memo-
ry, excellent PDA

functionality,
triband,

GPRS, WAP
Contact: Sony Ericsson Mobile
Communications International
Phone: 011-26180808
E-mail: sudhin.mathur@
sonyericsson.com 
Price: Rs 39,995

Digital Cameras

Olympus C-5050ZOOM
+ Allows external memory in vari-
ous formats
- Relatively low memory
Specifications: 5 megapixels, max-

imum resolution 2,560 x 1,920,
optical viewfinder, Auto focus,
CCD sensor, 1.8 inch TFT colour
LCD display, 3X optical zoom,
support for RAW, JPEG, TIFF pic-
ture formats
Contact: Komal International 
Phone: 022-22631366
E-mail: indiaolympus@vsnl.com 
Price: Rs 49,995

MP3 Players

Apple iPod 30GB
+ More space than you’ll 
ever need
- Costs way too much
Specifications: 30 GB storage
capacity, up to 25-minute skip
protection, 2-inch (diagonal)
greyscale LCD with LED back-
light, dock connector, remote
connector, stereo minijack,

Audio support
for Mac: AAC
(16 to 320
Kbps), MP3 (32
to 320 Kbps),

MP3 VBR, Audible(6), AIFF, WAV;
Audio support for Windows:
MP3 (32 to 320 Kbps), MP3
VBR, WAV; size: 4.1 x 2.4 x 0.73
inches; weight 176 gm
Contact: Telecompac Infosys
Phone: 011-26688171
E-mail: bally@del3.vsnl.net.in
Price: Rs 32,000 for 30 GB,
Rs 26,000 for 15 GB, Rs 21,000
for 10 GB

Laptops

Acer TravelMate C100
Convertible Tablet PC
+ Easy to carry and work with
- Slightly sluggish performance
Specifications: 800 MHz ultra low
voltage mobile Intel Pentium III
processor, 256 MB RAM, 10.4-
inch TFT LCD display, 30 GB
hard drive, USB (x2), Ethernet
RJ-45, modem RJ-11, IEEE 1394
(FireWire), infra-red, optional
802.11b wireless LAN, five
launch keys, four-way scroll key,
built-in microphone and speak-
ers, SmartCard slot, Type II
PCMCIA slot
Contact: Acer India Pvt Ltd
Phone: 080-5219520/23
E-mail: ailenquiries@acer.co.in 
Price: Rs 1,59,990

PDAs

Sony CLIE PEG-TG50
+ Great combination of features
and performance
- Rapid battery consumption
Specifications: 200 MHz proces-
sor, 16 MB ROM/RAM, Palm OS
5, Bluetooth and IR capable, high
resolution 320 x 320 TFT display
with backlights, integrated 

keyboard

with back-
light, USB
interface, Li-
Ion recharge-
able 

battery, built-in voice recorder
and MP3 player
Contact: Solar Systems
Phone: 022-56916834
E-mail: solarsystems@vsnl.net
Price: Rs 27,000
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We test the latest and the best hardware and software products available in the market 

The Pentium 4 3.2 GHz runs
on a 200 MHz quad-

pumped FSB, giving it a total
bandwidth of 800 MHz. It sup-
ports Hyper-Threading Tech-
nology (HTT), which gives it a
significant performance boost,
and has a really easy-to-install
cooling fan. We tested
this processor on an
Intel D875PBZ moth-
erboard with support
for 800 MHz FSB, 512
MB of DDR 333 MHz
Kingmax RAM in dual
channel mode, with an
MSI Geforce4 Ti 4800 SE
graphics accelerator. 

In the Quake III Arena test,
the 3.2 GHz was able to pump
387 fps at normal mode, 377
fps at high quality mode and
292 fps at a resolution of 1,024
x 768 and 32-bit colour depth.
These figures may seem a bit
low, but the bottleneck was
the DDR 333 MHz RAM and
the Ti 4800 SE graphics card.

On the 3DMark 2003
benchmark, the 3.2 GHz
returned 700 CPU marks—the
highest we have ever come
across. In the Sisoft Sandra
2003 Pro’s CPU arithmetic
tests, it gave 9,649 Dhrystones
and 6,059 Whetstones, and
yielded similar results with
CPU multimedia tests. The
Integer benchmarks saw a

score of 14,693 and FPU SSE2
saw a huge 23,321. All these
scores prove that the 3.2 GHz 
has an appetite for numbers. 

In the memory band-
width test, the dual channel
displayed its advantage, scor-

ing in the range of
4,000 and above. The
new Intel silicon
square was able to
complete the video
encoding process
in just 70 sec-
onds. However,

in the PovRay 3.5 test, the
CPU seemed to be lost, taking
29 seconds to complete the
rendering. Overall, the new
CPU set new records at times,
and just failed to break exist-
ing records at others. 

At a price tag of Rs 38,000,
you could choose to ignore the
200 MHz increase and wait for
something better—especially
with the expected 64-bit Intel
vs AMD war that is round the
corner. But, for those of you
who need the fastest CPU cur-
rently available, this is one of
the best around—providing
you can afford it.

Intel Pentium 4 3.2 GHz 
The Last of the Northwood 

Price: Rs 38,000
Contact: Nebula Technologies 
Phone: 022-26848612
Fax: 022-26848618
E-mail: pratik@
nebulatechnologies.com
Web site: www.intel.com 

With the D600, Dell has
gone in for a complete

re-design of its Latitude series
of laptops. The D600 meas-
ures 1.2 x 12.4 x 10.1 inches,
weighs only 2.12 Kg, and is
filled to the brim with fea-
tures, such as the Strike Zone
Technology that protects the
hard disk from shock.

Its Centrino-based
motherboard has the
slower 802.11b (11
MBps) wireless LAN
connectivity. Those
concerned about the
c o m p a t i b i l i t y
issues of Cen-
trino with
existing 802.11g network
equipment can opt for the
Dell TrueMobile Wireless LAN
Solutions that gives an addi-
tional 802.11 b/g or 802.11
a/b/g mini-PCI card. It has
dual band capabilities which
enable it to hop on to both
2.4 GHz as well as 5 GHz fre-
quencies.

The standard POVRay
benchmark, which takes
about 45 minutes on a Pen-
tium 4, 2 GHz, took just 58
minutes and 47 seconds on
the D600, proving its process-
ing power.

The operating tempera-
ture shot up to 57 degrees
after about 5 hours of use—

very uncomfortable if you
have it on your lap.

The keyboard is comfort-
able, and you can use the
touchpad with a pair of
mouse buttons below it, or
the pointing stick with a dif-
ferent pair of buttons.

It has a diagnostic utility
that can be used to recover

your system after
a crash. The diag-
nostic utility cor-
rectly diagnosed
the problems that
occurred after a
system crash.

The laptop
comes with a three

year onsite warranty.
Overall, it is a sleek, high per-
formance mobile device that
is perfect for executives on
the move.

Dell Latitude D600
Wireless anybody?

Price: Rs 1,53,366 
Contact: Dell Computers Asia
Phone: 1600-33-8044 (toll free)
Fax: 080-5586107
E-mail: marketing_response@
dell.com
Web site: www.dell.com

SPECIFICATIONS

Intel Pentium M 1.40 GHz,
Windows XP Professional SP1,
512 MB DDR RAM (up to 2 GB
supported), Removable 20, 30,
40, 60 GB hard drive,
Combination DVD and CD-RW
drive (8X24X10X24X), ATI
Mobility Radeon 9000 graphics
chipset, Intel PRO Wireless
2100 WLAN (802.11b) mini-PCI
card, Integrated 56 K V.92
modem and 10/100/1000
MBps Ethernet LAN

Dell Latitude D600

Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL

SPECIFICATIONS

Pentium 4 3.2 GHz, 512 KB L2
cache, Northwood core, 800
MHz FSB support

Intel Pentium 4
3.2 GHz 

Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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The Beanstalk 4455 is the
latest offering from HCL

Infosystems, targeted at the
home segment. The cabinet is
matte black with a silver
front, and the monitor is half
silver, half black. 

The PC comes with an
original Intel D845PEBT2
motherboard—the best
board in the 845 series, with
features such as 5.1 channel
sound, serial ATA controller,
optical SPDIF output, etc. It
has a pre-installed internal
modem, Ethernet, both a
DVD-ROM and a CD-RW
drive for CD-to-CD copying.
This last move seems bad, as
a combination drive would
have reduced the price con-
siderably. 

To complement the
onboard 5.1 sound system,
the PC comes bundled with
5.1 channel Altec Lansing
speakers—the wooden sub-
woofer gives out heart stop-
ping bass, and the satellites
produce good quality sound.
The Beanstalk 4455 also
comes with a small USB rum-
ble effect gaming wheel that
lets you feel the bumps on
the road when playing those
F1 simulation games. The
bundled software includes
MS Encarta (Indian edition)

and a complete suite of
multi-lingual software.

The PC also comes with
an external TV-tuner card and
a handy remote. The 80 GB
hard disk ensures that you
don’t run out of space for

your favourite movies. How-
ever, the GeForce2 MX 2400
graphics card does not do jus-
tice to the configuration. It is
the only component that
seems out of place, and keeps
this Beanstalk from qualify-
ing as a high-end PC. 

The PC also has good
Linux compatibility—we
installed RedHat 9.0, and
found that everything
worked smoothly.

At close to Rs 70,000 it is
a little steep, but the excellent
build, original Intel feature-
rich motherboard, flat-screen
monitor, Altec Lansing speak-
ers and bundled software
make this computer worthy
of any home.

Price: Rs. 69,990
Contact: HCL Infosystems Ltd 
Phone: 0120-2520977 
Fax: 0120-2533877 
E-mail: raman@hclinsys.com
Web site: www.hclinfosystems.com

SPECIFICATIONS

Intel Pentium 4 2.66 GHz, 256
MB DDR SDRAM (333 MHz),
80 GB 7,200 rpm hard drive,
16X DVD-ROM, 40X12X40X
CD-RW, 56K internal modem, 1
year onsite maintenance

HCL Beanstalk 4455 
Black beauty with a punch

HCL Beanstalk 4455

Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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When we received the big
FX Power Pack from

Gainward, we wondered how
large the card was to warrant
the humongous packaging.
On opening the box, the mon-
strous graphic card with huge
heat sinks on its front and
back was a sight to see. The
device is really thick and will
occupy the neighbouring PCI
slot with the elevated heat sink
fins that ventilate hot air from
above the core. It has a Molex
power connector (like the one
that goes to the hard disk) to
quench its thirst for power.

The fan speed varies
according to the
load placed on the
card. It’s quiet, and
runs at low speeds
when working
with non graphic-
intensive applica-
tions, but whines
like a jet turbine
the moment a user enters the
world of 3D. 

This card has some fea-
tures that no other card has.
The Ultra runs at a clock speed
of 500 MHz, with its memory
clocked at 1 GHz. It supports
the latest industry standards,
such as DirectX9 and OpenGL
1.4, vertex and Pixel shader
2.0, which means the user will
get to see more realistic water,
grass and walls in games.
There are some issues over the
pixel per clock—nVidia claims
it’s 8 pixels per clock, but in
some cases such as Z rendering
+ colour, it reduces to 4 pixels.
All said and done, the specifi-
cations look pretty good on
paper, making it decently
future proof. 

The card is indeed a per-
formance warehouse, giving a
high score of 286.7 fps in

Quake III Arena at a 1280 x
1024 x 32 resolution. The
scene in Serious Sam SE was
the same. Although the demo
started with a few jerks, there
was no stopping Sam in his
killing spree. Everything was
rendered instantaneously and
without any kind of artifact-
ing or jaggedness. In
VulpineGL Mark, the 3D
world was rendered with
ease—the whole benchmark
finished in half the time that
the SiS Xabre600 took—with
a score of 59.9 fps at 1280 x
1024 x 32. 

This card still isn’t the
fastest card overall, because

the 9800 Pro
from ATi is
already out,
and has an
improved and
faster core. The
9700 Pro still

manages to take the lead in
many benchmarks and is
available at a lower price.
Only games such as DOOM 3,
when released, will tell us
which card is better for the
games of the future. On the
price front, this card is unaf-
fordable to the majority, but
the privileged few who can
afford it will get a 5.1 channel
sound card, a FireWire card, a
Duke Nukem: Manhattan Pro-
ject CD and InterVideo
WinCinema DVD playback
software.

Gainward GeForce FX 5800 Ultra
Force 10 from nVidia

SPECIFICATIONS

125 million transistors, 0.13
micron fabrication process,
DirectX 9 and OpenGL 1.4
compliant, 500 MHz core clock,
1 GHz memory clock, 128 MB
DDR II memory

Price: Rs 37,975
Contact: Mediatech India
Phone: 022-5639 6696 
Fax: 022-2201 4083
E-mail: sales@mediatechindia.com 
Web site: www.gainward.com

Gainward GeForce 
FX 5800 Ultra

A-A-

Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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The first thing that you
notice about the SGH-

T500 is the external display
surrounded by bright gem-
shaped tiny LEDs. This
phone has an excellent build
quality and feels quite sturdy.
It is extremely lightweight
and is available in Ruby Red,
Sapphire Blue, Pearl White
and Topaz Gold. 

The 32 zirconium
stones lining the external
display double-up as serv-
ice indicators and flash
in the selected colour
namely, violet, blue, sky
blue, green, or orange.
The keys are flat and
lack depth, but large
enough to be used
comfortably, and
sport a blue back
light. Two soft keys
at the top of the key-
pad access the menu
and the phonebook; the can-
cel key is placed in between.
The four-way scroll key fea-
tures an Internet shortcut
key in the centre. You can
store 500 contacts apart from
those stored on the SIM card,
and can assign different ring
tones and service light
colours to your contacts.

The phone has a voice
memo feature, which allows
you to save three records of 35
seconds each.  Not really a
phone for SMS junkies, the
T500 does not support con-
catenated messages, and
though it does have predictive
text input, you cannot add
new words to the dictionary.
Other key features include
polyphonic ring tones, a
scheduler, alarm, calculator,
To-Do list, world time, con-

version, timer, stopwatch,
WAP 1.2.1 and three games.
Though the phone supports
picture messaging, it does not
support MMS or other con-
nectivity options such as
InfraRed and Bluetooth.

More features that mark
this as a lady’s
phone are calorie
and fitness calcula-
tors, biorhythm and
a pink scheduler for
menstrual cycles.
Even the internal

LCD display
doubles as a van-

ity mirror when
turned off!

The T500 nor-
mally offers a good

degree of voice clarity,
but faces a few prob-

lems in areas of low net-
work coverage. Also,

since the keys lack depth,
the two small rubber pegs at
the bottom of the keypad get
in the way when using the
two corner keys.

Looking at the hefty
price tag of almost Rs 30,000,
it may make better sense to
go in for high-end handsets,
such as the Nokia 7650 or the
Nokia 7250, which have dig-
ital cameras and cost less—
especially if you don’t care
for stereotypes.

Price: Rs 29,099
Contact: Samsung India Informa-
tion and Telecommunication
Phone: 011 - 5151 1234
Fax: 011 - 5160 8821
E-mail: chandrasekar@
samsungindia.com
Web site: www.samsungindia.com  

SPECIFICATIONS

80 gms, dual display (external
monochrome 96 x 64 pixels,
internal 65,000 colours 128 x
128 pixels), GSM 900/1800,
Li-Ion 720 mAh battery, up to
200 hours standby time, up to
3 hours talk time, three
games: Bowling, HamsterBox,
HoneyBall

Samsung SGH-T500
Mobile Phone

Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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The ML-1710 is the latest
addition to Samsung’s

extensive line of laser
printers. The ML-1710
comes in a milky white
body, decorated in slate
grey. Despite its small
size of 13.7 x 14 x 7.6
inches, the printer fea-
tures a removable paper
tray capable of holding
around 250 sheets. The
upper body serves as the out-
put tray but can hold only
about 40 sheets, after which
the papers start flying
around—a very small flap is
provided to hold the print-
outs in place.

As far as specifications
are concerned, the ML-1710
boasts an 8 MB memory
buffer, which is quite effec-
tive as can be seen from its
performance—the downside
is that the memory can’t be
upgraded. The printer comes
with a USB 1.1 interface.
Samsung has done a good
job of providing drivers for a
host of operating systems,
including all Windows ver-
sions and support for many
Linux distributions. The
drivers also have features
such as watermarking and
high altitude correction.

The bundled accessories
include a 15A power cord
and an extensive manual,
but no USB data cable,
which is quite strange for a
USB printer. 

The printer also comes
with a Toner Save button that
claims to save around 40 per
cent in ink consumption. The
front panel consists of just
one multi-functional button
and two indicating LED’s. The

printer also
supports a manual paper feed
mechanism, located on the
front side. 

The ML-1710 is the
fastest and the smallest laser
printer available in India. It
was able to print 15 pages in
one minute—only 2 pages
short of the claimed 17 ppm
printing speed. The quality
of the output was also great,
considering the speed of
printing. It printed the test
image and combination doc-
ument in just 17 seconds and
22 seconds respectively—by
far the fastest we have seen. 

Priced at Rs 16,000, the
printer is ideally suited for a
typical small office or as a
home printing solution, and
is a good buy for those on
the lookout for a small, fast,
good quality laser printer.

It may not be suitable for
a large organisation due to
the lack of networking capa-
bilities, the smaller paper
capacity and poor paper
handling. 

Samsung ML-1710 Laser Printer
The best things come in small packages

SPECIFICATIONS

66 MHz processor, 8 MB mem-
ory, 15 ppm, media type sup-
ported: A4 and smaller, special
media such as transparencies,
envelopes and postcards.

Price: Rs 16,000  
Contact: Samsung Electronics 
India Information & 
Telecommunication Ltd
Phone: 011-51511234
Fax: 011-51608820
E-mail: farrukh@samsungindia.com 
Web site: www.samsungindia.com

Samsung ML-1710 
Laser Printer
Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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Samsung SGH-T500 Mobile Phone
One for the ladies



test drive ■
■ reviews

76 AUGUST 2003

The COOLPIX 4300 is a
4.0 Mega pixel digital

camera with 3X optical
zoom. Other features
brought to you, courtesy
Nikon, include 12 scene
modes that help those new
to digital cameras to get the
best images easily. The cam-
era is compact and the but-
tons are easily accessible.
Like others in its
class, it has a
video-out jack
so that you can
preview the
images on a TV
screen, and is
bundled with
rechargeable Li-
Ion batteries for
a cost effective
solution for extended
use. The USB connection
makes for easy transfer of
pictures to the PC, and a
dedicated transfer hotkey is
provided to make the task
even simpler. 

However, when used in
manual mode, adjusting set-
tings such as white balance
and resolution is a little com-
plex. This is irritating if you
need to change the settings
frequently, while shooting
outdoors. The COOLPIX
4300 also captures small
movie clips, but the absence
of a microphone does not let
you record sound clips.

When tested for image
quality at the highest resolu-
tion supported by the cam-
era, we got mixed results. In
the Auto mode, the outdoor
images were impressive, with
brilliant colour reproduction
and details. However, when
shooting indoors, images
were captured in detail but

with a red tinge that was vis-
ible in PhotoShop, making
the images look rather grainy.
The camera also needs manu-
al settings to get better depth
of field. With everything set
on Auto, you will not be able
to get the desired depth in
your photographs; which is a
very important aspect of

indoor photography.
The compact

design and
lightness of this
camera makes it

convenient for
you to carry
it on
o u t d o o r
shoots. 

However,
if you are planning to take

the camera with you on a
long vacation, the 16 MB
Compact flash memory
might not be enough to
store all your memories—at
the highest setting in Fine
mode, an image occupies
between 1.8 MB and 2.3 MB.
Using a lower setting of
1,280 pixels will bring the
image size down to around
550 KB, which can also be
printed later. 

The camera is a good buy,
if one plans to use it more
outdoors than indoors, and is
sufficient for  the needs of the
novice photographer.

Price: Rs 44,000
Contact: Aver Software 
Technologies Ltd.
Phone: 022-2673 2955/ 6/ 7/ 8
Fax: 022-2673 3116
E-mail: aver@averphoto.com
Web site: www.nikon.com  

SPECIFICATIONS

Weight 283 gms, 16 MB Com-
pact Flash memory, 4.0 Mega
pixel resolution, 3X optical
zoomNikkor lens, f2.8 to f13.4
aperture range, 8 to 1/1000
second shutter speed range, 1.5
inch LCD, 4 cm macro mode

Nikon COOLPIX 4300

Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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Antec, well known for
their high quality power

supplies and cabinets, have
been in the Indian market for
while. The Sonata Piano
Black Super Mini Tower cabi-
net comes from Antec’s
LifeStyle series. 

The cabinet looks stun-
ning with its polished jet
black exterior finish. It has a
lockable front panel door.
When opened, it reveals
the power button,
optical drive
bays and the
floppy drive bay.
It has two USB,
one FireWire and
two audio ports
in front, neatly
hidden behind a
small gleaming
silver roll over
flap. The ‘Antec’
logos drilled on
both the side panels
double as ventilators. On
the rear of the cabinet, there is
a power switch and a switch
to select the voltage. 

The side panels have
thumb screws that you can
open with your hands, and
are also lockable to prevent
unauthorised access. The inte-
rior is a bit cramped, but bet-
ter than other cabinets in the
market. The quality of the
materials used for construct-
ing the cabinet is excellent,
and it comes bundled with
cables and connectors. A strik-
ing feature is the large 120
mm temperature controlled
fan on the back panel. The
sensor detects the interior
temperature and varies the

fan speed accordingly. So if
the temperature is lower, you
get a quieter environment.
There is also a provision to
place another 120 mm fan
behind the front panel, which
would act as an air intake fan.

The cabinet has three
5.25 inch bays and six 3.5
inch bays. The 3.5 inch bays
are displaced by 90 degrees
(they face the side panelling)

and are detach-
able; this allows
easy installation
of hard disk
drives—you can
take the bay out,
place the hard
disk on rubber
grommets pro-
vided on the
bay, screw it in
and place the
whole bay back.
The cabinet
comes with

seven large power con-
nectors and two small power
connectors. 

The Antec Sonata is
priced at Rs 9,000, making it
the most expensive cabinet
targeted at the home seg-
ment. Considering its fea-
tures, quality of construction,
380 Watt power supply, and 3
year replacement warranty, it
is a great buy for gamers—if
you can afford it. 

Antec Sonata Piano Black 
Super Mini Tower
A gamers box with style

SPECIFICATIONS

Mini Tower, Athlon or Pentium
4 compliant power supply, 380
Watt power rating, front
mounted USB, FireWire and
audio ports, Voltage (110/220)
selector, 120 mm fan

Price: Rs 9,000  
Contact: Cyber Space Abacus 
Pvt Ltd
Phone: 044-24917667
Fax: 044-52154188
E-mail: shunmugavel@
theitdepot.com 
Web site: www.antec-inc.com

Antec Sonata Piano 
Black Super Mini Tower
Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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Nikon COOLPIX 4300
Pricey affair
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The XA3021 speaker set is
designed to stick out in a

crowd. The subwoofer looks
like a 500 pound bomb, a
scuba diving apparatus, or an
ultra-futuristic cappuccino
machine, depending on
which angle you look at it
from. The satellites are
designed to look like large stu-

dio microphones, with the
ability to swivel vertically. 

The wired remote control
has three presets to control the
bass level—TV, Gaming and
Max Bass. The traditional vol-
ume control is replaced by a
rotary dial that can change
volume levels really quickly.
However, if you’re looking to
turn down the volume a wee
bit, it’ll actually increase sig-
nificantly before going down.

The speaker connections
are different from what you’d
expect—instead of inputs for
the front and subwoofer chan-
nels, it has Left and Right

channel inputs; typical of TVs.
PC users should be aware that
the sound card output needs
to go into the ‘Aux’ Input for
the system to work.

The bass is pretty power-
ful—too powerful at high vol-
umes—and the treble repro-
duction is truly excellent. It’s
only at the highest levels that
the treble begins to crack, but
the bass gives way long before
that. In fact, it only sounds
good at low to medium vol-

umes. Plastic just can’t
replace wood as a substitute
for a subwoofer’s case.

Overall, the speakers
perform consistently with

what you’d expect from a
high-quality set. The real body
blow comes if you glance at
the price tag. Rs 6,750 is way
above its deserved asking
price. You can get great-sound-
ing 4.1 speaker sets for less
than that. The XA3021 looks
like a bomb, and costs just
about as much.

Price: Rs 6,750
Contact: Trifin Technologies
Phone: 011-26236061
Fax: 011-26436447
E-mail: trifin@vsnl.com
Website: www.alteclansing.com 

SPECIFICATIONS

20 W RMS total power, 35 Hz to
18 KHz frequency response, 76
dB SNR, 5.25-inch long-throw
woofer, two 3-inch full-range
satellites, corded remote    

Altec Lansing XA3021
2.1 for the price of 4.1

Altec Lansing XA3021  

Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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utilised RAM, after which the
program will automatically
start freeing up memory. You
also have an option of ‘Deep
RAM Recovery’, which frees
up more memory. It can be
used when your system is
extremely sluggish, and saves
you from restarting. 

SpeedUpMyPC is also
capable of monitoring CPU
resources, and assigning
them to the most important
tasks. It depicts usage on a
graph and allows the user to
assign resources to any pro-
gram currently running.
Most importantly, it can also
prioritise system processes,
once a certain amount of
CPU usage is set. 

This program is capable of
optimising the browser and
Internet settings and can also
automatically perform a

bandwidth test to gauge your
speed. However, we did not
see any sort of boost in surf-
ing or downloading.  

SpeedUpMyPC can
recover the PC from crashes.
It does this by trying to
terminate tasks that are
possibly responsible for the
crash, frees up the CPU and
RAM, and restarts the Win-
dows shell. 

Overall, SpeedUpMyPC
1.16 does offer a good set of
features and will boost system
performance for those who
use older versions of Win-
dows, such as Windows 9x. 

Most of us would appreci-
ate a utility which

allows us to free precious
memory and assign more
CPU power to programs.
SpeedUpMyPC is a program
from Li Utilities that serves
this purpose—it help you free
up RAM when needed. You
get an option to set a limit of

Price: $29.99 (approx Rs 1,399)
Contact: Liutilties
E-mail: contact@litutilties.com
Web site: www.liutilities.com 

SPECIFICATIONS
Windows 95, 98, 2000 or XP,
10 MB free hard disk space,
32 MB RAM, Pentium 400 MHz
or higher

SpeedUpMyPC 1.16   
Memory monger

SpeedUpMyPC 1.16

Performance
Ease of Use
Value for money
Features
OOVVEERRAALLLL
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BenQ’s new M100 optical
two-button scroll mouse,

is an entry-level optical input
device. The
mouse is an ele-
gant electric blue,
with silver coating
on the buttons. 

The M100 is built for
both left-handed and right-
handed users, and has a USB
to PS/2 adapter. It displayed
good precision in the games
we played, namely, Unreal
Tournament 2003 and Quake
III Arena. The mouse sensitiv-
ity is above par, and per-
formed well even when the
mouse sensitivity settings
were lowered. 

Although it costs as
much as an entry level
mouse, it matches the quali-
ty of a Microsoft mouse. It
combines top performance

and great value in a
very attractive pack-
age, and is worth
every penny you

spend, and that’s the
bottom line! 

Price: Rs 699
Contact: BenQ India Pvt Ltd
Phone: 022-25705230
Fax: 022-25705235
E-mail: kamleshsalunke@benq.com 
Web site: www.benq.co.in

BenQ M100 Optical
Mouse
Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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SPECIFICATIONS

Optical sensor, PS/2 interface
(USB version with USB to 
PS/2 option also available), 
two buttons, scroll wheel with
glowing LED   

BenQ M100 Optical Mouse 
Glow mouse
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The monsoon brings joy to all, and
I’m no exception—I love walking
in the rain and pretending to

not have a care in the world. Unfortu-
nately, it’s a bad time of the year for our
little white computing boxes. Sure the
climate makes them run cooler, but the
humidity can sometimes stop them
cold—condensation can blow up com-
ponents at times.

This weekend I was out on a stroll,
enjoying myself while the rain gods
showered the earth. Happily soaked, I
returned home and poured myself a cup
of hot coffee, sat down and switched on
my PC. To my dismay, all I saw was a
blank screen and heard the dreaded
death toll of my RAM. Immediately I
switched off, opened the cabinet and
realised that my decision to keep my PC
near a window, so that I could enjoy the
real and cyber world simultaneously, was
a big mistake. Moisture is a PC compo-
nent’s biggest enemy, and alas my RAM

chip had suffered a fatal blow. After a few
feeble attempts at digital CPR, involving
a hair dryer and trying out different RAM
slots, I declared my chip to be indis-
putably dead.

After a quick eulogy and
dump-in-the-dustbin funer-
al, I headed out to buy
myself a new RAM
chip. Being the end of
the month, I was on
the lookout for the
cheapest solution
available. My first
stop was the
nukkad-wallah
computer shop.
When I asked
for a 256 MB
SD RAM chip,
he handed me
a Hynix module
and told me the
damage would be Rs 2,500.
After a brief pause to catch my
breath, I asked why SD RAM
was so expensive. He informed
me that SD RAM was soon to be
extinct, and is now sold as
antiques. Dealers are not
stocking SD RAM, as the faster
and now cheaper DDR RAM is
taking over. I couldn’t believe
my ears, as I had bought my
now deceased SD RAM for Rs 1,200 only
a few months ago.

So, I decided to venture further away
from home, and went RAM shopping in
Lamington Road. The first dealer I came
across, was selling the same Hynix mod-
ule for Rs 2,300, but was quick to suggest
that I buy DDR RAM instead. “Aare
bhayyia, when you can get double the
performance at a cheaper price, toh
sochna kya”, he said. When I told him
my motherboard didn’t support DDR
RAM, pat came the reply, “Toh mother-
board upgrade karo”.

My next stop was also fruitless, as
the vendor told me he had stopped sell-
ing SD RAM a month ago—all he had
was the different flavours of DDR RAM.

When I asked for prices, I was told that
normal Hynix 256 MB DDR RAM was
available for as low as Rs 1,700, the 333
MHz variety costs Rs 2,200, and the
fastest 400 MHz version costs just Rs

2,800. Cursing my luck for buying
a dinosaur, I moved on in 
my search for the elusive cheap
RAM chip.

The next dealer had a new
swanky, modern looking shop. He
also sold only DDR RAM, but

offered a choice of brands, such
as Kingston, Cosair, Sam-

sung, etc. Kingston is
supposed to be really

good, and also
more expensive.
Kingston RAM
costs Rs 1,950,
Rs 2,350 and
Rs 3,500 for
266 MHz, 333

MHz and
400 MHz

respectively.
Onwards I

went, looking
for a solution to
my problems. I
was about to call
it a day, and was
resigned to buy-
ing a new DDR

RAM supporting motherboard, when I
came across a very troubled looking ven-
dor, who told me that he would get the
RAM for me for Rs 1,800, but with only
6 months warranty. Immediately suspi-
cious, I asked why that was so, and was
told that he had a few pieces lying
around which he had bought a few
months ago for really cheap and was
now just looking to get rid of them as no
one was buying SD RAM anymore.

I wasn’t too worried about the 6
months warranty, as I knew I would
probably upgrade to a DDR-based moth-
erboard way before then. So, after double
checking the RAM, I headed off home,
happy that I had got what I wanted, 
and cheap!

RAMbling Memory
Agent 001 goes shopping in the volatile RAM market

■ Never buy second hand RAM
modules. Since they don’t carry
any warranty, you might end

up wasting your money.
■ If you are buying a new PC, opt

for a DDR RAM-based motherboard,
as DDR is much faster, and cheaper
as well. 
■ Before buying a DDR 333 or a DDR
400 memory module, make sure it is
compatible with your motherboard.
This can be verified from the mother-
board manufacturers Web site.
■ Insist on genuine RAM chips. General-
ly what we get in Indian market, are
modules that are manufactured locally
by soldering memory chips onto a
cheap quality PCB.
■ Manufacturers such as Kingston, Cor-
sair, Crucial, etc., offer a lifetime war-
ranty (five years actually, a computer’s
lifetime not yours). Pay a little extra and
opt for this warranty, to give you peace
of mind.

ILLUSTRATION: Mahesh Benkar
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Finding a needle in a haystack may
sometimes be easier than finding
relevant search results on the Web.

But with Google, you can refine your
searches dramatically. It’s the definitive
search engine that can be used to scour
the Internet for virtually anything—from
a simple search for MP3s to issues such as
Digital Rights Management, Google is
sure to bring up results of relevance.
Though most people are satisfied with
typing in whatever they want and click-
ing search, power users need more. To get
accurate results, you have to use certain
tricks to properly link all sections of your
query.

To search better, you have to know
what to query for and more importantly,
how the technology works. 

Every Web site uses certain keywords
to describe itself. These keywords are
included in the code of the Web site and
are called Meta tags. Most search engines
compare these keywords to the query you
enter, in order to check the relevance of
the page. This process of checking a page
is known as Web crawling. The problem
with Web crawling is that Web sites can
make improper use of Meta tags. Com-
monly generated search requests such as
money, news and jobs are added as key-
words to almost every Web site. 

Google uses many search algorithms,
and a large network of low cost PCs, to
filter its results. The main algorithm used
is PageRank, which votes for the rele-
vance of a site. Each site that provides a
link to the tested site is counted as a vote.
Also, the vote of an important site is
given higher priority. After this, a sepa-
rate algorithm known as Hypertext is

used, which makes a detailed compari-
son of all the elements of the tested Web
page. After this, the results are delivered
to your system.

Google’s advanced technology is all
well and good, but the main question is
“How do I search better?” All you have to
do is follow some simple search tactics to
get better results. 

Understanding Your Google
When you perform a query, it appears in
the Google page at the top. Below this,
you will see some categories, which indi-
cate that your query is listed in the Google
directory. Then the results are displayed
in the order of relevance. If your search
uses very general terms, you may get hun-
dreds of thousands of results. Thus, the
best search is one that gives you fewer, but
more accurate results.  

If you use Google regularly, you may
have noticed the ‘I’m Feeling Lucky’ but-
ton, located right next to Search. Click-
ing on this button will take you directly
to the most relevant Web site—the first
link that would appear if you had clicked
on Search. If the query is related to an
organisation, you will also see a stock
quote of the company.
Three more links are includ-
ed with every result—
‘Cached’, ‘Similar Pages’ and
‘More results from…’. The
‘Cached’ link allows you to
view a snapshot of a Web
site, taken when Google
indexed the site. The snap-
shot may not provide the
current version of the page,
but is extremely useful if the

Web site in question is out of service. The
‘Similar Pages’ link allows you to view
page listings that are similar or related to
the query, and the ‘More results from…’
allows you to see search results from
other Web sites. 

The most basic aspect of query con-
struction is clear thinking. You must be
specific in your thinking of what you
want to search for before typing in the
keywords. A specific query will generate
more accurate results than a query with
commonly found keywords. For example,
if you’re searching for the lyrics of a song,
try typing in a line from the song along
with its name. 

Google eliminates all common words
such as ‘The’, ‘And’ or ‘Of’. This is done
because such words generate a lot of
results. But if you are searching for ‘Rise Of
Nations’, the ‘Of’ is necessary. To specifi-
cally include it, you have to search for
‘Rise +Of Nations’ or include the query in
quotes—search for “Rise of Nations”. 

Another way to improve your search
results dramatically is to use the Advanced
Search feature. This allows you to construct
your query with a variety of conditions.
You can also provide exclusions to your

Refine your search result using the Advanced Search Options

Peek under the hood of the most popular search engine there is,
and learn how to use it effectively
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query. The search query can then be filtered
using various criteria such as language, file
format, date and query occurrences.

Search operators, which are prefixed to
a query, are another great way of defining
your results. Google has 10 major opera-
tors that can be used to retrieve pages from
its cache, look for the query in URLs,
search for links to the query, etc. Some use-
ful search operators are ‘related’, ‘allintitle’
and ‘indexof’. For example, if you are
searching for the E3 games Web site, try
entering the query as ‘allinurl: E3 games’.
This will give you results of all sites with
‘E3’ and ‘games’ in the URL.

If the search is OS specific, try using
Google topic specific searches. The
topics include Macintosh, Windows, BSD
Unix and Linux. Another feature
is an exclusive .edu (education) and .mil
(military) site search. You could also
narrow your search to a specific school
using the university search, which pro-
vides a listing of many universities.
You can check out all these advanced
search features by clicking on the
Advanced Search button or visiting
www.google.com/advanced_search.

More than vanilla
Google is not about plain Web Searches; it
also has a comprehensive image, news
and directory search.

The image search is extremely effective,
with algorithms that analyse various fac-

tors, such as name of image and image cap-
tion. Images are then selected and
processed, multiple instances are removed
and finally the results are displayed as
thumbnails. To refine image searches, try
to restrict the resolution of the images. For
example, to find 1,024 x 768 resolution
images of natural beauty, search for ‘nature
1024*768’ rather than just ‘nature’. 

The ‘Advanced Image Search’ option,
allows you to refine search results by
searching for fixed file sizes, file format or
colour values. You can also use the ‘Safe
Search’ option to prevent explicit content
from being displayed. To maximise your
relevance, construct your query with key-
words that may be included in the image
or its caption. 

A facet of the Internet that has been
largely forgotten is Usenet. It is a system
that transfers information inside specific
groups, and can provide solutions and
firsthand information from like-minded
individuals around the world. It is con-
sidered to be the largest de-centralised
source of information on the Internet.
Google Group search can be used to track
relevant information across Usenets. To
do this, click on the Groups link.

When you search for Usenets, you
must know the subject, the group or the
author. When a search request is made,
the results are displayed in a format sim-
ilar to to standard Web searches, but only

groups related to your query are shown.
For a precise search of Usenet archives,
use Advanced Search. Apart from stan-
dard filtering, the Advanced group search
allows you to specify a group name,
author and subject.

You will always find information on
the Internet, but the problem is verifying
this information. The Open Directory Pro-
ject (ODP), started by Netscape, aims to
solve this. It is a large catalogue of Web
sites categorised by people around the
world. These voluntary editors review
sites, and decide whether they should be
included in the directory. The directories
are classified broadly into sections such as
arts, business, computers, etc. Within
these directories, are more specialised divi-
sions that can be used to make search
results precise. Due to the level of preci-
sion involved in Directories, an advanced
search option is not necessary. 

Google uses its search technology to
track information from about 4,500 news
sources, to form Google News. The news
is then placed in order of relevance,
allowing you to look at news from vari-
ous sources and study different news per-
spectives. In a test search, Google
retreived a news item that was posted
only 35 minutes earlier!

Searching is one thing and promotion is
another. If you want to improve your site
rankings in Google, just follow these sim-
ple steps.

If you wish to pay for promotion, use
Google Adwords. This is a unique advertis-
ing system targetted at relevant customers.
Check it out at www google.com/ads/.

If you just want ranking improvements,
you should follow the system Google uses to
rank pages. Submit your site to the Open
Directory Project, in order to get Google to
list your site. Google provides more rele-
vance to Directory based search results. Thus

a significant boost in ranking can be seen.
Also try to add all the keywords that

define your site to the top or the Web
address of your site. Google gives high pri-
ority to keywords in the title or heading of a
page. Apart from this, spread the keywords
along the entire page and site, as Google
evaluates the content in the middle and at
the bottom of your page.  

Become a part of a Webring. Find a
group of sites with related content. Pro-
vide cross links between the pages. This
will result in link popularity and provide
better results.

Attention Web Masters

Before: Using a plain image search can result
in thousands of useless images

After: The advanced image search will yield
better and relevant results

Use Google Group search to get exactly what
you need, and nothing more!

Google News is taken from over 4,500 sources
and brought fresh to your desktop
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Adding Google to your PC
Installing the Google toolbar is the sim-
plest way to search the Net, as it docks
with your IE browser. After this is done,
you can search Google effortlessly using
the search field in the toolbar.

And still some more
Answers (http://answers.google.com), is yet
another ace in Google’s deck of cards. You
can ask any question you like and have it
answered by experts, albeit for a fee. But,
some of the previously asked questions
can be browsed freely. 

Google labs is an interesting section
which reveals what may be the final solu-
tion to the complete search experience.
Some of the more popular projects are
mentioned here; to see the entire list of
revolutionary new search ideas, visit
http://labs.google.com/.    

Google Compute: Google supports a
distributed computing project called
Folding@home—a project dedicated
to understanding the structure of
proteins, thus providing better treatment
for diseases. It installs along with
the Google toolbar, and uses your com-

puter’s idle time. This is a great cause
to help, especially if you have a broad-
band connection.

Touch Typingoogle: If you are a touch
typist, you must hate reaching out for
your mouse. Like-minded developers in
Google have developed keyboard short-
cuts so that you can search Google with-
out ever touching your mouse! 

Quoting Google: If you want to view
instant feedback on every search result,
try out Google Webquotes. It provides
quotes regarding search results. 

The Next Step
Since Google has launched its API for free,
programmers are taking advantage of this
to present search results in many differ-
ent ways. Here are a few examples:

Egobot: If you never wish to worry about
constructing queries, use Egobot! It allows
you to search for information using a ques-
tion-answer format. It uses a specifically
composed algorithm, with the Google API,
to create a simple yet accurate answer. If
anything, it will lighten your mood.
http://blog.outer-court.com/egobrowser/egob-
ot.php

Centuryshare Calculator: Centu-
ryshare Calculator is a great tool for
research. It provides the relevance of the
entered key phrase along a timeline.
When ‘Beatles’ was entered as the search
string, the chart shows popularity from
1961 to 1970. This was the period when
the Beatles worked, and created music. 
http://blog.outer-court.com/centuryshare/

Memomarker: The Web address of a
site may change, but its description gen-
erally remains the same. Memomarker
uses page descriptions to search the Web
and provide you with accurate results.

http://blog.outer-court.com/memomarker/

Googlism: Need a few more laughs?
Check out Googlism.com. Search for any-
thing under the sun and you’re likely to
find a quote about it. 
www.googlism.com

Google by e-mail: An innovation in
every sense of the word, use this service to
search for results via e-mail! Simply send
a blank e-mail to google@ capeclear.com,

Tired of Google? Or want a new set of
tools? Check out these popular alternatives
to Google search. 
Teoma: www.teoma.com uses the commu-
nities of the Internet to provide you with a
relevant search. It also provides tips and
tricks to refine your search.
AllTheWeb: In terms of database and
search coverage, www.alltheweb.com is
clearly better than Google. Bizarre search
queries such as ‘Russian Education’
brought up more than twice the links that
Google provides. 
Kartoo: If you have a really fast connec-
tion, you may like www.kartoo.com. It is a

Meta search engine that draws an interac-
tive map of all the results it receives. This
makes for really interesting viewing!

Different Beats…

Interactive Results in kartoo.com

If you think of the Internet as a mam-
moth library, then you’ll be shocked
to know that more than 90 per cent
of the Internet is not accessible using 
search engines. This portion of the
Net is known as the invisible Web. This
information could potentially enhance
the search process and make your
searches more relevant. One ambitious
approach to search the invisible Web is
Turbo10.

Turbo10 promises a search engine
that can scan the invisible Net and
produce better results. True to its
word, the search did provide some
different results. You can try it out at
www.turbo10.com

The Invisible Web…

Egobot, Google with intelligence?

The Centuryshare calculator adds the
perspective of time to searches

Want to do more with the Google API?
Check out the tutorial provided by IBM
related to Google’s API at http://www-
106.ibm.com/developerworks/edu/ws-
dw-wsgoog-i.html. It describes building
Web Service Applications with Google.
It has four examples that demonstrate
the capabilities of the Google API and
service. 

Advanced Ap(e)Ing?
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with the subject as your query, and you
will receive the search results as a reply.
Google API Web Search by Host

(GAWSH): GAWSH presents the Google
results differently. All results are sorted
by Web site, with all the relevant links
displayed as a tree. This tree expands to
view all links local to that site. 
http://www.staggernation.com/gawsh/

Google API Relation Browsing Out-
liner (GARBO): GARBO is similar 
to GAWSH. But the tree structure is
defined on the basis of related pages of
linking pages. This allows you to club
together sites of similar or redundant
information.
http://www.staggernation.com/garbo/

Google API Proximity Search
(GAPS): Completing the staggerna-
tion.com trio is GAPS. It is a unique way
to search terms that are situated next to
each other. For example, you can define
how close the terms must be and in what
order must they be placed. You may also
specify secondary terms. 
h t t p : / / w w w. s t a g g e r n a t i o n . c o m / c g i -
bin/gaps.cgi

Touch Graph Google Browser: The
Touch Graph Google Browser is a prime
example of how the Google API can be

used. A complex graph is generated
which shows all sites related to the 
URL input. www.touchgraph.com/TGGoogle-
Browser.html

Use these tricks to refine your search
results, and remember that Google is con-
stantly upgrading its search systems and
adding new functions and services. Check
out Google Labs for services under testing.
Also, many more third party tools for
searching are available. So make sure you
keep learning new tricks to keep your
searches accurate. You could also refer to
books and Web sites that provide an
insight into searching Google—such as the
book ‘Google Hacks 100 Industrial Strength
Tips and Tricks’  that has been reviewed in
the Off the Shelf section this month.

AAYUSH IYER (aayush_iyer@thinkdigit.com)

SAURABH KUMAR(saurabh_kuma@thinkdigit.com)
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Google has a great sense of humour.
Check out the links below and see just
how good they are at making you smile.

Want to know more about Google
Technology? Check out PigeonRank
(www.google.com/technology/pigeon-
rank.html) and MentalPlex (www.google.
com/mentalplex/MPfaq.html). These are
two revolutionary algorithms used by
Google to sort sites in order of rele-
vance. And make sure you tell us what
you think of it!

Also, Google has a long list of logos
that commemorate special occasions.
Check them out at www.google.com/holi-
daylogos.html

And finally, make sure you see Google
Zeitgeist. It has various statistics of
Google users and their searches.
www.google.com/ press/zeitgeist.html

If you’re feeling really adventurous,
check out www.elgoog.com. See results
in a Google mirror... Literally! 

Have fun with Google

Using Google by e-mail, you can have your
search results delivered to you by e-mail

1/2 H AD
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3:30 am. Your eyes meet the piercing
gaze of the boss. You need to come
up with that one liner ASAP, or

waltz your job away. An entire day’s
brainstorming with your freelancing
friend has yielded nothing... And then,
ping! He screams a bright idea to your
desktop. Eureka! It’s a clincher! The boss’s
gaze gets friendlier, and you, in turn, gra-
tuitously doff your hat to your friend...
sitting back in the US, and of course,
Yahoo! Messenger.

Instant Messengers have been around
for quite a while. A few years ago, some-
one came up with this brilliant idea that
has made it easy for all surfers to commu-
nicate directly with each other. Today, a
huge chunk of online traffic is peer-to-
peer, i.e. directly from one person’s com-
puter, to another person’s computer. And
we are not just talking about the Napster

clones either. A lot of the traffic is actual
communication between real people—be
it sharing of ideas, conducting business,
or simply staying in touch with mom and
dad back home. It’s all happening online,
and in real time.

The first tool—I Seek You (ICQ)—was
developed by three Israelis, in late 1996.
Its core functionality is instant messaging
(IM), that refers to short text messages,
delivered ‘instantly’ to a user online. Sim-
ply download the software, install it, reg-
ister, add your friends to your contact list,
and exchange instant messages with
them, whenever any of them come
online.

Metcalfe’s law states that the value of
a network grows as the square of the num-
ber of users. Imagine if only you and three
other people in the world had phones.
This would make your phone practically
useless. But as the network grows, so does
its value. But because all your friends have
phones, you can communicate with the
person you want to, when you want to.
Today IM is a rage, its users having grown
to several millions worldwide—faster than
fax, e-mail, cell phones, or the Web. So,

the more of your friends and contacts that
are online, the more useful the communi-
cation tool becomes. Unfortunately, there
are several competing standards for com-
munication. Currently, each IM user can
only communicate with users of the same
IM. This effectively reduces the number of
people, and consequently, the value of
your network. For a casual user, the choice
of network depends largely upon how
many of your friends and contacts are on
a particular network. Some users, are
happy running multiple IM clients to have
maximum connectivity.

Users see the benefits of IM every day,
and large companies have been looking
to gain a foothold over the IM market for
some time now. There are four big play-
ers in the IM space today—ICQ,
Microsoft’s MSN Messenger, Yahoo! Mes-
senger, and AOL’s Instant Messenger
(AIM). MSN grew in popularity because
of its simplicity and its tight integration
with its ubiquitous Hotmail service. Sim-
ilarly, Yahoo! and AIM have capitalised
on their strong user base, to enhance
their popularity. Groups of friends, or
office departments, generally like to use
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Find it on the Mindware CD 
ICQ Pro 2003a
Yahoo! Messenger 5.6
MSN Messenger 5.0
Trillian 0.74

Instant Messengers are not just for idle chatter, they can also benefit your business!

PHOTOGRAPH: Mexy Xavier,  IMAGING: Solomon Lewis
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one IM that the entire group uses to
remain connected. Interoperability, or
better still, a common standard, would
greatly increase the value of the entire IM
community, making the whole greater
than the sum of its parts, so to speak.

One of the key benefits of online com-
munication is presence. The fact that you
can see the status of your contacts online
lets you know whether they are con-
tactable, and if they are, the effort required
to contact them is minimal. This ease of
use, combined with the impersonality of
text messaging, tends to remove inhibi-
tions and formalities, and allows for a
more open and free exchange. Whilst
presence is cool for your friends, it’s a valu-
able asset for any business. Within the
organization, a lot of time is saved because
employees don’t have to walk across to
another department to ask a question, or
dial an extension to find the concerned
person not at her desk.

Accessibility to your clients is also
greatly increased. How, you ask? It is truly
impractical to have every client on your
ICQ, or MSN contact list. So, what you
can do is use one of ICQ’s free services
that run off your Web site. The most basic
of these is the Online Status indicator
that tells your visitors whether you are
online, or offline. If you add your ICQ
number, they can put you on their con-
tact list, and you can begin conversing to
solve the client’s problem, or answer 
a query. Yahoo! Messenger users can 
also add their online status to their 
Web pages.

Every Web site has a page with con-
tact details so that the creator,
or company, can be contacted.
This page can contain your
online status along with a link,
to take the visitor to your Uni-
fied  Messaging Center on ICQ's
servers (http://www.icq.com/ICQ#),
from where the visitor will find
several ways to contact you
immediately—you can be con-
tacted directly on ICQ, the visi-
tor can add you to their contact list, or
you can even be contacted on your
mobile phone via SMS. Providing such a
service will be a big boost to your busi-
ness. Just imagine someone visiting your
Web site and not buying something
because he is sceptical, or needs some
more information about the product. The
ability to communicate with clients lets

you answer queries, and convince them
of your product. Though this has not yet
been quantified, IM within the organisa-
tion can improve productivity. 

There are some problems with IM in
the office environment though. By far, the
largest concern is security. Consumer IM
applications send plain text messages, and
are very vulnerable to eavesdropping. If
IM is to become a viable communication
medium in the corporate world, this issue
must be addressed. When messages go out
of the local network and onto the Inter-
net, they open up security holes in the
firewall—opening it to attack. These con-
cerns can be addressed by deploying a

company-wide standard, secure
IM. Yahoo offers a secure IM,
called Yahoo! Messenger Enter-
prise Edition. It has all the fea-
tures of the standard Yahoo!
Messenger, and boasts of addi-
tional ones that are targeted at
the managed business network
such as 128-bit encrypted mes-
saging, integrated logging and
archiving of messages, local

administrative control, authentication
against the company’s corporate directory,
and screen names using the employee’s
existing e-mail address.

Another problem is that IMs lend
themselves nicely to purposes other than
official business. Chatting with friends
outside the organisation about yester-
day’s cricket match would be a waste of

If you have friends on more than one of
the IM networks, and currently shuffle
between clients to chat with them, 
consider a unified messaging client. 
Trillian is an all-in-one messenger, which
supports ICQ, MSN, AIM and Yahoo!, with
a sleek skinable interface. You will need to
register with those networks before you
can use any of them with Trillian.

IDC expects
there will be
506 million IM
users by 2006,
of which, near-
ly half will be
business users

Adding a status indicator to your Web site
involves adding some HTML code into the
Web pages where you want your status
displayed.

ICQ’s basic status indicator does not
link back to anything, so you can do two
things to get surfers to reach you when
you’re online. The first is to write your
ICQ number beside the status indicator,
so that they can add you to their contact
list. The other way is to make the status
indicator link back to your Unified Mes-
saging Center on ICQ's Web site. The
sample code below does both of these.
Don't forget to replace ‘your_icq_number’
in all three places.

<a
href="http://www.icq.com/'your_icq_num-
ber'">

<img
src="http://web.icq.com/whitepages/online?ic

q='your_icq_number'&img=21" bor-
der=0></a><BR>
ICQ# ‘your_icq_number'

Visit http://www.icq.com/features 
/web/ indicator.html for more styles of
indicators. If users can’t see your online
status go to Main > Security & Privacy Per-
missions > General, and click the Web
Aware checkbox.

Yahoo  makes better use of the status
indicator by linking to a page that lets your
visitor send you a message and even get a
reply though a Web-based Java version of
Yahoo! Messenger. However, it’s in the
early stages, and should get better sooner
than later. You should also add your Yahoo!
e-mail ID, just in case. Again, replace
your_yahoo_id in all three places in the

code given below.
<a

href="http://edit.yahoo.com/config/send_web
mesg?.target='your_yahoo_id'&.src=pg">

<img border=0
src="http://opi.yahoo.com/online?u='your_ya
hoo_id'&m=g&t=2"></a><br>

Contact me on
'your_yahoo_id'@yahoo.com

What about MSN? Microsoft does not
provide any way of putting your status on
your Web site. You could try a free service
that offers to do so at
www.onlinestatus.org. They have a few
servers running, but the code on your Web
page can only link to any one of them.
When that server goes down, so does the
status indicator.

Status Indicators - ICQ & Yahoo

Trillian
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company resources. Banning their use
completely is a shortsighted solution,
which ignores their potential contribu-
tion to the company. Organisations must
develop their own policies for IM usage
within the company. Besides, whilst
implementing business grade IMs, a cor-
porate policy must be in place to deter-
mine the nature of their use. Monitoring
usage is the proverbial hot-potato—with
CIOs wanting to know exactly what their
employees are up to, and privacy advo-
cates crying foul. Some companies
already archive e-mails to monitor leak-
age of sensitive data. One can only
assume that, as IMs becomes more per-
vasive, a similar system will be imple-
mented for it too.

Besides, for text messaging, today’s
IM clients provide the basis for much
richer forms of communication. Voice,
and even video, can be carried over the
same networks that carry text. Consumer
IMs integrate all the facilities you need,
into the clients. Once your audio is prop-
erly set up, starting a voice conversation
with anyone on your contact list is just a
couple of clicks away. The same can be
said about video, assuming that both par-
ties have Web cams.

Long distance calls, even to regular
phones, are now being made through
the Internet because of the cost advan-
tage it enjoys. Calls through the Net,
made using the services of Indian
providers such as Phonewala.com, costs
about Rs 5 per minute. International
providers are even cheaper. These calls
work on a technology called Voice over
IP (VoIP). Simply put, the voice is encod-

ed and compressed, then sent over the
Internet as data packets—just like regu-
lar Internet traffic would be—and are
decoded back to audio at the other end.
It takes a lot of data to transfer very lit-
tle audio. This means that the demands
placed on the network are relatively
high, often leading to poor quality of
service. This network limitation usually
exists at the so-called last mile, i.e, the
connection between the home or office
and the ISP. Connections between the
phone provider’s servers the world over,
are generally speedy enough not to be
an issue.

Here’s an idea to solve the last mile
link problem, and eliminate the PC in
the bargain. Users can call the phone
provider’s server directly using his 
standard phone. This keeps the voice 
as voice, until it reaches the server. 
The voice is then encoded and decoded
at the servers, and transferred between
them over the Internet at high speeds,
providing much better voice clarity, 
and less delay.

We have already seen the integration
of MSN messenger into Windows XP in
the form of Windows Messenger. The
next logical evolution is the integration
of communication tools within our appli-
cations, allowing for better collaboration.
Microsoft will soon release its own enter-
prise-grade IM server that will be brand-
ed as part of the office suite. Office Real-
Time Communications Server 2003 (RTC)
will be part of Microsoft’s Office system
of programs, servers and services. RTC is
a server, which allows organization users
to communicate in real time over man-
aged networks, securely. RTC will also be
extensible, allowing developers to inte-
grate real time communication into their
own applications. Microsoft touts the
benefits of integration with other office

apps as ‘collaboration in context’, which
reduces decision-making time, and
increases efficiency. For example, when
you’re reading an e-mail in Outlook, you
will be able to see if the sender is online,
and initiate an IM conversation. The IM
conversation may resolve the issue, or
turn out to be more efficient than the
usual process of mailing a reply, and then
waiting for a response. Another place
where the integration will be evident is
the new SharePoint Portal Server. Using
SharePoint, companies can make their
own portals for their organization, or
each departmental team may have their
own portal.

One thing is certain about the future.
More and more communication will hap-
pen over the Internet. Time and time
again, it has proven to be endlessly exten-
sible, adapting to future requirements,
and taking on new roles with increasing
bandwidths. Text, voice, video and data
all help us do business faster and bring us
closer together—all thanks to the wonder
that is the World Wide Web.

KAIZAD VAJIFDAR (kaizad_vajifdar@thinkdigit.com)

ICQ offers several types of web panels,
each with its own unique functionality.
Choose one that offers all the functionali-
ty that you need without blocking up too
much of your Web page. Check them
out, and get the code to insert them into
your page at http://www.icq.com/panels/.

Unified messaging centre

Using IMs, you can now initiate a voice
conversation with your pal. The Audio
Setup feature, present in most IMs,
checks the audio peripherals, and analy-
ses the quality of sound received, and
transmitted. 
Yahoo!
The first time you attempt to make a call
in Yahoo! Messenger, it will automatically
launch the Audio Setup Wizard. To do
this, go to Tools > Call… Follow the
instructions on screen, to complete the
setup. The wizard even sets up echo
reduction, and tests your connection’s
quality. After the wizard completes, it
takes you to the phone interface, from
where you can make long distance calls
via Net2Phone's service. To have a voice
chat with others on your contact list, dou-
ble-click their name, and click the Voice
icon, which is just below the menu bar.
MSN
MSN Messenger also launches its own
Audio Tuning Wizard when you first try to
have a voice conversation with any of
your contacts. To initiate it, right-click on
a contact, and from the menu, select
‘Start an Audio Conversation’. Follow the
steps to complete the tuning.

Audio Setup

ICQ Web-Pager Panel lets your site’s visitors
send messages straight to your ICQ. 

Yahoo! Messenger Enterprise Edition has
‘professional’ written all over it



Meet Jack and Jill—two hardcore
gamers in town. Between them,
Jack lives in the gaming world

and plays his PS2. As for Jill, the poor
thing is still deciding the best upgrade for
her PC—a thing that is never on Jack’s
mind. Her father is on the verge of filing
a lawsuit against a company that releas-
es a new product every six months. 

Agreed, the gaming console-versus-
PC argument is getting pretty old but
that’s not the bone of contention here.
Instead, by comparing the architectures
of consoles and PCs, we can understand
the difference between them. It will also
help in understanding the requirements
of not just games, but all 3D applications. 

Design of the consoles
In the gaming arena, there is a sense of
superiority when a gaming console is
compared to a PC. It is difficult to believe
that a gaming console that was designed

a couple of years ago, outperforms a PC
that has a six-month product cycle. The
fact remains that gaming consoles are
better designed to handle the require-
ments of a gamer. It is actually a case of
generalisation against specialisation.  

The problem lies at the foundation of
the design; the PC is designed for gener-
al purpose computing from the ground
up. On the top there is some make up in
the form of a GPU (sorry nVidia) and
some buzzwords such as MMX, 3DNow,
etc. Also, the PC platform is a perfect
place for studying chaos theory. There are
hundreds of manufacturers for the same
number of components that make a PC.
This throws up numerous restrictions—
the video card manufacturer has to keep
in mind the design of the motherboard,
drivers may develop incompatibility with
a specific component, etc. But a gaming
console is developed for the sole purpose
of playing games, and nothing else. 

Another factor is that multimedia
components have different processing
requirements as compared to normal
applications, such as office suites. In gen-
eral-purpose software, different instruc-
tions are applied over localised data. In
the case of a multimedia application, the
reverse holds true. A set of instructions is
repeatedly applied over large amounts of
data—for example, the instructions for
decoding an MP3 will be repeated over
an entire file.

What do they actually do?
Good question. Let’s look at the steps
that are followed inside these boxes
before they create those stunning visuals.
In any 3D application, the first step is the
creation of objects in a virtual 3D world.
This step is called the geometry stage,
where the objects and their positions are
calculated. The output of this stage is
what is called a ‘display list’. This is a
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series of commands and argu-
ments that will be used in the
next stage. The CPU, or the
main processor, undertakes the
task of creating the display list.
In this stage, the CPU has to
bring the required data closer to
it, by moving it from the main
memory to the cache memory.

The second stage is the con-
version of the 3D scene to a 2D
bitmap image. This is what
video cards or GPUs are
designed to do. Generally, this
stage is referred to as rendering.
Executing the display list creates
the 2D bitmap image. The dis-
play list will contain tasks such
as drawing lines and polygons,
and giving textures and light-
ing. During this stage the GPU should be
able to easily access the required data. 

The final stage is the one that
involves the least computation. Data is
fetched from the frame buffer in a digital
format, and converted into analog sig-
nals. These analog signals are sent to the
monitor, which displays what you call
‘stunning visuals’.

The consoles currently dominating
the market are the Sony PS2, Microsoft
XBox and Nintendo GameCube. Here, we
shall take a look at the first two. Read on
to find out how they work.

PLAYSTATION 2: The almighty
The gaming console market is dominated
by the PS2 to such an extent, that it has
become the gamer’s mantra. Sony recent-
ly unveiled their upgraded PS2, the PSX
with additional features, aiming at mak-
ing it a complete entertainment
box. As with other gaming con-
soles, the designers of the PS2
had the luxury of building a sys-
tem exclusively for gaming. The
heart of the PS2 is the now
famous 'Emotion Engine',
which was jointly developed by
Sony and Toshiba. 

For all its boasts, the archi-
tecture of the PS2 is pretty sim-
ple. Little do people realise that
it is a perfect example of KISS
(Keep it Simple, Stupid). The main com-
ponents of the PS2, in order of impor-
tance are, the Emotion Engine, Graphics
Synthesizer, Sound Processor and I/O
Processor. Let’s look at the simplest one
first. The I/O processor (IOP) handles all
the requests from the outside world.

When the controller gives an input, the
IOP sends it to the Emotion Engine, so
that an update is made to the state of the
game. The IOP is also responsible for
running earlier PlayStation games. The
sound processor is capable of producing
CD quality audio to support the visuals.
It supports formats such as AC3 and
DTS—something that would be expected
from a device of its class. 

Coming to the serious stuff, the Emo-
tion Engine has a 300 MHz MIPS III CPU
as the core. Actually, the Emotion Engine
comprises of many components, the
important ones being a MIPS III CPU
core, a FPU (Floating Point Unit), two
vector units—VU0 and VU1, and a
Graphics Interface Unit (GIF). These com-
ponents are well connected. This is where
PS2 scores over the rest of the pack. It has
two advantages, namely bandwidth and

strategically placed cache
memory. The components of
the Emotion Engine are con-
nected to each other via a
128-bit bus. This is some-
thing unheard of in a PC. The
reason why the bus width
cannot be increased easily in
a PC is that it has to maintain
compatibility with existing
applications. Increasing the
speed will not affect legacy
applications, but changing

the bus width will.
The next difference is the cache

memory. The sole purpose of the cache
memory is to keep important data close
at hand while processing. Hence, what
matters more is the location of the cache
memory, not just its size. The actual oper-

ations performed by the Emotion Engine
depend upon the application. For exam-
ple, in the case of a FPS game it has to
execute the AI program for the enemy. In
general, it deals with the behaviour of the
game, such as AI and physics. But the
ultimate output of the Emotion Engine is
the display list.

The CPU teams up with the FPU and
VU0, while the VU1 teams up with the
Graphics Synthesizer (GS), through the
GIF. The programmer decides the task
assigned to these teams. They can be
made to work in parallel and send the
display list to the GIF together. Alterna-
tively, the CPU group can be made to do
some processing and send the result to
the VU1, which will use the input and do
some further processing and finally send
the display list to the GIF. This parallel or
serial option gives a lot of flexibility to
the programmer.

The CPU has 16 KB of SPRAM
(Scratch Pad RAM); this SPRAM can be
used by the VU0 also. This piece of mem-
ory allows the CPU and VU0 to collabo-
rate together. A 128-bit bus connects
them to each other. Most of the time, the
FPU and the VU0 act as co-processors to
the MIPS CPU, but can be programmed to
work separately. The VU0 performs oper-
ations such as floating-point divide,
square root and inverse square root. The
bulk of the processing that goes into 3D
games involves doing a lot of these oper-
ations.

The VU1 acts more like a geometry
processor for the GS. Since this involves
more floating point calculations, it packs
extra processing power and memory to
do the same. Unlike the CPU team, where

The PS 2 Architecture

To put an end
to finagling of

the PS2 in India,
Sony has
announced that it
would soon be
launching the
console in our
country.
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the CPU can control the other two com-
ponents, the VU1 and GS are equals, and
communicate through the GIF. As men-
tioned above, the VU1 keeps generating
the display list and the GS turns them
into bitmap images. The GS has a 150
MHz core with 16 pixel pipelines. Using
these pipelines, it can churn out 75 mil-
lion polygons and 2.4 billion pixels per
second. Compared to current GPUs, such
as the GeForce FX, this may seem mea-
gre, but considering that the PS2 was
released in 2000, this is impressive.

No doubt, the PS2 is a powerful
machine, but it may not be better than
the latest PC, thanks to companies such
as Intel and nVidia. However, it is still a
good buy.

XBox: The black beauty
Keeping up with its tradition of entering
every relevant market, Microsoft
entered the gaming arena with its
famous XBox in 2001. The console
is made of PC components such as
a Pentium III 733Mhz (Copper-
mine), nForce chipset-based moth-
erboard, 64 MB DDR RAM, 8 GB
hard disk, a DVD drive, and runs
on a stripped down version of
Windows 2000. But that is where
the similarity between a PC and
the XBox ends. There is a tighter
integration between these compo-
nents that enables it to outper-
form a PC. Strictly speaking, the
components are not exactly the
same as PC components. Let’s take
a look at each of the components
in detail.

The Coppermine processor comes
with a 128 KB L2 cache memory.
Although this makes it look like a
Celeron, it’s definitely not one. This is
because the Coppermine core here has an
8-way set associative cache rather than
the 4-way cache found in the Celeron.
This makes it a Pentium III with half of
its cache disabled. But the lingering ques-
tion is, in the days of gigahertz wars, how
does a 733 MHz processor compete? The
answer to that is simple—even this much
processing power is not required, at least
for now. 

The graphics solution provided by
nVidia is similar to its nForce chipset
with minor variations. Like the nForce,
the XBox has the Integrated Graphics
Processor (IGP) as the northbridge. The
IGP acts as both the northbridge and the
GPU. The difference is that the nForce

has a Geforce 2MX (NV11) class GPU,
and the XBox has an NV2A core. The
NV2A is something that lies between the
GeForce 3 (NV20) and the GeForce 4
(NV25). It takes care of all the graphics
processing; it provides hardware trans-
form and lighting (T&L), something
which the PS2 sorely lacks. In fact, the
GS of the PS2 is much inferior to the
NV2A, which has two Vertex Shaders—a
huge benefit because a Vertex Shader is
used heavily by current generation
games. The strength of the GS lies in its
parallel computation power and not in
the functions that it provides. Like the
GS, the NV2A takes care of all the graph-
ics processing. So the CPU is left with AI,
physics and managing the connection
between individual elements, such as the
hard disk. For performing these functions
a Coppermine is overpowered as all the

games are rendered at a resolution of 640
x 480 x 32, which is sufficient for NTSC
television. XBox also supports HDTV out-
put, for which a Conexant video encoder
chip increases the basic resolution.

The southbridge is the Media & Com-
munications Processor (MCP), which
provides the audio solution. An interest-
ing point is that a HyperTransport bus,
which is used by AMD, connects the
MCP and IGP. Audio is another area
where the XBox is much better than the
PS2. The MCP provides a Dolby Digital
5.1 audio output, compared to the stereo
output of the PS2. This is a very impor-
tant feature, as many games support this
surround sound format. The MCP also
offers a 10/100 Ethernet controller,
which allows multiple Xbox consoles to
be interconnected.  

Another reason the XBox produces
stunning visuals is that developers heav-

ily optimise the games for it. This is due
to the fact that the system is not going to
change, unlike a PC. While programming
for the PC, no sane developer will devel-
op a game that will run only on a top-of-
the-line system. Any game that is
released, now will be programmed to run
on any card, ranging from a lower end
graphics card, such as the GeForce 2 class,
to the latest cards such as the Radeon
9800. This prevents the developer from
optimising the game for a specific sys-
tem. Also, unlike the PS2, the XBox is
closely related to the PC, which makes it
a friendly turf for PC game developers. 

The end and future…XBox 2, PS 3
Microsoft and Sony are busy gearing up
their warriors for the future. Not much is
known about the XBox 2. After specula-
tions that Microsoft has opted for ATi,

there is a new round of rumours
that Microsoft may design the
processors on its own—it has
apparently licensed some SGI
patents. This would enable the
company to strategically price the
XBox 2. Also, the CPU for the XBox
2 is rumoured to have the ability to
decode and execute instructions in
Microsoft Intermediate Language
(MSIL)—an integral part of .Net,
while being compatible with Xbox
at the same time.

Now, coming to Sony, the
word that comes to everyone’s
mind when the subject of PS3 is
brought up is the ‘Cell’. Dubbed as
a supercomputer on a chip, the

Cell is the microprocessor that will power
PS3 when it comes out, some time in
2005. Sony, Toshiba and IBM are devel-
oping it jointly. It will be fabricated using
the 0.10-micron silicon-on-insulator
(SOI) process technology. The PS3 will
also make use of Grid computing. Grid
computing is a variation of distributed
computing, and presumably involves
networked game machines sharing soft-
ware, processing power and data.

On the whole, gaming consoles are
the better option in the long run. After
all, they are designed for gaming right
from scratch. This has helped the indus-
try understand the basic requirements of
3D and multimedia applications. With-
out a doubt, this will affect the designs of
PCs in the future and make them gamer
friendly.

MOULY ARUN PRABHU

(mouly_arunprabhu@thinkdigit.com)

Take a peek under the hood of XBox
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Windows XP is known for its
beautiful new interface, cou-
pled with the stability of Win-

dows 2000. The only problem is, there are
some chinks you may want to iron out.
XP comes with a whole bunch of in-built
applications that are really useful if you
want to run a server or some database
applications. The problem is that these
applications all seem to start simultane-
ously, whether you need them or not, and
use up precious system resources. The fol-
lowing is a guide to making XP work for

you, without killing your resources. 
The most effective way to disable serv-

ices is by running the Windows Manage-
ment Interface. Access it through either
Control Panel > Administrative Tools > Ser-
vices or go to Start > Run, type services.msc
and press [Enter]. A window pops up that
displays all the services, their descriptions
and status—whether currently running or
not. From here you can start, stop, pause,
resume, or restart a service. 

In the table below, we have provided
the configuration settings for three types

of PCs—Safe, Internet Gateway and
Gaming. Those who want the maxi-
mum out of their system for games,
should set the services according to
the Gaming Configuration. And PCs
used as Servers or Internet Gateways
should use the list specified in the
Internet Gateways configuration. The
Safe configuration, is for those para-
noid about security.

To disable services from here, just
right-click a service and choose proper-
ties. Now, go to the list box named

‘startup type’. Select whichever of the three
options (automatic, manual and disabled)
is applicable.

Disabling most remote services will
not only increase your PC speed, but also
improve your security. For example, make
sure to disable the Remote Registry Ser-
vice, which basically allows your registry
to be edited from a remote location—apart
from the security risks, you’re probably
never going to want to edit your registry
over the Internet anyway. 

If you feel that you don’t know
whether you require this service or not
just set it to ‘manual’ run. This way, Win-
dows will not load it at startup, only when
it is required. Finally, be careful about
selecting from the services listed above,
and remember to restart your PC after
making the changes. You can now enjoy
a faster and less resource hungry XP.

NIKETU SHAH (niketu_shah@thinkdigit.com)

Faster, Safer Windows XP

Services.msc lets you to tweak Windows XP

There may be services which may or may
not be installed on your PC depending
on whether it’s Windows XP Home, or
Windows XP Professional. Also, if it came
pre-installed by your vendor, he may not
have installed any or many of them. For
more information visit
www.blackviper.com

Note

Disable services by right-clicking on them from
the services.msc box

The following is a list of those services available in Windows XP:

Display Name

Application Layer Gateway Service
Automatic Updates
Computer Browser
Error Reporting Service
Help and Support
Indexing Service
Logical Disk Manager
Network Location Awareness (NLA)
Performance Logs and Alerts
Portable Media Serial Number
Remote Access Auto Connection Manager
Remote Access Connection Manager
Remote Desktop Help Session Manager
Remote Procedure Call (RPC) Locator
Remote Registry Service
Routing and Remote Access
Server
Smart Card
System Restore Service
Task Scheduler
WMI Performance Adapter

Safe

Manual
Manual
Disabled
Disabled
Disabled
Disabled
Manual
Manual
Disabled
Disabled
Manual
Manual
Disabled
Manual
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Internet 
Gateway
Automatic
Automatic
Automatic
Disabled
Disabled
Disabled
Manual
Automatic
Disabled
Disabled
Automatic
Automatic
Disabled
Manual
Disabled
Disabled
Automatic
Disabled
Disabled
Disabled
Disabled

Gaming

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Manual
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Watch my PDA
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Far from being a numbing
procedure, installing Linux is
easy, user friendly, and
completely reversible. Safe
installation guaranteed!

There are some things that money
can’t buy and there are some
things that money need not buy.

With the open source movement gaining
momentum, you are no longer forced to
buy the basic software such as an operat-
ing system for your computer. The flag-
ship product of the open source move-
ment—Linux—has gained a lot of recog-
nition in recent times. 

This workshop will be your friendly
guide to a beautiful place called Linux. If
you are not happy with the change, or for
any reason you want to revert your system

to the current state, don’t worry. This is a
perfectly reversible process. If you are a
Linux geek, this is where you get off; this
article is meant for Linux newbies. 

Here’s what you need before you can
start off. First and foremost, you’ll need
the Linux distribution. In this workshop,
we shall use Red Hat Linux 9. The distri-
bution can be found in the accompany-
ing DVD. You will find the images of the
three CDs that are required for the basic
installation. Burn the CDs and your Linux
distribution is ready. Make any number of
copies and distribute them. You will not
be breaking any laws.

Preparation for Installation
Defragment your hard disk and check for
any errors using scan disk. Make sure you
do this as this ensures that free space is

clubbed together. Then, select the parti-
tion where you want to install Linux. It is
recommended that you allocate at least 4
GB of hard disk space albeit the bare min-
imum is 450 MB. You can resize an exist-
ing partition to create a room for
installing Linux or you can allot an entire
existing partition.

If you want to resize an existing
free partition, use the partition

resizer tool. It can be found in the Mind-
ware CD.  It is recommended that you
copy the program to a boot floppy, boot
into the system using it and run the pro-
gram. It has a very friendly interface. First,
select the resize/move option. Then select
the partition to be resized; the program
will indicate resizable partitions, using the
* symbol. After selecting, you can resize
the partition; the program will indicate

Find them on the Mindware CD 
Ranish Partition Manager Beta
2.43
Partition Resizer 1.3.4

ILLUSTRATION: Solomon Lewis
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the size of the resized partition and not
the free space. So, make sure that you have
resized correctly. Confirm the operation
and reboot the system after it is complet-
ed. Run scandisk on the resized partition. 

To remove an existing Windows
partition and install Linux in it,

make sure that no data is present in the
partition. Copy its contents to another
partition.

Installation
You have to start the installation by boot-
ing from the CD-ROM drive. To do so,
make sure that the first boot option is set
as CD-ROM. You can check this in the
BIOS setup. Insert the first CD and restart
the computer. You will be presented with
a text-based menu. From here, follow
these steps.

Press enter to start the graphical
installation mode. Next, you will

be prompted to test the media. The instal-
lation program will test your media for
any flaws in it. Although you can skip this
step, it is recommended that you check all
the CDs at least once.

Now, you will be presented with
the Welcome Screen. Click next to

enter the language selection step. No
regional languages are supported; the
default would be the language that you
are reading. However, you can install
other languages, if needed. 

Keyboard configuration: Select
‘U.S English’ keyboard. 
Mouse configuration: The instal-
lation program will probe your

mouse and give a default option. If you
are sure of the model of your mouse and
find that it is wrongly listed then change
it. If your mouse is connected to the seri-
al port then make sure that the correct
COM port is selected under device
menu.

Installation type: Here, you can
choose any one of the four

options—personal desktop, workstation,
server and custom installation. Select Per-
sonal desktop. You can always change it
later, after the installation.

Partitioning
This is the mother of all steps. If you com-
plete this step successfully, the rest is a
breeze.

You can choose between ‘Auto-
matically partition’, and ‘Manual-

ly partition with Disk Druid’. The latter is
recommended as it gives you control over
the partitioning. 

In the manual partition method,
you will be presented a screen sim-

ilar to the one shown. The actual screen
will depend on your hard disk.  If you have
resized your partition, skip to the next step.

Otherwise, select the partition on which
you want to install and click delete. If you
are finding it difficult to relate the entries
in the Disk Druid menu to the correspon-
ding Windows partition, then refer to the
box Disk Druid—take it easy.

Select the free partition, and click
New. Now the add partition win-

dow will appear. In the mount point field,
select ‘/’. Select the file system type as
ext3. In the size field, select ‘Fill to maxi-
mum allowable size’. If you get a warning,

click continue. If you happen to make a
mistake in this step, click the Reset but-
ton and start partitioning again.

Now the easier part of installation
After partitioning, the boot loader config-
uration and other configurations have to
be done. Here’s how you do it.

✔ Know your system configuration.
Right-click My Computer and select Proper-
ties to get information about your system.
✔ Check whether all your hardware com-
ponents (especially the video card), are
listed at http://hardware.redhat.com/hcl/.
✔ Find out its horizontal and vertical scan
frequency. You can find it in the manual
that accompanied the monitor.
✔ Make a note of the port your mouse is
connected to—serial, PS2 or USB. If it is
a serial port, find out whether it is COM1
or COM2.
✔ Windows XP users may need the setup
CD if they are going to revert back after
the installation.
✔ If your system is networked, then
you should know the details of the same.
Contact your system administrator for
the details. 
✔ Backup all your important data
✔ Defragment the hard disk

Before you install Linux...
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A Welcome Screen appears after selecting the
graphical installation mode

Change the default option for the mouse
model, if it’s wrongly listed

Choose the type of installation in the screen
shown above 

Manually partition the hard drives using Disk
Druid

Click on the New button in the Disk Druid
menu, to create a new partition 
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Boot loader configuration: Make
sure you have an entry named

DOS in the Label column, if Windows is
installed in your system.  

Network configuration: The
details to be entered depend on

your network. If you have any, contact
your network administrator. 

Firewall configuration: Select
medium. 
Language: English (U.S) 

Time Zone: Asia/Calcutta. 

Enter the root password. All Linux
operating systems will have a

super user with username root. This user
will have full control over the system.
Enter the password and click next. 

If you want to customise the pack-
ages to be installed, select cus-

tomise, else accept current packages and
click next. 

Click next to begin installation.
During installation, you will be

prompted to insert the other two CDs.
The actual time taken for installation will
depend on the system.

In the previous steps, you could click
the back button, and make changes with-
out any difference. But if you click next
after these steps, new partitions will be
created. This is the first change made to
your system.

Post Installation
After the installation is over, you
will be prompted to create a boot

diskette. This is recommended, because
if your boot loader fails or the MBR
gets corrupted, you can boot from
the diskette. 

The next step is the video card
detection. You will be presented

with a list of video cards, with a default
selection. Change it if the default option is
not correct. Your card may be unrecognised
if it is very old or one of  the latest mod-
els—especially the onboard display cards. If
it is unrecognised, then obtain the drivers
from the Internet. For now, skip X server
configuration. Then, you can boot into
command prompt and install the drivers
and X server.

Monitor Configuration: If your
monitor is not in the list, select

Partitions can be troublesome. Thankful-
ly, hard disk partitions are much easier to
create. To understand partitioning, you
have to view the hard disk as a shelf for
keeping books. Each rack is a partition
and each hard disk has a partition table
that keeps a record of the partitions. A
partition table is designed to hold infor-
mation regarding four partitions only. To
over come this limitation, extended par-
titions were developed. They can contain
many sub-partitions within them, which
are called logical partitions. Primary par-
titions are the partitions, that can’t be
sub-divided. Older operating systems
such as Windows 9x, have to be installed
in a primary partition. Thus, the total
number of extended and primary parti-
tions should be four.

Partitions demystified

Choose your  Boot Loader, and ensure that all
the operating systems are present

Enter the Network details in the Network
Configuration screen

Choose the monitor that best matches the one
attached to the PC
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Ensure that the probed video card is correct,
else change it
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unprobed monitor and enter your moni-
tor’s horizontal and vertical sync. 

Select your screen colour depth,
resolution and login type in the

next screen. 
A screen will appear, confirming the

completion of installation. Remove the
CD from the drive and click next. The
system will now be rebooted. The boot
loader will start, and give you two
options—DOS and Linux. Select Linux
to enter the world of Linux.

Un-installing
If at all you need to revert back to the
previous state that your system was in,
follow these steps. First, if you are using
Windows 98:

Go to the command prompt and
clear the MBR by entering fdisk

/mbr in the command prompt. 
Then, to delete the Linux parti-
tions, use Ranish partition man-

ager (found on the Mindware CD). Run
the Ranish partition manager, select the
Linux etx3 partition and delete it. 

Now a free partition will be shown
in the menu. Select this free parti-

tion and start the partition wizard by
pressing the Enter key. 

Select the file system as FAT 32
and leave the size field as it is.

Next, select the ‘Save changes now’
option. In the next menu, select the For-
mat now option, and after that, select the

‘Quick format without surface test’
option. Then, restart the system.

There is no support for fdisk in 
Windows XP.
Hence, to clear
MBR, you have to
boot into the sys-
tem using 
the Recovery Con-
sole. The recovery
console is a com-
mand line-based
d i a g n o s t i c  
tool. It has many
features such as
enabling and dis-
abling services,
format drives, etc.
You must be an
administrator to
use the Recovery
Console. Follow
these steps to
restore your Win-
dows XP system.

You can
install it

from the Windows
XP setup CD by
typing {X}:\i386\
winnt32.exe /cmd-
cons in the Run
dialog box, where
{X} is your CD
drive letter. 

Restart the system and select DOS
from the boot loader options.

Now, you will be presented with a menu
that has two options—Windows XP and
Widows recovery console. Select the latter. 

If you have more than one ver-
sion of Windows installed, you

will be presented a menu of these. Then,
select the Windows version where XP is
installed, and clear the mbr by giving the
fixmbr command at the prompt. 

To remove the Linux partitions,
boot into Windows, right-click

My Computer and click on Manage. In
the left side pane, select Disk manage-
ment. On the right side, the systems view
of the disk will be shown. Here, the Linux
partition will be shown as an unrecog-
nised partition that you need to delete.

The system will now show an
unused partition. Select the parti-

tion and right-click it. From the menu,
select create logical partition and then
choose the file system and size. Now the
system is back to normal.

That leaves your system in its original
state.

MOULY ARUN PRABHU

(mouly_arunprabhu@jasubhai.com)

After you have selected the Windows par-
tition for installing Linux, you have to
identify the respective partition in the
Disk Druid menu. If your hard disk is con-
nected as a Primary Master, it will be
shown as hda, and a primary slave will be
shown as hdb. Similarly, hdc and hdd will
be shown for secondary master and slave
respectively. Further, the first primary par-
tition of the hard disk will be shown as
hda1 and the next primary or extended
partition will be shown as hda2 and so
on. The Windows partition—the C drive,
usually would be the first entry in this
menu. Subsequent drives can be mapped
to the next entry. For example, the D
drive would be second entry, followed by
the E drive and so on. But you have to
ignore the entry for extended partition, as
it is only a combination of the logical par-
titions under it. 

Please note this will not be applicable

if your system has more than one hard
disks and it runs on Windows 9x. This is
because Windows 9x lists all the primary
partitions before listing the logical parti-
tions. You can check the number of hard
disks and primary partitions your system
has using fdisk. After starting fdisk, you
will be presented with a menu having
options to display the partition informa-
tion and to change the current disk,
among others. Note that the option to
change the current disk will be shown
only if you have more than one hard disk.
Select the choice to display the partition
information for the current disk. It will
show all the partitions along with their
details such as type, size, usage, etc.
Then, change your current disk and dis-
play each partition’s information.Using
this information, you can now relate the
Windows partitions to the ones men-
tioned in the Disk Druid menu.

Disk Druid—take it easy
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Computers can be used to talk to
each other by connecting them
wirelessly, using the latest Wi-Fi

access points and adapters. Connecting
machines situated on different floors,
or in rooms several metres apart, will
require long cables and a few hundred
holes drilled all over the place. With
wireless connectivity no drilling of
holes or investment in cables is
required—just plug the hardware into the
PC and connect.

We decided to experiment with wire-
less connectivity, and that too with the
cheapest ingredients—D-Link’s DW-
900AP+ access point, a DWL-650+ PCM-
CIA card for the laptop and a DWL-520+
PCI-based card for our desktop PC. These
components are also capable of securing
home users sufficiently.

We considered a typical office envi-
ronment, where a wired LAN exists but a
few people want to have the freedom and
portability that wireless offers. Thus, a
hybrid LAN is formed, with some com-
puters connecting with normal ethernet
cards, and a few connecting with wireless

adapters. In order to get seamless con-
nectivity within the hybrid LAN, an
interface between the wired and wireless
LAN is required. This is where the Access
Point comes in.

In order to achieve this real world
scenario in out test centre, we connected
two desktop PCs, one called ‘master’, the
other called ‘client’, and a laptop. The
access point and PCI and PCMCIA inter-
face adapters will take care of the Wi-Fi.
The master PC had a built-in LAN card,
and a modem provided Internet access.
We used Internet connection sharing
software (WinGate or WinProxy5), to
enable the client to access the Internet
via the master.

In all, we needed an access point and
wireless adapters. If we consider the cur-
rent price of the D-Link Access Point, and
PCI and PCMCIA-based adapters, then
the total solution cost us approximately
Rs 18,400. This amount appears pretty
high as compared to a wired LAN, but is
a boon for small businesses which oper-
ate from rented offices—especially if they
are not allowed to alter the interior in

any way, such as drilling holes. Not only
is it convenient to set up, it’s also very
simple to move to a different location.

If you’re looking to connect five or
ten PCs on the same floor, and are will-
ing to go through the hassles of net-
working them, then wired LAN is the
cheaper option. But, if you want to have
the latest technology, with a system 
that most 15-year olds could set up, 
and also have an aesthetically pleasant
look to your office, then wireless is 
the way to go. 

Set up and configuration
Setting up a Wireless LAN (WLAN) is 
really easy. However, depending on your
network type, the requirements change.
There are two ways to go about this,
either you have a purely wireless LAN,
where every computer is freely portable,
or you share a LAN with wired computers,
in a hybrid of wired and wireless LAN. 

To configure a purely wireless net-
work, you need to install the cards and
configure them to run in Ad-Hoc mode,
which can be done from the network
connection wizard in Windows XP or

the utility bundled
with the Adapter card.
Now, install a proxy server
on the computer with the
Internet connection (master)
and set the others to access the Net
through it. That’s it; your network is up
and running.

However, a word of caution; when
buying wireless hardware, make sure they
are compatible—802.11b (Wi-Fi) will not
work with 802.11a/g hardware. Also,
wireless equipment from different ven-
dors may or may not work together. Buy

���������� 	
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Wires are a tangly web that can get on anyone’s nerves.
Wireless Networking solves the problem, but like a BMW,
costs more for the comfort it offers

��
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all your wireless hardware from a single
vendor to avoid such problems.

Setting up a hybrid LAN is a tad more
complicated. Follow the steps below to
connect and configure an Access Point to

set up your hybrid LAN:
Connect the Access Point to 
the existing LAN with a normal

RJ45 cable, which costs around Rs 50 
for a 5 meter cable.

Power up the Access Point and
access the built-in Web server

by entering its IP address (for example,
http:// 192.168.0.1) in the browser of
the master system. This will open a
configuration page, from where the the
rest of the Access Point configuration
can be done. 

Click on the Wireless tab. There
are default values assigned to 

various fields. Change the SSID (Service
Set Identification) to something else, such
as ‘home’ or ‘wireless’ and assign a net-
work key. Set it to run in infrastructure
mode and set the WEP (Wireless Equiva-
lent Protocol) to 64-bit from the drop
down menu. The rea-
son for not using 128
or 256-bit WEP
encryption is that
higher settings will
lower the data
throughput because of
greater security checks.
Under the LAN tab,
t h e r e

exists a
default IP and subnet

mask—do not change
this. Click on the
DHCP tab. Here,
enable the DHCP serv-
er and assign a starting
IP (192.168. 0.2) and
ending IP
( 1 9 2 . 1 6 8 . 0 . 2 5 4 )
address for the client
adapter to automati-
cally pick up IPs.
Enable DHCP only if you want the client
PC to get its IP automatically, otherwise
disable the DHCP server and manually
assign the IPs for the client PCs. 

97

The Setup Wizard makes the configuration of
your LAN settings a snap

Configure the clients using the Wireless
Adapter Configuration utility

Can you afford the latest? The cost of setting up 5 PCs on a LAN (in Rs)

Component 100 MBps LAN 11 MBps Wireless hybrid LAN
LAN card 2,500 22,500

Access Point Nil 10,000

Cable 500 Nil

Entry-Level switch 4,000 Nil

Total 7,000 32,500

Access Point: It is a piece of hardware
which connects wireless adapters to a
wired LAN. For home and SoHo (Small
office Home office) networks it is
connected to the LAN card on a PC,
using a cross over cable. 
Wireless Adapter: It is the wireless
replacement for the network interface
(LAN) card—available in the PCI and
PCMCIA interface.
DHCP: Dynamic Host Configuration
Protocol allows the adapters to
automatically pick up IP addresses from
the list defined in the DHCP
configuration on the Access Point. 
SSID: Service Set Identifier is a 32-
character unique identifier attached to
the header of packet transmitted over
wireless LAN. SSID differentiates one
WLAN from another, so that all access
points and devices attempting to
connect to a specific WLAN must use
the same SSID. It is also referred to as a
Network name.

Jargon buster
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PHOTOGRAPH: Mexy Xavier, 
IMAGING: Solomon Lewis
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Now, all you have to do is configure
the clients.

Install the adapter drivers and
then shut down the PC and plug

the adapter card into the PCI/PCMCIA

slot and restart the system. Wait for the
driver to initialise the adapter.

Once the hardware is initialised,
double-click on the adapter card

configuration icon in the system tray.
This will launch the configuration 
utility. Here the user doesn’t have to do 
anything, as most of the settings, includ-
ing SSID and encryption key, are auto-
matically picked up by the adapter card
from the Access Point.

Check the signal strength avail-
able at the place the wireless

desktop or laptop is placed double 
clicking utility resting in the taskbar.

While setting up a wireless network,
it is important to remember to place the
access point carefully, as metal tables,

cupboards, and cabinets filled with
clothes can cause a drop in throughput.
Though a wireless connection is the 
best choice for a multi-storeyed house,
there will be many obstacles, such as
walls, flooring, metal tables and even
microwave ovens, which might lower the
data throughput. To avoid this, move the
access point around to find the best place
where the clients get the maximum 
signal strength. The same process will
have to be repeated for the client 
placement. Once you find the best place
for them, you’re all set to do as you
please in your networked haven.

ALIASGAR PARDAWALA

(aliasgar_pardawala@thinkdigit.com)

AUGUST 2003

Fine tune the quality of your LAN connection
using the Configuration utility

Security is a critical issue with wireless
transmission. As the signal in a WLAN is
freely transmitted in space, anybody in
the vicinity has access to it. This can
include a hacker sitting in a car parked
just outside your home or office. SSID are
used to identify the wireless adapters
installed in a wireless environment, by
access points. The SSID is broadcasted
freely many times by an access point. A
hacker with reasonable experience and
the help of an 802.11 analysis tool, can
sniff the network to get the SSID, and
hence, free access to the home or office
network. Wireless networks can enable
WEP (Wired Equivalent Privacy), a form of
encryption, available in 64, 128 and 256-
bit that will keep amateur hackers away.
However, an experienced  hacker can gain
access by monitoring the data
transmission and decoding the WEP-
encrypted information. WPA (Wireless
Protected Access) a more secure
encryption standard, is in under
development and will be available soon.

Wi-Fi hacker alert
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Set the encryption level as per your network



Only a few computer enthusiasts,
and hobbyists look upon Linux as
an alternative operating system.

However, this scenario has been chang-
ing drastically. Now, ordinary users use
Linux for typical desktop use such as word
processing, making presentations, and lis-
tening to music. This is possible due to
the availability of free as well as commer-
cial office applications for Linux that offer
good compatibility with existing MS
Office files. But, there are times when
something as simple as sharing a file with
your friends across a LAN, or a printer
configuration, can get confusing due to
the lack of any coherent information
source. This workshop helps you get
around those small, irritating hiccups that
stand in the way of using Linux to its
fullest potential.

Use Windows Programs
in Linux with
CrossOver Office

Ever thought how nice it would be if you
could install Microsoft Office in Linux?
Well, here’s your dream come true.
CrossOver Office is a Windows emulator

that installs your favourite Windows pro-
gram, under Linux. This program has an
ever-growing list of supported software.

We installed CrossOver office on Suse
Dektop Linux, by executing a shell script.
This shell executable is located in the
/opt/cxoffice folder. As soon as you 

execute the command: /opt/cxoffice/bin
/crossover.sh, the emulator starts installing.
The script starts uncompressing the 
files, and installing them. During this
process, it asks you to configure the 
proxy settings—since this utility has the
capability to download files from the
Internet, if necessary.

Once the installation of CrossOver
Office is complete, install all your

favourite Windows programs such as
Microsoft Office 2000, IE 5 or 5.5, Photo-
shop 7, Visio 2000, etc. 

As soon as you click on Microsoft
Office 2000, in the CrossOver Office
install window, a new window pops up
where you need to specify the source 
location of the set up files, for example,
/mnt/cdrom, to install the application 
via a CD.

The installation starts just like it
would have on a Windows PC, asking
you the serial key, license agreement,
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Things about
Windows...

...that You’ll Never Miss Again
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Common Windows tasks that you can now do in Linux

Run the crossover.sh script at the prompt to
start the installation

Configure the proxy settings, if you are behind
a firewall

5
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acceptance to typical installation, etc.
Now, you just need to restart the
CrossOver emulator. Once the installa-
tion is completed, you can work with
your most desired Microsoft Office appli-
cations, such as Word and Excel. These
can be accessed by going to Main menu >
Windows Application Menu.

To remove an application, go to Main
menu > CrossOver Office > CrossOver Office
Setup. Select the installed software, and
click on the Remove button to start the
application’s un-installation program.

Access Windows Files
automatically
Most users start with a dual boot

system when they install Linux. Hence,
transferring or accessing files created while
working in Windows is the first problem
faced. For example, you wish to open a
Microsoft Word file from your Windows
partition. Solve this by loading the Win-
dows partition, using the mount com-
mand. To use the mount command, there
are two essential requirements: First, you
should have a local folder where you can
map the Windows partition. And second,
the physical address of the Windows par-
tition. As far as local folder is concerned,
you can create a new folder, called ‘win-

dows’, within the /mnt folder, using mkdir
/mnt/windows.

But, to find the physical address of
your Windows partition, you will have to
use a utility such as Hardware Browser.

Now, you have a local folder
/mnt/windows, as well as a physical
address of your windows partition
/dev/hdb1. Now, at the command
prompt, type mount -t vfat /dev/hdb1
/mnt/windows.

You need root permission to issue the
command. So, log in as root, or change to
root, using the su command. The mount
command will load the Windows parti-
tion once. Hence, you will have to execute
the mount command again, whenever
you restart your PC. To avoid this, change

the File System Table i.e. /etc/fstab. Open
this file with any text editor such as vi,
gedit, etc. This file is formatted in 6
columns seperated by spaces. You need to
append the following line

/dev/hdb1     /mnt/windows     vfat
auto,umask=0     0     0

From now on, whenever you want to
access the files of your Windows folder, go
to /mnt/windows.

Share files and printers
using Samba 
With Microsoft’s SMB (Server

Message Block), it became easy to access
Windows shares on a Linux PC, but
the configuration was a headache.
Now, SWAT (Samba Web Administration
Tool) reduces this headache, by provid-
ing a Web-based utility, to manage the
Samba server.

Start the service
First of all, you need to start the SWAT
service. To do so, first modify the line ‘dis-
able = yes’ to ‘disable = no’ within the file
/etc/xinet.d/swat, then restart the xinetd

service by executing the following com-
mand at the prompt: /etc/rc.d/inet.d/xinetd
restart.

Configure the SWAT service to run
automatically every time the PC starts, by

ntsysv is a simple graphical utility to acti-
vate and deactivate services. It gives you
complete control as to which services
should, or should not be running. First,
type ntsysv at the terminal window, and
press [Enter].

You will see a list of services available
that you can either enable, or disable.
The services that are already enabled
are the ones, which start when your

PC boots up. Select, or unselect all
the services needed, and press OK.
Restart the PC for the changes to come
into effect.

By default, the configuration is affect-
ed only to the current runlevel. If you 
wish to make similar changes to more
then one runlevel, use the command:
ntsysv --level 35.

The configuration will affect all the
runlevel number(s) specified after the --
level option. In the example shown, the
runlevel 3 and 5 will be affected.

➜Partitions are listed as /dev/hdxx 

The fstab file lists all the available partitions
and their mount points

Just select Microsoft Office 2000 and click on
the ‘Add’ button to install it

You can adjust the Global settings in SWAT

ntysysv lists all the services available on
your Linux PC

1

Configure services
Bonus
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executing the following command:
chkconfig -level 35 swat on.

Check if the application has started
properly by typing:
chkconfig -list | grep swat.

The result should be ‘swat: on’. Once
it’s verified that the service is running, let’s
see how it eases the configuration task.

Run the Utility
To start with the Samba configuration, go
to the browser, and type http://local-
host:901/ in the location bar.

Next, specify the user name as root
and enter the password to start off with
the configuration. If you enter the wrong
user name or password, it will not give
you a second try. If you manage to mess
this up, restart the xinetd service, as
mentioned above. Use this configuration
utility on a remote machine cautiously,
since the username and password is sent
as simple text (without encryption)
across the network.

Configure
When you view the /etc/samba/smb.conf
file, you will notice that it is organised
into sections. Although we won’t be
directly modifying the files, the GUI tool
(SWAT) will modify it. The first section
consists of global settings. It defines the
server’s overall attributes, including the
two most important settings: workgroup
name, and NetBIOS name.

The next section deals with shared
folders. By default, one share is created
called ‘homes’. This is a private share, and
is visible to the users, who use a valid
username and password. By this share,
users can access their own home folder
over the network. To see the details of the
homes share, select home from the drop
down box, and press Choose Share. To
save any changes you make, press the
Commit Changes button. To add a new
share, type the share’s name in the text

box besides the Create Share button, and
then, press the Create Share button. Type
the folder name you wish to share along
with security settings such as ‘quest=yes’,
or ‘guest=no’, and Commit Changes. You
have successfully created a shared folder
in Linux that can be accessed even from
Windows PCs.

Once the shares are created, check
whether the users are configured proper-
ly to access the shared folders. To manage

the users for Samba, go to the Password
section. This section is split vertically into
two halves. The top half helps in manag-
ing Samba users on the local machine,
while the bottom half helps in changing
the password on the remote Windows PC.
The username and password on the local
and remote machine should be the same.
Before adding a Samba user in the Server
Password Management, check if the users
are present on the local machine. If not,
then add users in the local machine first.
Samba has a limitation that only allows
users with a valid local account to access
the shares.

Sharing printers is very similar to 
sharing folders. It works for major Linux
print services such as LPD (Line Print 

Users have to be given access rights to the
shared folders

Sharing printers is very similar to sharing
folders, using SWATSWAT lets you share folders with ease

On earlier Linux versions, the only way to
get your GUI working, was to use Xconfig-
urator—a console-based utility that acted
as a rudimentary front-end to the X serv-
er’s configuration file. But now, a new tool,
called redhat-config-xfree86, has been
included that makes changing display
properties very similar to that in Microsoft
Windows. To start the tool, go to the Main
menu > System Settings > Display. Alterna-
tively, you could execute the command:
redhat-config-xfree86.

In the window that pops up, you can
change the resolution, as well as colour
depth. Press OK, and that’s it.

You can also change the hardware
drivers for your monitor, or graphics card,
using this utility. When the utility opens,
go to the Advanced tab. Here, you can
configure both, the monitor and the
graphics card. Click the configure button,
to get a list of supported drivers. Choose
one from the list, or use the Probe button

to detect the hardware. Once you have
chosen the proper hardware, press OK.

Once you change any display set-
tings, you need to restart your X server
for the changes to take effect. This can be
done by simply logging out, and starting
a new session again.

Set your display
properties easily

Adjust colour and resolution easily

Configure the monitor via the Advanced tab

2Bonus
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Daemon), and CUPS (Common UNIX
Printing System).

Finally, check the Samba server’s sta-
tus in the Status section. It provides a but-
ton to start, stop or restart the server.

Install and manage
printers using CUPS
CUPS provides a portable printing

layer for UNIX-based operating systems.
Most of the newer distributions bundle
CUPS along. You can also download it at
http://public.planetmirror.com/pub/cups/1.1.4/.
Once you’ve downloaded CUPS, remove
your old printing software. Then, install
CUPS by typing: rpm -ivh cups-1.1.4-linux-
2.2.14-intel.rpm.

Note that your filename may differ
slightly. By default, CUPS installs with a
Web-based, and console-based interface.
It should start automatically when
installed via RPM. To verify whether the
cupsd daemon is running, execute the fol-
lowing, with the privileges of the root
user: /etc/rc.d/init.d/cups status

If you receive ‘cups: Scheduler is run-
ning’ as the output message, you are ready
to explore the Web interface. 

If not, start the scheduler, by typing
/etc/rc.d/init.d/cups start, with root privi-
leges. 

Once the CUPS scheduler is running,

point your Web browser to http://local-
host:631/. The :631 tells your browser to
connect to port 631, instead of the stan-
dard Web port 80.

There will be a variety of options in
your browser. Click on the first one—Do
Administration Tasks—and you will be
prompted to log in. Log in as root, using
your root password, and the Admin screen
will come up.

Although the ‘Class and Jobs’ section
appears ahead of Printer, we will add the
printer first. Press the Add Printer button,
and you will be asked for printer name,
host name and the printer’s description. 

Next, specify the device, device
Uniform Resource Identifier (URI), make
and model for the printer, one after the

other. The file option lets you print
directly to a file on the hard drive. The
http option lets you print directly to the
CUPS port. The ipp option lets you print
to a queue with the Internet Printing Pro-
tocol. The smb option lets you print to
shared printers, connected to a Windows
PC—if you use Windows as a print serv-
er. If the printer is locally connected,
specify the port to which the printer is
connected. Once you furnish all these

details, your printer set up is complete.
Now, you can manage printers, classes, as
well as print jobs. 

The Classes option allows you to
place a series of printers into a pool, or
class. If you print to a class, instead of a
specific printer, the first available printer
in the class will receive the job. This is
useful if you do a lot of high-production
printing, and have a series of printers at
a central location. 

AUGUST 2003

The printer setup process lets you choose the
model number

Clicking on ‘Do Administrative Tasks’, brings
up the Admin screen 

Here’s how to install a .tar file. 
Execute the following command: 
tar -xvf <package>.tar

This creates a folder by the name
<package> and extracts the files in it.
Next, change the current working direc-
tory to the <package> directory (using cd
<package>), and compile the file again.
To compile first you need to execute the
./configure command.

Now, create a binary file that can be
executed, with the help of the make com-
mand, and then install the compiled pro-
gram, using the make install command.

The normal process to install <pack-
age>.tar.gz, and <package>.tar differs
only by a step. The <package>.tar.gz file
is first converted to <package>.tar file,
and then the normal process of installing

the tar files is followed. Converting the
.tar.gz file to .gz can be achieved, using
the command: gunzip <package>.tar.gz.

An alternative method is to combine
both commands (gunzip <package>.tar.gz
and tar -xvf <package>.tar) to a single
command line:
tar -zxvf <package>.tar.gz

You can even execute the same com-
mand, using pipes, as follows:
gunzip <package>.tar.gz | tar -xvf

Uncompress packages

The default CUPS screen provides you with
online help

Type in the device URI in the Admin screen

The status section in SWAT lets you check the
status of the Samba server
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Further, the Jobs option allows you to
manage the print jobs in the queue. There
is no button to add a print job; you can
only manage the jobs using the Hold job,
and Cancel job operations, which are pro-
vided as buttons.

Just like managing jobs, you have
operations to manage your printers and
classes. The Printers managing section
lets you print a test page, start the print-
er, and perform other administrative
tasks. It also shows the print job, and
printer status.

Burn CDs on Linux
With CD-Writer prices falling
rapidly, users are now switching

to CD-Writers, instead of CD-ROMs. A
CD-Writer’s performance depends on the
CD-Writing software being used. Tradi-
tionally, Linux only supported command
line tools, to burn CDs, but now easy to
use, graphical tools, such as gcombust,
are available.

gcombust is a graphical user interface
for traditional tools such as mkisofs,
mkhybrid, cdda2wav, cdrecord, and 
cdlabelgen. Some of the features of 
gcombust are burn CD on the fly, iso
image creation, Audio CD creation, Print

CD-covers, multisession support, and
bootable CD support.

Since the gcombust package is avail-
able in the gz format, follow the steps
shown previously to install it. When you
execute the software for the first time, it
will show you an error that says ‘Config-
uration file not found’. Press OK, and then
set the configuration in the Preferences
window that opens up. You have to set
these settings only once; hence forth you
can directly get to the task of CD Burn-
ing. To burn a CD, go to the Data Files tab,
and press the Add Directory button to add
files, or folders. 

Once all your files and folders are
added, go to the Burn tab. Uncheck the

‘Dummy test run’ checkbox, check the
Burnproof checkbox, and then the Multi
Session checkbox (if you wish to create a
multi-session CD). Finally, press the
Combust! button.

If you cannot locate your drive, use
the ‘Detect SCSI drive’ button, and 
verify the drive, using the ‘Check SCSI 
settings’ button.

Most graphical utilities, such as gcom-
bust, use a command line utility to
accomplish their task. So, knowing how
command line utilities operate is a great

help. In the command line, each burn
process is two fold—first, create an 
iso image, then burn the iso image 
on the CD. To make an iso image, execute
the following command:
mkisofs /home/user  >  /tmp/user.iso

Make an iso image from a CD using
dd if=/dev/cdrom of=/tmp/img.iso

Burn this iso image on a blank CD by
executing the following command:
cd-record -v speed=12 dev=0,0,0 -data img.iso

If you wish to write to a re-writable
CD, after erasing its content, type:
cdrecord -v speed=12 dev=0,0,0 blank=fast
-data img.iso

Check the files in the iso, by directly
mounting the iso file. For example, create
a folder, say /mnt/iso. Then, mount the
iso file by typing:
mount -o loop,ro -t iso9660 ./img.iso /mnt/iso

You can then browse through the
image content, as you would with your
CD-ROM drive. If there are any problems
with the image, delete it, and create a 
new one.

PRAVEEN KURUP (praveen_kurup@thinkdigit.com)

MUSTALI KACHWALA

(mustali_kachwala@thinkdigit.com)
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MP3 is the most common music format
in use today. But, it is involved in legal
issues. Converting to and from MP3
involves payment of royalty for encod-
ing or decoding. On the other hand,
ogg is a format that’s free to use—a
open source project which provides the
same quality of sound at half the file
size, thus reducing the disk space
required to store your music. One of the
easiest ways to convert MP3 to OGG is
by using scripts.

The mp32ogg script is in Perl, avail-
able at http://freshmeat.net/projects/
mp32ogg, and the pre-requisite is that
you need to have the mpg123, and the
oggenc packages installed on your PC.
You will also need a couple of Perl mod-
ules that go by the names MP3::Info, and
String::ShellQuote as well. Once, you
have these, execute the Perl script named
mp32ogg by typing mp32ogg *.mp3.

This will convert all the mp3s, with-
in the current directory, to the ogg for-
mat, and create a new file with an ogg
extension, for each mp3 file. Existing
mp3 files are not affected, so relax
while the conversion takes place.

Convert your MP3s to OGG

The CUPS Web interface lets you manage 
print jobs

Click on the Add Directory button in the Data
Files tab, to add files and folders

gcombust gives you continuous output during
the burn process

Uncheck the Dummy test run checkbox in the
Burn tab 

4Bonus
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Windows 98 to XP
I was unable to install Windows XP Profes-
sional in the MS-DOS mode. I had to install
Windows 98 SE first, and then upgrade it to
Windows XP Professional. Is there a way to
install Windows XP Professional without
having to follow this procedure?
Mahendra

You can install Windows XP by exe-
cuting the winnt.exe within the i386
folder on the Windows XP CD. The setup
then asks for the path of the source files,
and starts the installation. Another alter-
native is to install it directly using a
Windows XP bootable CD. To change
the boot sequence, re-start your PC and
press [Del] (or [F2], or [F12], depending
upon your motherboard) to enter the
CMOS setup. Change the first boot
option to CD-ROM and keep the hard
disk as the second boot option. Now
boot your PC using the Windows XP CD.
The setup should start automatically. 

Keep less work at startup
I get a USERINIT.exe error, whenever I

switch on my computer. The PC runs
Windows XP Home edition.
Deepak Dugar

This error occurs when Windows ini-
tialises the users environment. There
exists a way by which you can start a

program even before Explorer starts. This
feature is used by software such as
Norton AntiVirus, McAfee, etc., to exe-
cute the program automatically. 

To eliminate the error, you will need
to change the settings in the anti-virus
program so that no virus scan is ini-
tialised at startup. Restart your comput-
er and the error should not occur again.
If it persists, then another application
may be causing the error. You will have
to find the program that starts at startup,
and disable it. 

Upgrade to higher capacity drive
I wish to upgrade my PC’s BIOS to

allow it to recognise large hard disks. I
have a Pentium-II 266 MHz, 128 MB RAM,
4.3 GB hard disk, SG200A video card,
440LX motherboard, and the Award mod-
ular BIOS Version 4.1. I wish to have both
Linux and Windows on this PC. My prob-
lem is that although I am keen on using a
large hard disk, say 40 to 60 GB, my
motherboard manual says it will not
recognise hard disks beyond 8.4 GB. What
I can do to solve this?
V.A. Kowshik

This is a problem faced by many.
There are three methods to solve this
problem: 

Update your motherboard’s BIOS.
Download the update available for your

motherboard model at the manufactur-
er’s Web site, and follow the steps given at
the site, to flash the BIOS. However, they
may not be an update available for your
motherboard, it being too old.

Get an add-on IDE controller. Pur-
chase an IDE controller card, install
the drivers, and connect it to the high
capacity hard drive. Though being an
expensive solution, it will surely solve
your problem.

Use utilities provided by your drive
manufacturer:

If you use a Maxtor hard drive, down-
load the utility at http://www.maxtor.com/en/sup-

port/ downloads/big_drive_enabler.htm

Seagate’s utility is available at http://www.

seagate.com/support/kb/disc/capacity/index.html

A file that needs to be locked away, an intriguing mark on the CPU, a motherboard that refuses to
recognise hard disks... Here’s the denouement to it all!

■ troubleshooting

Maxtor’s Big Drive Enabler provides support for
larger hard drives
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Video memory size
I have a P4 1.5 GHz, 256 MB SDRAM,

40 GB 7,200 rpm hard drive and a 64 MB
SDR nVidia GeForce2 MX 400 graphics
card. 

While fiddling about with my BIOS
recently, I came across an option wherein
the AGP aperture size is set to 64. I would
like to know whether this is applicable
only for integrated graphics chipsets. If
not, what does it mean for my system
configuration. Will increasing it to 128
increase my graphics performance?
Sai Krishnan

The AGP aperture is the portion of
the PCI addressable memory range that
is dedicated as graphics memory address
space. It determines the amount of sys-
tem RAM that can be allocated to the
graphics card for storing texture details.
It is recommended that the aperture size
be half of your system RAM. Typically,
set the aperture to 64 MB or 128 MB. As
the memory on the graphics card
increases, the system requirement
decreases. Hence there is no need to set
the aperture size to half the system
RAM. The aperture size is in no way
related to performance. Increasing it to
the largest setting would not result in
performance gains.  

Can’t boot
I have a Pentium 4 processor, 128 MB

DDR RAM and a 40 GB hard disk. When
I boot up Windows XP, I get an error say-
ing, “Unmountable boot volume”
displayed on a blue screen. The error
directs me to remove recently installed
hardware or software first. Since I also
have Windows 98 SE in another partition
that works fine, how can I get rid of the
error message? 
Arvind Kumar 

This problem occurs when you have
a corrupted boot.ini file. Boot up
using the Window XP CD. Press [R]
when you get the Setup screen, to get to
a DOS-like mode. Here, type chkdsk /p
and press [Enter]. After it is done, type
fixboot, press [Enter], then [y] and then
again press [Enter]. After this, type exit to
reboot to Windows. This should solve
your problem.

If it doesn’t, boot into the CD again.
Type chkdsk /r to switch to the recovery
mode. When it is finished type exit to
reboot to Windows. This should defi-
nitely help you out.

gpedit not available
I tried to bring up the group policy

editor by typing the command gpedit.msc
in the Run dialog box in Windows XP. But,
the PC gave up an error message saying,
“Windows cannot find ‘gpedit.msc’ Make
sure you typed the name correctly and try
again”. I tried several times, but to no
avail. So, I tried to locate that file by using
the search utility. I found that there is no
file named gpedit.msc. Kindly help me!
Benenet

You probably have Windows XP
Home installed on your PC, under which
the gpedit.msc command is not avail-
able. Hence, you will need to upgrade
your operating system to Windows XP
Professional.

Graphics card or a processor
I have a PII 300 MHz system with 128

MB RAM and a 32 MB Sis 300/305 AGP
card. I have noticed that games such as
FIFA 2003, which run very slow on my PC,
run smoothly on my friend’s computer—a

PIII 500 MHz system with only an 8 MB
AGP card. I want to know what affects the
graphics capability of a system—a proces-
sor faster by 200 MHz, or a graphics card
with 16 MB of extra RAM? Is there any
way I can improve the performance with-
out buying new hardware?
Piyush Mishra

Your friend’s PC is a PIII, which has
an optimised instruction set that han-
dles the graphics better than your PII.
The processing speed also cannot be neg-
lected; after all, everything depends on
the CPU’s processing power. Hence, a
surplus of 200 MHz processing power
will definitely make a difference.

Sorry, there is no way you can improve
you system performance without upgrad-
ing the hardware.     

Crack game
I was using the trial version of the

7Tools Partition Manager 2003. Ever since
the trial period expired, I get an error
message about the expiry that waits for a
minute at the boot up screen, every time
I start the PC. 

I also receive a message saying that a
CD is needed when I try to play Age of
Empires. This error occurred after installing
an update for the game, downloaded from
the Microsoft Web site. 
Vinodh

Upgrade to the full version of the
Boot Manager. If you don’t want to buy
the program, un-install it and the mes-

Relay not allowed
The outgoing mail server for Dishnet

DSL and NOW no longer works. Their
help desk says that they have removed
the facility to send e-mails from a
domain account such as mine.
What do I do now?
Paradise

It appears that you
have an e-mail id on a
domain other than that
provided by Dishnet, or
NOW. Many Internet
Service Providers such
as VSNL and Sancharnet, provide
SMTP solutions. 

Under this service, e-mails from pri-
vate domains are relayed through their
SMTP server. Purchase one of those

services depending upon
your need. 

If you are
unable to send e-
mails through
your Dishnet or

NOW e-mail id, then
first check the pass-

word. If you are using the
correct password, then you

will need to contact the ISP
help desk.

Another solution is to get
SMTP services for your domain
from the Web hosting company

that is hosting your Web site. You may
also host your own SMTP server on a
system that is connected to the
Internet 24 hours a day. IIS under
Windows NT is one such alternative.

ILLUSTRATIONS: Farzana Cooper

The group policy editor comes with Windows
XP Professional
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sage should go away. 
The reason why Age of Empires doesn’t

work anymore is that you originally
installed the game from a pirated CD, or
copied a cracked version from a friend.
The crack modifies the game’s .exe file to
bypass the CD check. When you installed
the update, the cracked file got overwrit-
ten by the update and it started checking
for the original CD again. 

The solution? None; one of the lessons
to be learnt of playing pirated games!

Not enough memory
I have a Celeron 1.2 GHz, Intel 810

motherboard, 128 MB RAM and a 40 GB
hard disk drive. I am a multimedia stu-
dent, and the software I use brings down
my system resources. Whenever I connect
to the Internet, I frequently get an error,
indicating that there is not enough mem-
ory. Sometimes, it even causes my PC to
hang. However, my friend’s PC that has
the same configuration with 64 MB RAM
faces no such problems. Why is this so?
Parivesh Jain

We assume that you are using
Windows 98, since this and the previous
versions are the main operating systems
that faced such problems. This happens
because browsers such as Netscape need a
lot of resources, and operating systems
restrict each application to a 64 KB limit.
These applications do not release unused
resources, and simultaneously demand
more resources thus resulting in crashes. 

To over come this problem, you need
to install patches, or fixes available at the
browser’s Web site or upgrade the brows-
er to a newer, more stable version.

Real Jukebox
Every time I start my PC, I get a mes-

sage saying, “Error starting program, A
required .dll file, PNGU3263.dll, was not

found.” How do I get rid of this message?
Manoj

This is a known problem with Real
Jukebox. You get this error when the
pngu3263.dll file is missing or corrupt.
The solution is either you re-install Real
Jukebox or disable it at startup. To un-
install it, go to Control Panel > Add/Remove
Program.

To disable the program from starting
automatically you have two options. One
is using the msconfig utility. Go to Start >
Run and type msconfig. Press [Enter]. Go
to the Startup tab, uncheck all the entries
related to Real Jukebox, press OK and
restart the PC. 

The other option is to directly modify
the registry. Go to HKEY_LOCAL_MACHINE\
Software\Microsoft\Windows\CurrentVer-
sion\Run, and delete all the keys pertain-
ing to Real Jukebox. Playing around with
the registry can cause Windows to crash,
so it’s a good idea to back up the registry
before you use regedit.

Can’t change BIOS setting
My PC restarts automatically ever

since I upgraded from Windows 98 to
Windows XP Professional. If I try to enter
the BIOS setup, none of the configuration
options are highlighted, and I cannot
change any of the settings. Help!
Kabeer J Barooah

BIOS settings need to be highlighted
so that they can be changed. The reason
they are not highlighted is that someone

may have set up an adminis-
trative password without your
knowledge like maybe your PC
dealer. You will have to reset
the BIOS, either by removing

the battery or
changing the
jumper on the
motherboard so
that the CMOS
is reset. Refer to
the mother-
board manual
for the proper
jumper set-
tings. Be very
careful when
changing the

jumper settings, it being an intricate
process. You could always get a profes-
sional to do the needful.

Mark of the CPU
I have a PC with a Pentium 4 1.8 MHz

processor. It is shown as Intel Pentium (R)
4. Its L2 cache is 256 KB. This perplexes
me since I read somewhere that P4 has a
512 KB L2 cache. Also, why is that brack-
eted ‘R’ between Pentium and 4? Have I
been taken for a ride? Please comment! 
Prasad

Don’t worry, your hardware vendor
has not duped you. In its initial stages,
the Pentium 4 was built with only 
256 KB cache. Later on, it was revised to
include a 512 KB L2 cache. This can be
confirmed by taking a look at the CPU
packaging box. If it says that the CPU is
a Pentium 4 1.8 A, then must be a 
512 KB cache processor whereas if it just
says Pentium 4 1.8, then it is a 256 KB
cache processor. As for the R, it stands for
‘REGISTERED TRADE MARK’. See?
Nothing to worry about.

Walk with the world
I have a PC with a Celeron 1.1 GHz

processor, 128 MB RAM, a 40 GB hard disk,
and an Asus motherboard. I have a sepa-
rate 6 GB partition for Linux. First, I

Behind the firewall
eDonkey2000, installed on

my Windows 98 PC, does not
connect to any of the available
servers. Do I have to change some
settings for it to work?
Mandar Sawant

Check if your computer is
behind a firewall. If you happen
to be behind one, then you need to
change the proxy settings. You will

also have to
get the port
4662 opened
on the
Internet serv-
er. Check the
status of the
port 4662 at
the following
Web site:

http://www.preinheimer.com/cgi-bin/con-
nectiontest/connectiontest.cgi

You can disable Real
Jukebox at startup
via regedit, or
msconfig
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installed Mandrake 8.2 without any prob-
lem whatsoever.  When I tried to install Red
Hat Version 7, I got a message indicating
that the disk space is not enough. 256 MB
for Swap, 4.5 GB for Root (/), and 1.2 GB
for home. When I tried to install Red Hat
9.1, the system hangs after 7 per cent of
the installation. At my workplace, the same
version installed itself smoothly without any
glitches. Will you kindly help me?
G.Harish

Do make sure that your distribution

is indeed Redhat 9.1. The Red Hat site
lists Red Hat 9.0 as its latest stable distro.
Running Red Hat 9.0 on your system will
be quite torturous as the minimum sys-
tem requirement is 128 MB RAM. The
Red Hat 7 installation should work fine
(even a Red Hat 8 needs 4 to 5 GB of hard
disk space for a typical install). The low
disk space warning could be because you
allocated separate space to /home but
not to the other directories such as
/boot, /usr, /etc, and /var. Try allocating
just the swap space and the / partition—

don’t give a separate /home partition`.
Allocating separate space for /home does
not really make much of a difference on
a home PC as the number of users will be
very less.

Send your computing
problems to sos@jasub-
hai.com or write to
Digit, D-222/2, TTC

Industrial Area, MIDC, MIDC, Nerul,
Navi Mumbai-400 706, and we may
answer it here!

IRQ Locking
I am unable to install the SBLive

CT4830 sound card in Windows 2000,
but the same hardware works fine in
Windows 98. I think the problem lies in
the IRQ sharing. I wish to know how I
should lock the IRQ for my sound card.

Another problem is that whenever I
burn a CD, it gets burned at a maximum
speed of 8X, even if the CD supports 24X.
If I try to burn the CD at a speed exceed-
ing 8X, it gives an error message saying,
“Buffer under run”. Why is that so?
Tamal

To manage IRQ settings for the
sound card, right-click on My
Computer and go to Manage > Device
Manager. In the right pane of the win-
dow, double-click on Sound, Video and
Game controllers. Now right-click on
the appropriate sound card driver, and
select Properties > Resources. Here you can
change the IRQ settings for the device.
To manually set the IRQ settings, first

un-select ‘Use automatic settings’.
Under Resource Type, select IRQ and
hit Change Setting. Now select the
IRQ you wish to bind the sound card
with.

The hard disk is unable to provide
data to the CD-Writer at the speed
that it is required to. This may occur
due to many reasons—the hard disk
maybe slow, or other applications
might also be accessing the hard disk
at the same time, or the data might be
fragmented, or CPU utilisation by other
programs maybe very high. To reduce
such errors, use such tools as scandisk
and defrag. Try not to run other appli-
cations while your CD is burning. 

It is also possible that you maybe
using an early version of a CD-Writer
that does not support buffer under run
protection. Hence, it maybe time to buy
one of the latest models that support it.

Locking files in a Safe
I wish to know how to password pro-
tect my important files and folders so
that no one can peek into them? 
Brajesh Manohar

There are many utilities such as
Secure Files 2.8, FileVault 2.7,
bProtected 2003, noDelete 1.51, etc.
to achieve this. Secure Files is one of
the best. With this utility the files
remain protected even if the appli-
cation is not running. Add the files
to be protected, add the password
and close the application. That’s it!
The files are protected. They can
only be retrieved after you start the
application and provide your pass-
word. As soon as you stop the appli-
cation from running, all the files

marked for protection just vanish from
their locations. They are visible only
when the application is running. It also
has an icon, which when pressed, clears
the recent file list.

DLL file missing
My Windows 98 SE PC has an Intel

815 motherboard and a PIII 933 proces-
sor. After updating the audio driver for
my motherboard, I found that it is throw-
ing the following error message at start-
up – “Error starting program; a required
.dll file - DEC2MIME.DLL not found.”
Due to this missing .dll file, the startup
programs such as MusicMatch, Norton
AntiVirus, Task Scheduler, Intel active
monitor do not appear on the system
tray and task bar. The programs work
fine when activated, using the desktop
icons.  
S.S.Samanta 

The missing .dll file—
DEC2MIME.DLL—is actually a
Symantec decomposer file, which
belongs to one of the recently installed
Symantec products. What you can do is
reinstall that Symantec product. It
should solve your problem and your
system tray icons will reappear. 

FAQs

Password protect your documents, using Secure
Files 2.8 

Resolve resource sharing conflicts by changing the
IRQ settings
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GRAHIC DESIGN: Atul Deshmukh

We tell you how to make your
imaginations a reality. Master these tips
and tricks on the three major graphics
software. Create jazzy effects, and play
with images in a much faster and
efficient way.

Imaging...
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Curved text
To create curved text, first
you need a curve on which
to place the text. With the
Preset Shape Tool, draw a
circle on a new canvas.
Switch to the Text tool. The
cursor changes to the
Curved Text cursor when
you move it over the image.
Click, and enter the desired
text in the dialog box pre-

sented. If your text is
not visible, it is

because both,
the fill and out-
line colours,
are white.
Click any
colour on
the palette
to choose
the outline
colour and
right-click to

fill in the
colour. If the let-
ters overlap each
other, increase

the kerning—the space
between the letters. Nor-
mally, auto-kerning works
well. Click OK, and the
curved text is seen. 

To make the circle invis-
ible, locate the layer that
contains your text and
vector object. Click on the
‘+’ to expand the layer,
right-click on the ellipse,
and click properties.
Uncheck the Visible check-
box; click OK, and the circle
will disappear.

Custom moulded 
button
Open a new image with a
white background and
immediately add a new
layer (layer 1). Select any
background colour, and
white as the foreground

colour. Create a circle, using
the Preset Shape Tool with
the following specifications:
Type: Circle; Style: Stroked
& Filled; Line Width: 22;
with Antialias checked.

Add a new layer—Layer
2. Using the Webding font,
hold in the Shift key,
and type @ for the hammer
and spanner symbol that
we will be using in this
example. Type in a font size
of 100, and select ‘Create
as Selection’. 

Back in your image, the
selection will appear as a
dotted line around the text.
Do not release the selection,
and your type will instantly
disappear. If the entire font
is on your screen you’re ok,
if part of it is off the screen,
you will need to try again.
Place the cursor in the mid-
dle of the window, and click
to go back into the text 
editor. Click ok, and see if
the entire phone symbol is
on the window. Go to Selec-
tions > Modify > Expand on the
Menu Bar, and expand the
selection to 4. 

Using the Flood Fill
tool, fill your selection with
the solid colour you used for
a background colour. Using
the Move tool, position the
hammer and spanner sym-
bol in the centre of the cir-
cle. If all has gone well, the
phone symbol should be
large enough to fill the
inside of the circle, barely
touching the edges. Unse-
lect any selections, and
merge all of the layers. 

Once the layers are
merged, use the Magic
Wand to select the figure

again, and fill it with a Sun-
burst Gradient fill. Adjust
the settings so that the
white part of the sunburst is
in the top left corner of the
preview square. 

Go to Image > 3 D Effects >
Outer Bevel, and select the 
following settings: bevel,
smoothness: 13; depth: 5;
ambience: 0; shininess: 0;
light white; angle: 315;
intensity: 38; elevation: 47. 

Invert your selection.
Using the Flood Fill tool set
to solid, fill the interior
areas of your figure with the
solid colour, selected as the
background colour. Invert
the selection again, and add
a drop shadow with the fol-
lowing settings; Opacity:
100; Blur: 13; Horizontal: 0;
Vertical: 0. 

Glowing text
Create a new file with a
black background, set to 16
million colours. For the
foreground colour, select
light purple—RGB (128,128,
255). Enter some text. Uns-
elect the text by going to
Selections > Select none. Go to

■ tips and tricks

Use Paint Shop Pro to curve
your text as desired 

You can create your buttons
and icons easily in few steps.

PAINT SHOP PRO 8

Glowing Text

JULY 2003

ILLUSTRATIONS: Farzana Cooper

This image editing software from JASC
Software now has a more polished look than

ever before, and has lots of features which are
unique to it. Find out how you can achieve

special effects in few easy steps.
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Effects > Edge Effects > Dilate,
and repeat this thrice. This
will expand the text. Now
go to Adjust > Blur > Blur More.
Do this thrice to create the
glowing effect around the
text.

Now, select dark pur-
ple— RGB(0,0,64) as your
foreground colour. Enter the
same text again, and move 
it so it superimposes the
blurred text. This is the 
final image.

This effect looks best
with a lighter colour on the
outside, and a darker colour
on the inside.

Golden text
Create a new image with
white as your background
colour, set to 16 million
colours. Enter some text
using in light grey—RGB
(192,192,192). Keep the text
selected throughout the
entire tutorial. Now go to
Selections > Modify > Feather.
Enter 3 in the ‘Number of
pixels’ field, to expand the
selected area. Now, select

white as your foreground
colour, and give the text a
hot wax coating by selecting
Effects > Artistic Effects > Hot 
Wax Coating. 

Now, go to Adjust > Color
Balance > Red/Green/Blue, and
enter these percentage val-
ues: Red: 100; Green: 50;
Blue: 0. Do this twice to get
a realistic gold colour. 

Finally, add a drop shad-
ow for a 3D effect. Go to
Effects > 3 D Effects > Drop
Shadow with the following
options; Color: black; Opac-
ity: 100; Blur: 10; Vertical
Offset: 4; Horizontal Offset:
4. This is the final image.

This method can also be
applied to shapes such as
hearts, found in the Webd-
ings font, for example. 

Neon text
Create a new file with a
black background, set to 16
million colours. With white
as your foreground colour,
enter some text. Unselect
the text by going to Selections
> Select None. Go to Adjust >
Blur > Blur More.  Now go to
Effects > Artistic Effects > Solar-
ize. Set the Threshold to
128, and click OK.

Now, click the Adjust >
Color Balance > Red/Green/
Blue, and enter these per-
centage values; Red: 100,
Green: 0, Blue: 100, for a
light purple colour. This is
the final image.

Water text
Create a new image with 
a white background, set to
16 million colours. Enter
some black text, preferably
with a thick font such as
Arial Black. Keep the text
selected.  Now, select the
Paint brush tool, and set it 
to  Size: 50; Opacity: 100;
Texture: Marble.  

With white as your fore-
ground colour, click and

Keyboard shortcuts for PSP 8

Golden Text

Neon Text

Menu Command
File > Import > 
Screen Capture > Start  
Edit > Paste > 
Paste As New Layer      
Edit > Paste > 
Paste As New Selection
Edit > Paste > 
Paste As New Vector Selection
Edit > Paste > 
Paste As Transparent Selection

Image > Crop to Selection

Image > Flip
Image > Rotate > Free Rotate...
Adjust > Brightness and Contrast >
Brightness / Contrast...
Adjust > Brightness and 
Contrast > Gamma Correction...
Adjust > Hue and Saturation > 
Hue/Saturation/Lightness...
Selections > Float

Selections > Invert

Shortcut
[Shift] + [C]

[Ctrl] + [L]

[Ctrl] + [E]

[Ctrl] + [G]

[Ctrl] + [Shift] + [E]

[Shift] + [R]

[Ctrl] + [I]
[Ctrl] + [R] 
[Shift] + [B]

[Shift] + [G]

[Shift] + [H]

[Ctrl] + [F]

[Ctrl] + [Shift] + [I]

Description
Start a capture

Paste the clipboard contents into the 
current document as a new layer
Paste the clipboard data into the 
current image as a new selection
Paste vector data in clipboard, into the
current image, as a new vector selection
Paste the clipboard contents into the 
current image, using the background
colour as transparent
Crop Tool: Used to eliminate, or crop
areas of an image.
Flip image
Apply rotation to image
Adjust brightness and contrast

Apply gamma correction to the image

Adjust the hue, saturation and/
or lightness
Convert the current regular selection 
into a floating selection
Invert the current selection area

Water Text
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drag the paint brush over
the text once.  Unselect the
text by going to Selections >
Select None. Now go to Effects
> Edge Effects > Dilate. This
will increase the lighter
areas of your text. 

Go to Adjust > Blur > Blur
more. Create a watery effect,
by going to Effects > Artistic
Effects > Hot wax coating. This
will create a liquid effect. To
add some colour, go to 
Adjust > Colors > Red/Green/
Blue, and use Red: 0; 
Green: 20; Blue: 100.

Note that all colours are
possible.

Burnt edges
Open an image, and select a
white background, set to 16
million colours. Use the
Magic Wand tool, and click
on the white area around
the image. Invert the selec-
tion by going to Selections >
Invert. This will allow you to
work only on the image,
and not the white border.
Use the Paint Brush tool
with white as your fore-
ground, and create an edge
as if has been burnt.

Click Selections > Select
None, and select the white
areas again, using the Magic
Wand tool. Invert the selec-
tion, and if you wish, feath-

er the selection by 2 or 3
pixels. This will give you a
smoother edge. Use the Air
Brush tool with black as
your foreground colour.
Select a brush size of 10, and
opacity 50. Go around the
image close to the edges to
create a dark border. Use
opacity of 20 to create a
lighter border, further in
from the darker one. You
can also use dark brown to
give more realistic burnt
edge effect. 

Flying text
Start with any colour back-
ground. Choose a font, and
some text. Press [Ctrl] + [C]

to copy the text to clip-
board. Now, unselect your
text. Flatten the image by
clicking Layers > Merge >
Merge All (Flatten).  Then, go
to Image > Rotate > Rotate
Clockwise 90. Next, go to
Effects > Distortion Effects >
Wind. Set the strength at
100, from the Right. 

Then, go to Image >
Rotate > Rotate Anticlockwise
90, to bring the image back
to its original position. Now
paste the text you had
copied to the Clip Board.
Flatten the image once
again. Now, click the Selec-
tion tool from the tool bar,
and drag it across your wind
effect to cover the effect in
the selection rectangle. 

Now go to Effects > Geo-
metric Effects > Perspective-ver-
tical. Set the Distortion to
100 and Color to the back-
ground colour you are
using. After that, unselect,
and you’r e done. 

Creating styled lines 
To create a styled line, press
the arrow or preview win-
dow for Styled Lines on the
Tool Options palette, then
press the Custom button at
the bottom on the Line
Style selection list.

Here, you can manipu-
late several line properties.
To set one of the caps, press
the arrow button near the
caps preview window, to get
the selection box. Choose
the cap you want by click-
ing it. You can then set the
cap size relative to the line
width, by pressing the cap’s
Size button and then setting
the Height and Width for 
the cap. You add dashes and
gaps in the Style pane of
the Styled Line dialog box.
The first time you press Add,
you add a dash, which you
can size by setting a value
with the Length control, or
by dragging the pointed

thumb in the control box.
Press Add again, to add a
gap. You can keep adding
dashes and gaps. 

To save your styled line,
press the ‘Save As New’ but-
ton. Once you save your
new line style, it’s available
with any drawing tool. You
can create styled lines for all
sorts of purposes, including
navigation buttons for a
Web site, or separator bars
for a Web site, or newsletter.

The Seamless Tiling
effect 

Turn any selection into
a seamless pattern for appli-
cations such as painting,
adding text, or creating

backgrounds, with the
Seamless Tiling Effect under
the Effects > Image Effects
menu.  This feature gives
you the option to create
tiles using three methods.
Try this effect. You are sure
to like it.Burnt Edges Effect

Flying text effect

With Paint Shop Pro 8, you can
create your own Styled Lines.

The Seamless Tiling Effect in
PSP 8
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Create custom styles
To create custom styles, set
up objects with the strokes
and fills you want to save as
styles. Drag each of them to
the styles palette. Do not
delete them from the page
yet. On the Styles palette,
click the options triangle,

and choose ‘Select all
unused’.

The unused styles are
selected. Click the trash can

at the palette’s bottom,
and say yes, when

asked if you want
to delete the

selected styles.
Follow the
same proce-
dure for brush-
es, swatches
and symbols
(symbols are in
AI 10 only). You

will now only
have items used in the

document in the palette.
Next, delete the objects
using the styles from the
page. New styles are stored
in the styles palette. Save
the file, give it a descriptive
name, and close it. Remem-
ber, the file must be closed
to load the styles.

To use the styles, go to
Window > Style Libraries > Other
Library, and navigate to
where you saved the file.
Highlight it and click Open
to open it. The styles will be
in the styles palette, ready
for use. 

Transferring vectors
between Illustrator and
Photoshop
Vectors are important as
they are resolution inde-
pendent—so they can be
scaled up or down with no
loss of detail—and they

print clean, and crisp. Vec-
tor shapes can be easily
modified; just a little tug on
a handle turns a line into a
curve. Vectors can be easily
rasterized into pixels; it
takes specialised programs
to convert pixels into vec-
tors. If vectors could be
transferred between differ-
ent programs, it would be a
very handy feature. Here is
how we can do it between
Photoshop and Illustrator.
From Photoshop to 
Illustrator
Between Illustrator 9 and
Photoshop 6, you can drag
and drop paths, directly
from Photoshop into
Illustrator. Previously, you
could only export, or copy,
and paste. Just select the
Photoshop path, and drag
it to an open Illustrator
document.

Export paths from Pho-
toshop, by going to File >
Export > Paths to Illustrator.
You can choose a specific
path from the Paths palette,
a path from a shape layer, or
crop marks that define the
Photoshop file size. Note
that the path exported to
Illustrator, will have no fill,
or stroke. Select all, or
switch to the outline mode
to see your vectors. 
From Illustrator to 
Photoshop
You can also get vectors
from Illustrator into Photo-
shop. If you select the Illus-
trator objects, and then
copy and paste, a dialog box
appears that lets you control
whether you want the path
converted into pixels (on
their own layer), paths

(added to Photoshop’s Paths
palette), or shapes (as a new
shape layer). 

Photoshop lets you con-
trol the conversion from
precious vectors to bland
pixels. If you choose pixels,
a transformation box
appears around the import-
ed art work. Use the bound-
ing box handles to scale,
rotate, or skew the art work
any which way you want. As
long as you don’t double-
click, or press [Enter],
you’ve still got resolution-
independent vectors. 

Finally, if you want to
drag and drop from Illustra-
tor into Photoshop, you can
control the created object
type as follows. With no
key pressed, drag to create
a pixel layer. Hold [Ctrl] to
create a path. If a shape
layer is currently active, the
path will be added to that
shape layer. Hold [Shift]
and place the new object
in the centre of the Photo-
shop file.

Make your own gift
tags
You can create your own tags
that are business card sized
to put on gift boxes. By
default, the 0 on the ruler is
set to the left side horizon-
tally, and the bottom verti-
cally. Change it by clicking
on the crosshairs on the
rulers’ top, and dragging it to
the top left corner.

Unfortunately, you can’t
change the page margins in
Illustrator. They’re set to the
unprintable area of your
printer. You can move them
around on the page, but you

Create your custom styles and
use them later to ease your
work and attain consistency

ADOBE ILLUSTRATOR

If you want a top of the line graphics program
that deals with both raster and vector

graphics, Adobe Illustrator 10 is the software
for you. Use these small time saving tips to get

the best out of this powerful tool.
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can’t change their size.
Hence, you’ll need to pull
out horizontal guides to
0.75, 4.25, and 7.75 inches.
Click on the ruler, and drag
with your mouse, to pull
out guides.  You’ll also need
to drag vertical guides out to
0.5, 2.5, 4.5, 6.5, 8.5, and
10.5 inches.

Place the image you
want to use. Select File >
Place, and navigate to the
directory with your image
and double-click on the file
name. Select the image,
once you have it placed
properly. Once it’s selected,
the bounding box, and
small rectangles appear
around it. Then, choose
Object > Transform > Move.

Put in 0 for the horizon-
tal position, and -2 for the
vertical position. Negative
numbers move objects
down; positive numbers
move objects up. Press the
copy button—this places a
copy of the object you select-
ed, at the chosen position.
Choose Object > Transform >

Transform Again, or the key-
board shortcut [Ctrl] + [D],
three more times.

Select everything ([Ctrl] +
[A]). Then, choose Object >
Transform > Move again. This
time, enter 3.5 for the hori-
zontal position, and 0 for the
vertical position. Press copy,
and all the graphics will be
positioned as desired.

Print this, and you are
ready with your Gift Tags.

Changing the default
Illustrator file
If you want a brush, symbol,
swatch, or style to be avail-
able whenever you create a
new document in Illustra-
tor, you can edit the Illus-
trator Start up documents in
the Illustrator plug-ins fold-
er. For example, if you
installed Illustrator 10, the
start file for CMYK will be
called ‘Adobe Illustrator
Startup_CMYK.ai’ and will
be located in ‘C:\Program
Files\Adobe\Illustrator 10
\Plug-ins’. Just open the file
in Illustrator, add the
content you want available,
save, and close the docu-
ment. The next time you
create a new document
in Illustrator it will be there. 

Remember that unless
you do a cleanup on every
final document you save, by
deleting unused brushes,
symbols, swatches, and
styles, everything you add
increases file sizes. Hence,
delete items you will never
use from the start up file.
Once again, this is not for
the casual user. It’s akin
to changing the Windows
registry. 

Turn guides into vector
lines
Go to View > Guides > Lock
Guides, to unlock locked
guides. Then, go to View >
Guides > Release Guides, and
the guides will turn into 
vector lines.

Changing tool pointer
You can change the point-
er’s appearance, from the
tool pointer to a cross hair,
for more precise control.
More artwork is visible,
when using a cross hair
pointer. This is convenient
for detailed drawing, and
editing. To change a draw-
ing tool pointer to a cross
hair, press [Caps Lock],
before you begin drawing
with the tool. To make this
change permanent, open
Edit > Preferences > General,
and check ‘Use Precise Cur-
sor’, and click OK.

Draw straight
When you draw, or move
objects, hold down the Shift
key, so as to move them
within a range of 45 degrees.
This angle can be changed
from Edit > Preferences > Gener-
al. Enter the new Constrain
Angle, and click OK.

Scratch disk
For best performance, pro-
vide Illustrator with ample
swap space on the hard disk
where it can temporarily
store information such as
the image information,
undo information, etc. This
will ensure its smooth func-
tioning, especially if you
work with large, complex
graphics. Change the loca-
tion of the scratch disk, by
clicking on Edit > Preferences >
Plug-ins & Scratch Disk.

Easter egg
By default, in the lower left
hand corner of the drawing
area, Illustrator displays the
current tool being used.
Click on it to view other
items such as, the Date and
Time, the amount of Free
Memory, and the Number of
Undo’s. If you hold down
[Alt] while clicking on the
drop-down, you can choose
such items as number of
shopping days left till
Christmas, a pair of eyes
that follow your cursor, the
number of mouse clicks,
and the moon phase,
among other things!

Custom brushes
To use an object as a brush,

Create your own gift tags and
put them on gift boxes!

you can personalise a lot of
things, through this Preferences
Dialog.

Alt Click and keep yourself
updated with some interesting
information.

AUGUST 2003
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select the object, and click
on the new brush icon
in the brushes palette. In the
new brush dialog box, select
the kind of brush to create,
and click OK. Set the
properties for the brush
from the Brush Options dia-
log box, and click OK to cre-
ate the brush.

Artwork and preview
You can view some items in
Preview mode, and other
items in Artwork simultane-
ously. Place the objects on
separate layers. Double-click
the layers you wish to see in
Artwork mode, and disable
Preview from the layer
Options dialog box.

Text on path
You can apply text around
any object in Illustrator.
First, create the object
around which you want the
text to appear. Select the
Path Type tool. To do so,
hold down the mouse but-
ton on the Type tool, until
the options below it appear.
Create an insertion point
near the object’s edge, and
type the text.

Enter the new height or
width value in the transform
palette; hold down [Ctrl],
and hit Enter, or Return. The
other value will be entered
automatically. More trans-
form tricks here.

Use that Knife nicely
Using the Knife tool, can
have an uncertain outcome
if you don’t know the short-
cuts to making it work.
If you select the Knife Tool,
and begin cutting a shape,

it is very hard to try and
keep that cut straight. Press
[Alt], and then begin cut-
ting, because if you begin
cutting, and press [Alt] later,
the cut will be crooked.  If
you have several layers with-
out any item selected, and
you begin cutting it with the
Knife Tool, the cut will
apply to all layers. If you
want to cut only one item,
make sure that it is the only
thing selected. 

Moving objects
Here’s how to move one
item from one layer to the
next. Select the item you
want to move. The layer
with the selected item has a
little square in it. Hover over
the little square and you’ll
see a hand with a pointing
finger. Press the Alt key, 
and drag that item to a 
new layer. 

Find the complementa-
ry color for a selected item
by holding down [Ctrl], and
clicking inside the bar,
when working in the colour
bar area (the area at the bot-
tom with all the colors).
This gives you the colour
immediately. It will not
change the actual art piece,
unless you actively select
the item. 

Use Path Type tool to curve
your text the way you like.

Manipulating layers
Selecting layers
Press [Ctrl] and click on a
layer in the Layers palette to
automatically select every-
thing. This is the best way to
select small, complex objects
on a layer. To show only one
layer, and hide all the others,
press [Alt], and click on the
eye icon to the left of the
layer, in the layers palette. 
Deleting layers
To delete a layer set, but not
the layers within the set, go
to the Layer palette drop-
down menu, and choose
Delete Layer Set. Click on Set
Only, when the dialog box
appears, and click OK.
Linked layers

If you want to
make the same
change to more
than one Type
layer at the same

time, just link
all of the
layers you
want from
the Layers
palette, then
hold [Shift],

and make your
changes to one

of the linked layers. All of the
linked layers will show the
same change.

To delete your active
layer, and the layers linked to
it, hold [Ctrl], and click on
the trash icon in your Layers
palette. You can quickly lock
all of your linked layers, by
choosing ‘Lock All Linked
Layers’ from the layer palette
drop down menu. You can
easily align your linked lay-
ers by selecting the Move
Tool and looking at the
Options bar.  There’s a selec-
tion of buttons that will
align your layers to the left,
right, horizontally, vertically,
to the centre, and even
adjust the spacing.
Using masks
If you want your Layer mask
to have clean sharp edges,
add a Vector mask. To do this,
hold down [Alt], while click-
ing on the ‘Add a Mask’ but-
ton, at the bottom of the
Layers palette. Mask a layer, or
set of layers with Layer Masks
already attached, by adding

Delete only the set, not the
layers that are contained in it.

PHOTOSHOP

Use everyone’s favourite image editing tool in a
smarter way with these smart tips.
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them to a layer set, and
adding a mask to that set. To
quickly and easily copy your
Layer Mask, just click on the
Layer you want the mask
copied to, then click directly
on the Layer Mask you want
copied, and drag it to the Lay-
ers Mask icon.
More Layer settings
If you want to move more
than one layer in your doc-
ument, just link the Layers
together. Do that, by click-
ing on the little empty box
next to the eye icon in the
Layers Palette. 

Change your background
into a fully functional layer,
by double-clicking on it in
the Layers Palette.

If you want to save your
personal style as a Layer
Style, you can add a Layer
Style to its own layer by
going to Layer > Layer Styles >
Create Layers. It will appear on
its own Layer beneath the
original layer.

Change the opacity of the
layer you’re working on, by
pressing a number on your
keyboard. For example, typ-
ing 4 will set it to 40 per
cent, typing 5 sets it to 50
per cent, etc. If you want it
to be 52 per cent, just type in
5, and 2 quickly.

File handling
You can double-click any-
where on your open work-
space, to bring up the Open
dialog box. 

When using the ‘Save for
Web’ dialog box, you can see
how your image will look on
different platforms by using
the arrow in the preview’s
upper right corner, and select-

ing which platform you want
to see. Don’t keep saving your
images as JPEG, because Pho-
toshop compresses the file
each time. Save it as a loss-less
format until you’re done with
the editing.

After working on a Photo-
shop document for a while,
you may have some unseen
data lying on the outside of
the image. To get rid of this,
and hence, shrink your file
size, press [Ctrl]+[A] to select,
and then, go to Image > Crop.
To shrink the size of your
Photoshop files further, go to
Preferences > File Handling, and
uncheck the box that says
‘Always Maximize Compati-
bility for Photoshop PSD
Files’.

To undo the save, just
press [Ctrl] + [Alt] + [Z] a cou-
ple of times, until you see
your layers coming back. To
close all of your currently
open images, press [Ctrl] +
[Shift] + [F4].

Manipulating images
Use the Clone Stamp tool, to
clone from one open image
to another quite easily. Just
hold down [Alt], and click on
the image you want to clone,
then go to the original image,
and start painting.

To quickly change the
size of your preview thumb-
nail in your palettes, just
right-click in an open area of
the palette, and a menu will
appear with your selections.

Gain lost detail of a
shrunken image, by going
under Filter > Sharpen >
Unsharp Mask. In the dialog
box that appears, try using a
Radius of 1.0 and a Thresh-

old of 4, then play around
with the amount until you
are satisfied with the result.
Crooked scans are common,
and annoying. Fix them eas-
ily by selecting the Measure
tool, and dragging it along
the top edge of your image.
Now, go to Image > Rotate
Canvas > Arbitrary. Press OK,
and Photoshop straightens
the image automatically.

Playing with colours
Text colour changes when
highlighted. To view the orig-
inal text colour, and yet keep
it selected, press [Ctrl]+[H], to
hide the selection.

To get a finger painting
effect, hold [Alt] while using
the Smudge tool.  When
using a spot colour gradient
that fades to white, make
white a zero percent tint of
the spot colour. This ensures
that the entire gradient is
maintained in the separation.
CMYK colours
If you’re working in CMYK
mode, the colour picker is
still in RGB. To get around
this, press [Ctrl] + [Y], while
the colour picker is open.
This is the Shortcut for Proof
Colours found under the
View menu. Get the best
effect when sharpening flesh

tones in CMYK mode, by
applying the filter to the
image’s cyan channel.

Text effects
To numerically enter the
exact size for a type box, hold
the Alt key, and click on your
document using the Text
tool. A ‘Paragraph Text Size’
dialog box will pop up. To
quickly render your text layer,
just right-click on the layer’s
name in the layers palette,
and select Rasterize Layer.  To
get your fancy quotation
marks back (the real ones, not
the block foot, or inch mark),
look under Preferences, and
choose General Preferences.
Here, you can choose to tog-
gle the quotes with the ‘Use
Smart Quotes’ selection.

Other useful tips
Gradient banding: To elimi-
nate gradient banding when
printing, go to Filter > Noise >
Add Noise. When the dialog
opens, enter 2 in the Amount
field, select the Gaussian
option in the Distribution
section, and check the Mono-
chromatic box. Now, just
click OK. 
View at 100 per cent: No
matter what your current
zoom level is, to view your
image at 100 per cent, just
double-click on the Zoom
Tool icon.
Kerning and Tracking
Adjust: To set the Tracking
tighter, highlight the type,
and press [Alt] + [Left arrow].
To loosen, use [Alt] + [Right
arrow]. Adjust kerning, by
clicking the cursor between
the two layers, and using the
same shortcuts.

Clone one image into another
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Rise of Nations, the latest contender in
the race of RTS (Real Time Strategy)

games, is much more logical, mature, and
satisfying, as compared to previous titles.

It features eight ages, based on the
human race’s development checkpoints.
Advance from one age to the next, based
on research done in certain fields. Choose
from a cartful of civilisations. Each nation
has been painstakingly given a unique
appearance in terms of uniforms, build-
ings, units etc.

The game supports up to eight nations
on the map. A scenario editor is included to
make your own maps. Take over nations
through War, Diplomacy, Espionage, etc.
Guard your borders till you advance

enough to build up a strong army, or plan
a surprise attack on the opponent. You can
team up with a nation to combine and
attack a third nation.  

The game has a remarkable artificial
intelligence level. For example, if left idle,
citizens automatically try to find work for
themselves, be it raising crop, or repairing
buildings. They automatically return to
their previous work after doing the job you
called on them for. 

Static objects such as buildings, and
moving units that allow for inter unit
interaction, are rendered in intricate 2D
graphics to allow for greater details.
Hence, this provides a high level of 
detail and realism, for which a high end
graphics card is a must.

Indeed, it is a well-planned RTS game
and offers numerous ways to take the game
forward. All in all, this game is worth a try.

Rise of Nations
All rise! Here comes the emperor!

Genre: Strategy ■■  Developer: Big Huge Games ■■  Publisher: Microsoft Game Studios ■■  System Requirements: Windows: XP/2000/ME/98,
128 MB RAM, 500 MHz CPU, 800 MB disk space, 16 MB 3D card ■■  Online/multiplayer requirements: 56.6 Kbps or better for Internet play
Rating: ★★★★✩✩

Muscle Car 2: American Spirit
Racing for the absolute beginner

Muscle Car 2: American Spirit is a racing
game that’s based on 1970s muscle

cars, which were immensely popular in
the US for their brute power and looks.
The game has a weird interface that made
browsing the menu a tough task. We were
surprised to find that there was no option
to change the controller settings. The
game has four modes of play: Time Trial,
Rally, Bandit and Career. You can select a
car and the character accompanied to race
in any of the four modes.

In the Time Trial mode, you have to
race against the clock and cross various
check points in a certain amount of time.
In the Rally mode, the racer has to com-

pete against opponents in race circuits, and
place first, second or third to clear a track.
In the Bandit mode you race against one
opponent on street circuits—be ready to

handle cops who don’t like the idea of
street racing at all. Then there is the career
mode where you can earn money by win-
ning races. With this money you can buy
better cars, upgrades, etc. 

All the car models looked much the
same, differing only in textures. It also has
poor game physics and artificial intelli-
gence. The opponents were bumping into
each other for no apparent reason. The
overall graphics quality was also disap-
pointing. The tracks looked uninteresting
as the scenes seemed to be repeating and
we also found the tracks to be too long.
This is not a game for die hard racers, but
its low price tag makes it worth a try.

Genre: Arcade Racing ■■  Developer: 3 Romans LLC ■■  Publisher: Global Star Software ■■  Contact: Sujata Infotech ■■  System requirements: 500 MHz CPU,
64 MB RAM, 4X CD-ROM, 150 MB disk space, 8 MB 3D graphics card ■■  Price: Rs 199 ■■  Phone: 022-22846574/22885096 
Fax: 022-22840234 ■■  E-mail: sales@sujata.net ■■    Web site: www.globalstarsoftware.com  
Rating: ★★✩✩✩✩✩✩

RACING LESSONS: Poor graphics make the
car and the race circuits look dull

GETTING CIVILISED: Develop a state-of-the-
art city, complete with modern buildings
and famous ‘wonders’
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Google is the undisputed king of
search engines, and is your best bet

to finding what you need on the Inter-
net. The only problem is, if you don’t
search smart, you might get too many
search results for general queries—a
search for ‘news’ in Google throws up
237 million results. This book aims to
help you conquer the art of searching. 

The book describes different ways to
exploit the Google search system. These
are referred to as ‘hacks’, they are
described well and yield precise and min-
imal search results. The book first
describes basic search mechanics and
then explains in detail how to use spe-
cial keywords to refine your results. How-
ever, not all parts of the book are
described visually, and placing screen-
shots in some places would have made

the hacks easier to understand.
After the basic search

tricks, the book
also explains how
to use special
Google searches
and services. It
explains the
Google Groups and
Directory searches.
It also talks about
upcoming search
techniques, found
in Google Labs.
After this, the book
explains how to use
the Google API. It
also lists out various
useful third party
applications made

using Google services. A final topic
of interest is the Webmasters
view to Google. It explains
how to improve your Web-
sites score in the famous
Google Pagerank system.

For a more advanced
user, the book provides pro-
gram examples using the
Google API. This is very 
useful if you want to use 
the Google search in a specif-
ic way. Many examples are 
provided which sort the
results in different ways. 

The language used in the
book is simple to understand

and the hacks work very well.
This book is a good buy at its price, 
especially if you are an avid researcher.

Google Hacks 100 Industrial-Strength 
Tips and Tricks 
Search what you want…

Inspired by Matrix Reloaded, and
eager to try animation?

Of all the 3D graphics soft-
ware, 3ds max has tradi-
tionally been the beginners’
choice. The beauty of
Harnessing 3ds max 5 lies in
its emphasis on basics. It
begins with a chapter cover-
ing the nitty-gritty of 3D, fol-
lowed by an introduction to
3ds max. Its interface and
usage is explained thereafter. 

Rendering and special
effects, in 3ds max, can be
easily learnt. However, the
same cannot be said about
modelling fundamentals,
which require a detailed under-
standing. The book covers this

exhaustively; the
chapter on 3D
modelling is the
largest. There is
even a chapter on
advanced model-
ling towards the
end. Concepts
such as modifier
stack—one of the
core features of 3ds
max—have been
explained in detail. 

The book then
picks up pace, and
explains concepts

regarding materials, cam-
eras and rendering. The explana-

tions provided are well aided by illustra-
tions and screenshots. A summary and 

an exercise, provided at the end of 
each chapter, help you to fully understand
the content. 

The accompanying CD complements
the book by including videos that explain
the software’s key features. Files for 
doing the exercises given in the book, are
also included.

Although the book has done full jus-
tice of guiding a beginner to the interme-
diate level, it could have done better by
touching on some advanced topics such
as network rendering. Also, no introduc-
tion has been given to plug-ins such as
character studio, combustion and reactor.
It also does not come across as a book
meant for advanced users. But have no
second thoughts. If you want to dive into
3ds max, then this is the book for you,
provided you have deep pockets!

Harnessing 3ds max 5
A journey through 3ds max

Publisher: O’Reilly & Associates ■■    Author: Tara Calishain and Rael Dornfest ■■    Distributor: Shroff Publisher and Distributors Pvt Ltd
Phone: 022-27683337 ■■  Fax: 022-23243339 ■■  E-mail: spdinfo@shroffpublishers.com ■■  Web site: www.shroffpublishers.com ■■  Price: Rs 300
Rating: ★★★★

Publisher: Autodesk Press ■■  Author: Aaron Ross and Michele Bousquet ■■  Distributor: Computer Bookshop (India) Pvt Ltd ■■  Phone: 022-22317922 ■■

Fax:022-22623551 ■■  E-mail:orders@cb-india.com ■■  Web site: www.cb-india.com ■■  Price: Rs 1,150
Rating: ★★★★

✩✩

✩✩
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Digit suffered from penguin fever this month. And no,
not from burning the midnight oil while working hard
to collect 4.3 GB of the latest and best Linux ‘distros’

for you, but more from interest in learning what the hype was
all about. With all the geekdom running around the office,
talking Linux all day and shouting praises of ‘Open Source
ki jai’, it was inevitable. 

All throughout the month, people were buzzing
around asking questions about Linux. The *nix guru’s
were the most sought after people, with followers
hanging on to their every word when they gave
their impromptu ‘I-knew-Linux-was-the-best-all-
along’ sermons.

Even the writers team was bustling, with Aayush
and Mouly arguing incessantly about whose Linux

Distribution was better—thankfully the Linux
shootout in test drive put an end to that problem.

Next, everyone wanted to load Linux, as it was
the cool thing to do. Prashant, the CRN Brand
Manager installed SuSE, Sumod installed Xandros

(safely, with VMware on Windows XP) and
many other swear-by-Windows non-techies

installed various flavours of Linux.
All the hype, heated discussions and

sermons apart, this month was a lot of
fun with the penguin stampeding
through the office. Let’s hope things
stay that way, as we do our bit to sup-
port the free OS movement. Viva la
Open Source!

Last month Nabjeet Ganguly (Consumer Marketing Manag-
er), and the marketing team pulled off quite a coup by tying
up with Paramount Pictures—the folks who make some real

cool movies. Now if you have been following Digit (as you should
have…) then you would have read about The Hulk contest last
month in Digit (and seen the trailer on Playware). You can win
free tickets to a screening of the soon-to-be released movie, and
there’s more-free holiday packages to exotic locations such as
Kerala and Goa to be won!

Nabjeet is one of those guys who quietly pulls off some real-
ly cool deals like these. In his words, the “deal went through
smoothly, since the movie is the sort that would appeal to all
Digit readers”, and now movie goers in ten of India’s top Digit
readership cities are going to see Digit logos and banners along-
side the posters for The Hulk. 

In fact, the trailers for the movie on the July Playware CD
contain footage that has not been seen on any other Hulk trail-
ers. But wait up, things are going to get all the more peachy. This
month, Digit and Paramount Pictures are joining hands yet again
for two much anticipated movies-2Fast 2Furious and Tomb
Raider - The Cradle of Life. The Playware CDs again contain must-
see high-action trailers from both the movies. And yes, there are
contests galore. Digit readers now get to win 1,500 tickets for
each movie—and vacation packages! 

Now with the marketing team doing this, it was natural for
just about everybody in Digit to demand a ticket. Since Nabjeet

Three months after the first talent hunt, the newbies are
no longer that, and have settled in. When asked how
they were doing, the results varied from, “Fabulous!

Man” and “The high speed Internet rocks!”, to “Can’t talk
now, got a game review to do” and “The only problem is that
my parents miss me, and I feel guilty, because I don’t!” They
seemed to be fitting in just fine, between game… err…
reviews and surfing the Internet for (Ahem!) research.

What we needed was some new faces around, especially
because we needed some new people to rag. So up came Tal-
ent Hunt 2. This time the sales and marketing department
wanted to hire… The procedure was planned and finally the
test began. It was scheduled to run for 24 hours starting at 12
midnight on the twentieth.

Once again, the response was phenomenal, and the ded-
icated server we had set up to run the tests was bogged down
by 11 am. Rakesh Tiwari our systems administrator had to
rush to set up another server just to be able to handle the traf-
fic. Throughout the day there were people logging on to take
the 175-question test. At 1 am the next morning Rakesh and
Anurag Gour (Head Client Marketing) told us that 2,500 indi-
viduals had logged on to try their luck for the first round of
tests. Here’s wishing all those who took part the very best of
luck. With the second round of tests (for the 200 short-listed
candidates) around the corner, we’re sure to get the cream of
an already impressive crop. Watch this space for updates. 

Tux Invasion

Digit's Hidden Hulks
hasn’t come forth with tickets yet, wild rumours are abounding
about how Nabjeet and his team are going to ‘black’ the tick-
ets—but you didn’t hear this from us!

The hunt is on…
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Highlight the lighter side of computing. Mail your contributions to: Backbyte Digit, 
Plot D-222/2, TTC Industrial Area, MIDC, Shirvane, Nerul, Navi Mumbai 400 706 or
e-mail us at backbyte@jasubhai.com

Your chance to
bite back!
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This month you are sure to try something new.
Being the Explorer that you are, get up, close all
Windows, don your (Red) Hat and do a
Mandrake style disappearing act.

Aur Ek Kal (Oracle)

Much ado about 
‘Nothing’

Kabh se boot kiye baithaa hoon,
PC apne pyaar ka.
Kaise type karoon mein lekin,
Password izhaar ka.

Dil ki chaaron drives pe meine,
Jaana tujhko search kiya.
Yahoo, Yahoo, Google, Google,
Kitna paisa kharch kiya.

Tere chehre pe gussey ka,
Screensaver jab aata hai.
Mere chehre ka display tabh,
Greyscale ho jata hai.

Jinke links abh toot chuke hain, (Ex-
Boyfriends)
Shortcuts woh wipe karo.
Apne dil ki Init.ora mein,
Mera address type karo.

Aakar dekho toh mujhko,
Mein SQL prompt pe rehta hoon.
Tere login ki chaah main kitne,
Scott/Tiger sehtaa hoon.

Chaahat hai tere pyaar ki site,
Raat-din mein hack karoon.
Patthar-dil daddy ka tere,
Software bhi crack karoon.

Buddha agar jo maan gaya toh,
Hum connect ho jaayenge.
STG key server ki,
Phere phir saat lagaayenge.

Ginti ke bas bache hain baaki,
Mere jeewan ke yeh pal,
Tu jo aakar pyaar se chhoo le,
Mil jayega Aur Ek Kal.

Jai Oracle, Jai Oracle

Contributed by SP Singh

Now here's a believer 
in Extraterrestrial 
life forms, if we ever 
saw one

■ backbyte

Ain't that the truth!

Nothing 4 Sale
I am legitimately trying to sell nothing. 
It is hard to describe nothing but I can tell you that it is nothing like

anything you have ever seen. There is no photo available because 
I do not know how to take a picture of nothing. 

Some sellers have tried to trick buyers into buying nothing. This is
not my goal. I am really trying to sell nothing. My friends tell me that
people will buy anything on eBay. Now I want to see if I it is possible
to sell nothing. I also want to find out how much nothing is worth to
someone? I want to find out the price of nothing.

If you want to be the first person to buy nothing from me, bid on
this item. Bid as high or as low as you want to (there is no reserve
price). I may or may not try to sell nothing again; it depends on 
how well this auction goes. But if you want to be the first one to buy
nothing from me, then go ahead and bid on this item. 

Note: If you bid on this item, you are bidding on nothing. 
If you end up with the winning bid, you will get nothing. I will ship
nothing to you. There are no shipping costs associated with this item
because it costs nothing to ship nothing.

Thanks
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